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Introduction: Target for ArcGIS

Target for ArcGIS

Target for ArcGIS™ is a surface and drillhole mapping extension to Esri’s
ArcGIS™ software that simplifies the visualisation, mapping and analysis of
subsurface drillhole and borehole geology data within your Esri GIS environment.
Built on the same technology as Geosoft’s industry-leading Oasis montaj®
software, Target for ArcGIS adds powerful spatial data processing capabilities
and 3D viewing to your GIS.

About this Training Manual

The Target for ArcGIS course manual is for use in a classroom setting with a
qualified Geosoft instructor. Your instructor is available throughout the course to
answer any questions you may have.

Each module in this book contains a series of hands-on lessons that let you work
with the software and a supplied dataset. Lessons have brief introductions followed
by tasks and procedures in numbered steps.

The following modules are included in this course:
Module 1 - Mapping Surface Data
Module 2 - Managing Drillhole Data
Module 3 - Mapping Drillhole Data
Module 4 - Implicit Modelling
Module 5 - Explicit Modelling

Course Data

The data used in this course is contained in a folder called Geosoft Training Data.
Please copy the whole folder of data to your C:\ drive or other hard drive where you
have at least 200 MB of available space.
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Module 1: Mapping Surface Data

Module 1 has Four Lessons:

Lesson 1.1 Creating an MXD and AddingData __........___._... ... ... 4
Lesson 1.2 Displaying Data ... ...l 10
Lesson 1.3 Creating Gridded Data ........................................... 18
Lesson 1.4 Creating Geosoft Contours ... ... 30
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Module 1: Mapping Surface Data

Lesson 1.1

Creating an MXD and Adding Data

In this lesson you will:
Create a new map document

Add data layers

Add x,y tabular data and assign a coordinate system

Save the map document

Creating an MXD

An .MXD is the native project file format for Esri ArcGIS. It contains the project

map and any data contained within, as well as information about how those layers
are displayed. You will begin by creating a new ArcGIS map document.

To create and save an MXD:
1. Start ArcMap.

The ArcMap starting dialog opens.

Figure 1.1 ArcMap starting dialog
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Ensure Blank Map is selected and click OK.

From the File menu, select Save.

4. Locate the Geosoft Training Data folder.
This is the location where all your data output will be saved.
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Lesson1.1  Creating an MXD and Adding Data

5. Forthe File name, enter Surface Mapping.mxdDrillhole Mapping.mxd and
click Save.

Now that you have started ArcMap and created an .MXD file, you will display the
Target for ArcGIS toolbars.

Displaying Target for ArcGIS Toolbars

Once you have installed Target for ArcGIS and opened ArcMap, you need to
display the Geosoft Target for ArcGIS toolbars. The toolbars can then be docked
in various locations.

To display the Target for ArcGIS toolbars:

1. From the Customize menu, select Toolbars and then select Geosoft
Database.

The Geosoft Extensions Setup and DAP toolbar opens.

2. Repeat step 1 to display the Geosoft Extensions Setup and Seeker, Target
Drillhole, and Target Surface and Target Wireframing toolbars.

You will now add data to your map document.

Adding Data

Any data that you add to your map is represented as a layer in the MXD Table of
Contents. You can add data from folders (such as shapefiles and Geosoft grids)
and from databases.

To add data to a map:

1. On the Standard Toolbar, click the Add Data button &
The Add Data dialog opens.
Locate the Geophysics folder.

Hold down the CTRL key, select mag_MC.grd and magnetics.shp and click
Add.

The mag_MC.grd and magnetics.shp layers are listed in the Table Of Contents
and displayed in the map display area. By default, the mag_MC grid is
displayed as greyscale.

Target for ArcGISTarget for ArcGIS Il | 5
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Figure 1.2 Data added to map
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Adding XY Data and Defining the Coordinate System

In Target for ArcGIS you can create Geosoft grids, by interpolating data that is
stored within shapefiles and event layers . However, in order for the resulting grid to
have a coordinate system, you must grid either a shapefile or an event layer that
already has a defined coordinate system. When you do this, the output grid will
inherit the coordinate system of the source data.

In this example, you will add ASCII data into the MXD as a layer and then define its

coordinate system. Any grid created from this x,y coordinate event layer will inherit
its coordinate system

ek When adding x,y data, the coordinate system defaults to that of the current
data frame. You must ensure the coordinate system is appropriate for the
data you are adding.
iy To add x,y data, your coordinates must be in projected units or decimal
degrees.

To add x,y data and define the coordinate system:
1. From the File menu, select Add Data then Add XY Data.

The Add XY Data dialog opens. The coordinates of the current data frame are
listed by default.
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Figure 1.3 Add XY Data dialog

(2wl

A table containing X and ¥ coordinate data can be added to the
map as a layer

Add XY Data

Choose a table from the map or browse for another table:

[ =18
Specify the fields for the ¥, ¥ and Z coordinates:
¥ Field: -
¥ Field: -
Z Field: -
Coordinate System of Input Coordinates
Description:
Projected Coordinate System: -
Mame: GDA_1994 MGA_Zone_50
Geographic Coordinate System:
Mame: GCS_GDA_1994
4 3
[ Show Details
Warn me if the resulting layer will have restricted functionality

Click the Browse button = .
The Add dialog opens.

Creating an MXD and Adding Data

From the Geochemistry folder, select geochemistry_mga.csv and click Add.

From the X Field list, select East.
Fromthe Y Field list, select North.

The data that we first imported into the project has the "GDA_1994 MGA_
Zone_50" projected coordinate system assigned to it. Because of this, any new
data that is imported will by default be assigned to that system. You can change
the coordinate system by clicking the "Edit button". In our case though, the
displayed coordinate system is the one we want to assign to our new data.

Click OK.

A message window opens indicating the table does not have an Object-ID field.

Click OK.

The geochemistry_mga.csv Events layer is listed in the Table Of Contents and

displayed in the map display area.

Target for ArcGISTarget for ArcGIS Il | 7
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Figure 1.4 Tabular data added as X,Y Event layer
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&y The XY Event data (geochemistry_mga.csv Events) only exists in the

current map document. To save the layer as a separate file, you must
export it as a shapefile or feature class.

To save the layer as a shapefile:
1. Inthe Table Of Contents, right-click the geochemistry_mga.csv Events layer
and select Data then Export Data.

The Export Data dialog opens.

Figure 1.5 Export Data dialog
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2. For Output feature class, click the Browse button &',
3. Locate the Geosoft Training Data folder.

4. For Name, enter geochemistry.

5. From the Save as type list, select Shapefile and click Save.
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6. Click OK.

An ArcMap message window opens asking if you would like to add the exported
data to the map as a layer.

Click Yes.

The geochemistry.shp file is saved in the specified folder and is displayed as a
layer on your current map.

Because you have created a shapefile of the surface geochemistry data, you can
remove the Events layer.

To remove the Events layer:

In the Table Of Contents, right-click the geochemistry_mga.csv Events layer
and select Remove.

Saving a Map Document

When you save a map document, the data itself is not saved, but rather it saves
references to the data sources and their display properties.

To save your map document:

From the File menu, select Save
-OR -
Click the Save button on the Standard toolbar.

If you close your map document without saving it, you will be prompted to
save changes to your .MXD file.

In this lesson you:

Created a new map document

Added data layers

Added ASCII data and assigned a coordinate system
Converted an Events Layer to a Shapefile

Saved the map document

Target for ArcGISTarget for ArcGIS Il | 9
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Lesson 1.2 Displaying Data

In this lesson you will:
Change the grid display
Apply a colour ramp to your grid
Symbolise point data using colour and symbol sizes
Manually classify symbol ranges

Save symbolised points as a layer file

Displaying Geosoft Grids

You can modify the display of Geosoft grids in many ways in ArcMap, including
assigning different colour ranges, applying a shaded effect, and applying

transparency.

You will begin by changing the resampling method used to display the grid layer.
Then, you will select a colour ramp and choose how that colour is mapped to the

data.

To change the grid display:

1. Inthe Table Of Contents, right-click mag_MC.grd and select Properties.

The Layer Properties dialog opens.
2. Click the Display tab.

Figure 1.6 Layer Properties Display tab
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M
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3. From the Resample during display using list, select Bilinear Interpolation

(for continuous data).
This will give a smooth appearance to your raster data.
4. Click Apply.
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Now, you will select a colour ramp and how you want to map that colour to the data
- the colour "stretch".

To apply a colour ramp:
1. Click the Symbology tab.

Figure 1.7 Layer Properties Symbology tab
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2. Rightclick in the Color Ramp list and click to clear the Graphic View option.
The Color Ramp view switches from a graphic view to text.
From the Color Ramp list, select Geosoft Default.

4. Click Apply.

The Geosoft Default colour ramp is applied to the data; low values are shown in
blue and as the values increase, the colours change from green to yellow,
orange, red, and magenta.

Next, you will modify the colour display by changing the colour stretch.

To modify the colour stretch:
Note that the default color stretch in ArcMap is the "Standard Deviations" type.

1. From the Type list in the Stretch section of the tab, select Histogram
Equalize.

The Compute Histogram message window opens asking you how you would
like to estimate the histogram.

2. Click Yes.
Click OK.

The grid is now displayed with a histogram equalize stretch. This stretch is
designed to enhance mid-range features in data, by assigning an equal number
of data points to each colour in the colour ramp.
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Examine the colour display of the grid layer. You may wish to turn off the display of
the magnetics and geochemistry point layers or change the display order of the

layers in your data frame.

To turn off the display of a layer:
* Inthe Table Of Contents, clear the check box beside the geochemistry layer.

This layer is no longer displayed.

To change the display order:
* Inthe Table Of Contents, select the magnetics layer and drag it below the
mag_MC.grd layer.
The mag_MC.grd layer is now displayed on top of the magnetics layer.

Figure 1.8 Grid with coloured display
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Symbolising Point Data
Now you will explore displaying data as symbols. You will modify the display of
your soil geochemistry layer in your project to show symbols that change in colour

and size, according to gold concentration.

To symbolise point data based on quantity:
1. Inthe Table Of Contents, click the check box beside the geochemistry layer.

This layer is now visible again.

2. Right-click the geochemistry layer and select Properties.
The Layer Properties dialog opens.

3. Click the Symbology tab.

12 | Target for ArcGISTarget for ArcGIS I www.geosoft.com


http://www.geosoft.com/

Lesson 1.2 Displaying Data

Figure 1.9 Layer Properties Symbology tab for point data
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In the Show area on the left, click Quantities.

ArcMap automatically selects Graduated colors.

Figure 1.10 Layer Properties Symbology tab with Graduated colors selected
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From the Value list, select Au.

The Symbol, Range and Label columns update to show the data classified
based on the natural statistical groupings of data values.

For the Color Ramp, select Geosoft Default.

www.geosoft.com
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7. Double-click the first class in the Symbol column.

The Symbol Selector dialog opens.

Figure 1.11 Symbol Selector dialog
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8. Change the Size to 2 and click OK.

9. Double-click the symbol for each remaining class and change the size so they
range from 3 to 6.
10. Click Apply.

The points are now displayed using colour and size to represent the amount of
Au at each sample location.
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Figure 1.12 Coloured point symbols
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The symbol properties for this point layer are shown in the Table Of Contents; you
can see the colour, size and classes that are used to display the data.

Next, you will manually edit the class ranges based on the data distribution. You
are able to manually define significant or useful breaks in the data so you can
compare it with other maps or identify populations in the data distribution.

To classify the point symbols manually:

1. Inthe Symbology tab of the Layer Properties dialog, clickClassify.

The Classification dialog opens showing the
classification method.

default Natural Breaks

www.geosoft.com
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Figure 1.13 Classification dialog
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The data in this example is log distributed; there is a lot of data in the low end and
very little data in the high end. Notice the Classification Statistics area in the
Classification dialog. The Mean for this data is 24 and the Standard Deviation is 23.
You will use this information to determine the classification Break Values.

2. Inthe Break Values area, click the default values and enter the following

values:

Break Value

25

50

75

100

275

3. Click OK.

Explanation

Approximate Mean value

Mean value plus approximately 1 standard

deviation

Mean value plus approximately 2 standard

deviations

Mean value plus approximately 3 standard

deviations

Maximum value

4. Inthe Layer Properties dialog, clickOK.

The display of the symbols updates based on the redefined classes.
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Figure 1.14 Manually classified point symbols
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Saving as a Layer File

A .LYR file stores any symbology attributes used to display the data. It is a stand
alone file that can be shared with others and applied to other datasets. For example,
you might be working with others that are analysing geochemical data from the
same region as yours and you want to display your data in the exact same way; a
shared LYR file allows you to do this.

To save the shapefile as a layer file:
1. Inthe Table Of Contents, right-click the geochemistry layer and select Save
As Layer File.

The Save Layer dialog opens.
2. If necessary, select the Geosoft Training Data folder from the Look in list.

3. Ensure the layer Name is geochemistry.lyr and click Save.

The layer file is saved on disk.

In this lesson you:
* Changed the grid display
Modified the colour ramp and colour stretch your grid

L

W

Symbolised point data using colour and symbol sizes

L

Manually classified symbol ranges

* Saved symbolised points as a layer file

www.geosoft.com
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Lesson 1.3 Creating Gridded Data

In this lesson you will:
Create a grid using the minimum curvature method
Create a grid using the minimum curvature advanced options

Create a grid using the kriging method

Gridding Data

Gridding data is the process of spatial interpolation. The process of gridding takes
point data and interpolates to determine the values at the nodes of a grid in between
the data points. The resulting interpolated dataset is known as a grid.

Figure 1.15 Gridding process
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Target for ArcGIS provides two methods for interpolating raw XYZ data to create a
grid:

Minimum Curvature: Interpolates the data by fitting a minimum curvature
surface to the raw XYZ data points. This method is ideal when data is sparsely
sampled and a relatively smooth variation is expected between data points.

Kriging: Interpolates data using a geostatistical gridding method to determine a
value at each grid node. It first calculates a variogram of the data, which shows
the correlation of the data as a function of distance. This method is ideal when
data is clustered and randomly distributed.

Minimum Curvature Gridding

Minimum curvature gridding is a gridding method that fits a smoothest possible
surface to the data points. It is best used when data is randomly distributed, when
data is sampled along arbitrary lines or if you want to include tie lines. The following
figure illustrates these types of data:

www.geosoft.com
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Figure 1.16 Data distribution suitable for minimum curvature gridding
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If the data is relatively smooth between sample points or survey lines, minimum
curvature gridding should be used. If the data may be variable between sample
locations, oris known to be statistical in nature (such as geochemical data), is
poorly sampled or clustered, use the kriging method.

Minimum curvature gridding has the following strengths:
works with any spatial distribution of data

does not impose a directional bias

Determining Cell Size
If your data is distributed as random points, the cell size should be 1/4 to 1/2 of the

nominal sample interval. If the cell size is not specified, the data points are
assumed to be evenly distributed and the default cell size will be calculated as:

1/4* (sqrt (grid area / # data points))

Because our geochemical data is randomly distributed, it is difficult to manually
measure the nominal sample interval. In this lesson, you will grid the geochemistry
data using the minimum curvature method and have the algorithm determine the
cell size for you. You will then run it again after adjusting some of the advanced
parameters to optimise the output grid.

To grid data using the minimum curvature method:

1. Onthe Target Surface toolbar, click the Minimum curvature gridding from
table in current document button
The Select Table or Feature Class dialog box opens.

Figure 1.17 Select Table or Feature Class dialog box

Select Table or Feature Class

Available tables in current document:

=5
; geochemistry

magnetics

OK Cancel ] [ Help
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2. Select geochemistry and click OK.

The Minimum Curvature Gridding of attribute using feature positions in layer
dialog box opens.

Figure 1.18 Minimum Curvature Gridding of attribute using feature positions in layer dialog box

Attribute to grid: v]
Name of new grid file: E]

Grid cell size:

l OK I [ Advanced= ] [ Cancel ]

3. From the Attribute to grid list, select Au.

4. Forthe Name of new grid file, enter Au_MC.grd.
The Grid cell size parameter is optional. By leaving it blank, the cell size will be
calculated automatically.

5. Click OK.

The gridded data created using the minimum curvature gridding method is
saved in your working directory and displayed in the map display area.

Figure 1.19 Minimum Curvature grid

AT i

6. Inthe Table of Contents, dag the geochemistry point layer above the grid.

The holes in the grid correspond to areas of no sample data. Later in this lesson,
you will re-grid the data using several advanced options. One of these options is
the blanking distance, which is the distance within which missing grid cell
values will be interpolated.

Now you will examine the properties of the grid that was just created.

To examine the grid properties:
1. Onthe Target Surface toolbar, click Target Surface then Grid Properties.
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The Grid Properties dialog box opens.

Figure 1.20 Grid Properties dialog box

Grid Properties

(2] = |

Grid:

v (]

2. Click the Browse button () and select Au_MC.grd.

3. Click Next.

The Grid Properties dialog box opens.

Figure 1.21 Grid Properties dialog box

Grid Properties @
Grid file: Mau_MC.grd{GRD)
Grid element type: FLOAT
Grid points in ¥ direction: 113
Grid points in v direction: 132
¥ point separation: 23.0887695
¥ point separation: 23.0887698
Grid row orientation: Bottam left to right (Kx= 1}
¥ location of bottam left point:  715036.111
7 location of bottorn left point:  6529319.38
Grid ratation angle: i}
Coordinate system: GDA%4 / MGA zone 50
Coordinate system units: metre
Compression Ratio: 31.46%

<Back ] [ Stats ] [ Modify ] [ Exit
4. Click Stats.

The Grid Statistics dialog box opens.

Figure 1.22 Grid Statistics dialog box

Grid Statistics -5 |
Grid File: SAU_MC,grd(GRD)
Walid Items: 13446
Dummies: 1470
Minirmurm VYalue: -13.0515747
Maxirmurn Value: 275.535492
Mean Value: 23.8853046
Standard Deviation: 20.6568981
[ <Back ] [ Re-Calc ] [ Histogram ] [ Trend ] [ Cancel ]
W High and Low values for grid layers are also listed in the ArcMap Table

Of Contents.

5. Click Histogram.

The View Histogram dialog box opens and displays the grid histogram.
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Figure 1.23 View Histogram dialog box

View Histogram
# Divisions
S0
Statistics
Min -13.0516
Max 275.535
Mean 23,8853
Skd 20,6569
Median 20,7853
Cursar
* -50
%o 0.00

3500

1750

Look at the statistics and the histogram. It appears that the data is logarithmically
distributed. If you compare the minimum values of the Au grid to those of the Au
point layer in the Table Of Contents, you can see a significant difference as well as
the minimum of the grid being negative, which is unrealistic for geochemistry data.
Because minimum curvature gridding attempts to interpolate as smoothly as
possible between data points, it is not well suited to logarithmically distributed data.

You will now run the minimum curvature gridding again, this time adjusting the grid
cell size as well as advanced parameters such as the log option and blanking

distance, in order to optimise the output grid.

To grid data using the minimum curvature advanced options:

1. Onthe Target Surface toolbar, click the Minimum curvature gridding from

table in current document button

2. From the Select Table or Feature Class dialog box, select geochemistry and

click OK.

The Minimum Curvature Gridding of attribute using feature positions in layer
dialog box opens and remembers the parameters you used the first time.

For the Name of new grid file, enter Au_MC_log.grd.
For the Grid cell size, enter 25.
Click Advanced.

The Minimum Curvature Gridding — Advanced Options dialog box opens.
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Figure 1.24 Minimum Curvature Gridding — Advanced Options dialog box

' ™
Minimurm Curvature Gridding - Advanced Options M
Channel to grid: m
Output grid: Mu_MC_log.grd(GRD)
Grid cell size: 25

Xmin,YminXmax, Ymax:

Log option: linear w7

Log minimurm: 1
Low-pass desampling factor:
Blanking distance:

Tolerance:

% pass tolerance: 99
Maximum iterations: 100
Starting coarse grid: [16 -

Starting search radius:
Internal tension (0-1): o

Cells to extend beyond data:

Weighting Power: [2 v]
Weighting Slope (==0.0): 0.0
[ <Back J [ Finish ] [ Cancel ]

L J

The following are some of the key parameters that control the creation of the grid
surface:

Log Option: The logarithm (base 10) of the data can be gridded rather that the
original data. Once gridded, the output grid can be stored as either the
logarithmic data or it can be rescaled back to the original units. Gridding the log
of the data can be a very effective way to reduce distortion due to highly skewed
data such as geochemical data.

Blanking Distance: All grid cells farther than the blanking distance from a valid
point will be blanked out in the output grid. The default is the nominal sample
interval, i.e. 2*(sqrt (grid area / #data points)). This parameter should be set to
just greater than the maximum sampling interval through which interpolation is
desired. If there are too many holes in the resulting grid, increase the blanking
distance appropriately.

Tolerance: The tolerance required for each grid cell (%). The default is 0.1
percent of the range of the data. Decrease the tolerance for a more accurate
grid.

% Pass Tolerance: The required percentage of points that must pass the
tolerance. The default is 99.0 percent. Increase this percentage for a more
accurate grid.

Maximum iterations: Iterations at the finest coarseness level will stop when
the maximum number or iterations is reached (default is 100). At each greater
coarseness, the maximum iterations is reduced by 2. Increase this value if more
iterations are required to produce a more accurate grid.

Internal tension: The degree of internal tension (between 0 and 1). The default
is no tension (0), which produces a true minimum curvature grid. Increasing
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tension can be used to prevent overshooting of valid data in sparse areas,
although curvature in the vicinity of real data will increase.

6. From the Log option list, select log, save as linear.

Because this is highly skewed geochemical data, the log option will be used.
The log option transforms the data into log space, generates the grid based on
the transformed data and outputs the resulting grid back in linear space.

7. Forthe Blanking Distance, enter 225.

All grid cells within this distance from a valid point will be interpolated. Grid cells
that are further than this distance, will be left blank in the output grid.

You will use the intelligent defaults for the remaining parameters.
8. Click Finish.

The gridded data created using the advanced options for the minimum curvature
gridding method is saved in your working directory and displayed in the map
display area.

Figure 1.25 Minimum Curvature grid with log option and blanking distance of 225 m

1 i

9. Zoom in to the upper-left corner of the grid.
10. Turn the display of the Au MC log grid on and off to compare the results.
Figure 1.26 Left, Au_MC.grd; right Au_MC_log.grd

)+
|
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W You can also use the tools on the Effects toolbar to compare the grids.

Kriging
Kriging is a geostatistical gridding technique for random data, non-parallel line data
or orthogonal line data, as illustrated in the following figure:

Figure 1.27 Data distribution suitable for kriging

. -
+
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+
+
Random, Clustered Points Mon-Parallel Lines Lines with Tie Lines

Use the kriging method if the data is variable between sample locations, known to
be statistical in nature, poorly sampled or clustered. Kriging is ideally suited to
geochemical or other geological sample-based data; it is rarely used with
geophysical data, which tends to vary smoothly between data points..

It first calculates a variogram of the data showing the correlation of the data as a
function of distance. The greater the distance between data points, the greater the
variation between the points. Based on the variogram, you can select a model that
best defines the variance of the data. Because kriging can be slow, the size of a
dataset may be a limiting factor in choosing kriging.
Kriging has the following strengths:

ideal for clustered data

better control in anomalous or poorly sampled areas

You will now use the kriging method. You will first compute the variogram, adjust
the advanced options and then create the grid.

To compute the variogram:
1. Onthe Target Surface toolbar, click the Kriging gridding from table in

current document button ‘.

The Select Table or Feature Class dialog opens.
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Figure 1.28 Select Table or Feature Class dialog

Select Table or Feature Class

Available tables in current document:

B e
geochemistry
magnetics

2. Select geochemistry and click OK.
The Krigridding of attribute using feature positions in layer dialog opens.

Figure 1.29 Krigridding of attribute using feature position in layer dialog

Krigridding of attribute using feature positions in layer @
Attribute to grid: [ v]
Name of new grid file: E]

Grid cell size:

[ oK ] [ Advanced= ] [ Cancel ]

3. Forthe Attribute to grid, select Au.
4. Forthe Name of new grid file, enter Au_K.
5. Forthe Grid cell size, enter 25.
6. Click Advanced.
The Kriging - Advanced Options dialog opens.
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Figure 1.30 Kriging - Advanced Options dialog

rKriging - Advanced Options Mw

Channel to grid: m
QOutput grid: MAu_K.grd(GRD)
Name of error grid file: E]
Name of input variogram file: E]
Name of output variogram file: E]
X¥min,Ymin,Xmax,Ymax:
Log option: linear v]
Log minimum: 1
Low-pass desampling factor:
Elanking distance:
Remove trend (drift): lND ']
ariogram model: [spherical ']
FPower:
Range/Slope:
Mugget:
Sill:
Strike:
Strike weight: 1

[ <Back J [ Variogram Only ] [ Cancel ]

L. J

The following are some of the key parameters that control the creation of the grid
surface:

Range/Slope: For spherical, Gaussian and exponential models, the range is
the distance at which the variogram model reaches the sill value. Beyond the
range, the data is uncorrelated. For the power model, this is the rate of climb, or
slope for a linear model.

Nugget: The nugget is the average error in each data point and is indicated by
the intersection of the variogram model with the h=0 axis. The default is 0.

Sill: This is the level at which the variogram becomes uncorrelated, or goes flat.
The sill must be specified for the spherical, power and Gaussian models.

Strike and Strike weight: These parameters control anisotropic gridding.
For Name of output variogram file, enter Au K.
8. ForLog option, select log, save as linear.
This option will grid in log space and output the results in linear space.
9. Forthe Blanking Distance, enter 225.
10. For Variogram model, select spherical.
11. Click Variogram Only.
The variogram is plotted and displayed in the variogram window.

In general, the output variogram is good at matching the overall character of the
data. Ideally, the red curve representing the variogram model should approximately
matchthe black line representing the observed data.

Next, you will adjust the variogram parameters and then create the gridded data.
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To adjust the variogram parameters:
1. Onthe Target Surface toolbar, click the Kriging gridding from table in

3

current document button %

2. From the Select Table or Feature Class dialog, selectgeochemistry and click
OK.

The Krigridding of attribute using feature positions in layer dialog opens and
remembers the parameters you used the first time.

Click Advanced.

For Range/Slope, enter 1300.
For Sill, enter 0.115.

Click Variogram Only.

o g &~ w

A File Validation window opens asking to overwrite the existing variogram.
7. Click Yes.

The variogram is updated based on the adjusted parameters.

Figure 1.31 Replotted variogram

o oo
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Map Layers \ Undo/Redo History
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X (h) VARIOGRAM

Sample Pairs

li= s

Masked to view

Render images and grids first E

| Au_NP | *unknown |10.3731618,230.023897 | 1:20634553 48% = |

The updated variogram has a better match to the observed data. Note that it is
virtually impossible to exactly match the model to observed variance. It is
acceptable for the model to approximate the variance, much like a trend line or "line
of best fit". Now that the variance is accurately modelled, you will create the grid.

To create the grid based on the variogram:
1. Onthe Target Surface toolbar, click the Kriging gridding from table in

2K

current document button ‘%

2. From the Select Table or Feature Class dialog, selectgeochemistry and click
OK.

The Krigridding of attribute using feature positions in layer dialog opens and
remembers the parameters you used the first time.

3. Click OK.

28 | Target for ArcGISTarget for ArcGIS I www.geosoft.com


http://www.geosoft.com/

Lesson 1.3 Creating Gridded Data

The gridded data created using the kriging gridding method is saved in your
working folder and displayed in the map display area.

Figure 1.32 Grid created using the kriging method

Compare the grids created using the two different gridding methods. Note that
anomalies in the kriging grid are generally less continuous than in the minimum
curvature grid, which is a product of honouring the variance in the data.

Q Now would be a good time to save your map document.

In this lesson you:
* Created a grid using the minimum curvature method
* Created a grid using the minimum curvature advanced options

* Created a grid using the kriging method
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Lesson 1.4 Creating Geosoft Contours

In this lesson you will:
Create multiple contour levels and output to a shapefile
Apply colours to the contours
Output contours to a Geosoft map layer
Create exact contours
Add alegend

Creating and Plotting Contours

Contours are lines drawn at specified intervals or multiples of intervals on your map
based on a gridded dataset. After you create a grid, you may want to generate
contours and display them on your map. The contouring tool in Target for ArcGIS
is specially designed to handle the very large dynamic data ranges that
characterise Earth Science datasets.

You can output the contours to a Geosoft map layer for display in the ArcMap
window or make a shapefile (*.SHP) with Z attributes for use in ArcMap. You can
also select different contour options and line styles.

You will begin by creating multiple contour levels for magnetic data.

To create contours and output to a shapefile:
1. Onthe Target Surface toolbar, click the Create Contours from grid on disk
button &

The Create a contour plot of a grid dialog opens.

Figure 1.33 Create a contour plot of a grid dialog

Create a contour plot of a grid @
Input grid file: E]
Output Type: [shape file ']

Contouring option: [multiples of levels ']

(smallest) Interval level 1:
Interval level 2:
Interval level 3:
Interval level 4:
Interval level 5:
Interval level &:
Interval level 7:

8

Interval level 8:

[ Next= ][ Options ][Line Styles” Cancel ]

For the Input grid file, click the the Browse button L],
From the Geophysics folder, select mag_MC.grd and click Open.

In the Output Type list, ensure shape file is selected.

o > DN

In the Contouring option list, ensure multiples of levels is selected.
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This option plots the levels and their multiples.
6. Forlnterval level 1, enter 100.

You will create contours in 100 nT (nanotesla) intervals.
7. Click Next.

The Contour: Create a shape file as output dialog opens.

Figure 1.34 Contour: Create a shape file as output dialog

Contour: Create a shape file as output E
Output shape file: E]
[ ok ][ <Back || cancel |

8. For Output shape file, enter mag_100nT and click OK.

The contour shapefile with Z attributes is saved in your working folder and
displayed in the data frame.
Figure 1.35 Contoursfor mag_MC.grd

: % o

\Y %\J

i

9. Using the Zoom In tool on the Tools toolbar, zoom in to the contour layer.

3&3_ .'i{!ﬁ'
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Figure 1.36 Contoursfor mag_MC.grd (zoomed)
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In the Table Of Contents, there are two shapefiles; one representing the contour
lines (mag_100nT_Inz) and a polygon layer (mag_100nT_ pgz) representing lows in
the data. Highs are marked with a star and lows are marked with a triangle. Notice
with the contour line layer that the lines are not displayed in areas where the
contours get really close together. These factors can be controlled using the
contouring settings, which you will examine now while re-generating the contours.

To regenerate the contours:
1. Onthe Target Surface toolbar, click the Create Contours from grid on disk
button &

The Create a contour plot of a grid dialog opens and remembers the parameters
you just used.

2. Click Options.
The Contour options dialog opens.

Figure 1.37 Contour options dialog

Contour options @
smoothing option: [default ']
suppression option: [normal ']
suppression density {mm): 0.5
high-law annotation: [Iow ticks V]

high-low exclusion zone {cells): 5

label display: [black ']
label style: [up gradient ']
label size {mm): 1.5

label # of decimals:

default line: [thin-black -

3. Forsmoothing option, select smooth and refine.

4. Forsuppression density (mm), enter 0.
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A value of zero means that contours will be drawn regardless of how close
together they are.

For high-low annotation, select none.

Click OK.

Click Next.

For the Output shape file, enter mag_100nT_2 and click OK.

© N o o

The contour shapefile is created, saved in your working folder and displayed in
the data frame.

Figure 1.38 Contours without suppression (zoomed)

2

o e

9. Inthe Table Of Contents, right-click and remove the original mag_100nT_Inz
and mag_100nT_ pgz layers.

Now you will adjust the layer properties to display the contours using graduated
colours.

To apply colours to the contours:

1. Inthe Table Of Contents, right-click the mag_100nT_2_Inz layer and select
Properties.

The Layer Properties dialog opens.

v You can also open the Layer Properties dialog by double-clicking the
layer in the Table Of Contents.

2. Click the Symbology tab.
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Figure 1.39 Layer Properties Symbology tab

Layer Properties
Hatches I Joins & Relates | Time I HTML Popup
General | Source | Selection Display Symbology | Fields | Definition Query | Labels | Foutes
Show:
Feat |DraIl all features using the same symbol. Import...
- Single symbol
Cat jos Symbol
it —
Multiple Altributes
Legend
Label appearing next to the symbol in table of contents:

NEEEE

-
Additional description appearing next to the symbal in your map's legend

[ ok ][ Ccancel Apply

3. Inthe Show area on the left, click Quantities.

ArcMap automatically selects Graduated colors.
4. From the Value list, select ZValue.

The ZValue is the value from the grid that the contours were made from.
5. Click OK.

The contours are now coloured based on magnetic intensity.

Figure 1.40 Contours coloured by mag values (zoomed)

;
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Shapefiles and Geosoft Map Layers

The Target for ArcGIS plotting tools provide two types of output; shapefiles (as
you created in the previous exercise), and Geosoft map layers. The shapefile
output contains the attributes of the data you are generating contours from. Geosoft
map layers are static images ready for printing; they contain Geosoft's pre-defined
annotations and legends and allow you to pre-define colours, patterns and line
styles.

The Geosoft Map Layer is not a typical GIS layer. The ArcMap ‘Identify’ cursor,
symbology and labelling tools are not available to use with this type of layer. You
also cannot modify a Geosoft Map Layer; if changes are required, you must
recreate it.

To output contours to a Geosoft map layer:
1. Onthe Target Surface toolbar, click the Create Contours from grid on disk
button & .

The Create a contour plot of a grid dialog opens and remembers the parameters
you just used.

From the Output Type list, select Geosoft map layer.
For Interval level 2, enter 200.
This will create a second interval level.
4. Click Line Styles.
The Line colour and weight dialog opens.

Figure 1.41 Line colour and weight dialog

Line colour and weight @
Line weight-colour level 1: [thin-black ']
level 2: [medium-black ']
level 3: [thick-black -
level 4: [thick-black ']
level 5: [heavy-black ']
level 6: [heavy-black ']
level 7: [heavy-black ']
level &: [heavy-black ']

[ <Back |[ Mext> |[ cancel |

Forlevel 2, select medium blue.

Click Back.

Click Next.

The Contour: Create a Geosoft map layer as output dialog opens.

Target for ArcGISTarget for ArcGIS Il | 35


http://www.geosoft.com/

Module 1: Mapping Surface Data

Figure 1.42 Contour: Create a Geosoft map layer as output dialog

Contour: Create a Geosoft map layer as output @
Cutput map file: E]
[ oK ] [ <Back ] [ Cancel ]

8. For Output map file, enter mag_contours and click OK.
The Geosoft contour layer is displayed.

Figure 1.43 Geosoft contour layer

Ooa
\/z

The output map layer has contours every 100 nT. In addition, the level 2 contours
specified at an interval of 200 nT have labels and are displayed with a thicker blue
line style.

Note thatyou can create a contour at an exact level. This can be useful when you
want to define anomalies or any other value in your data. For example, local
knowledge tells us that the main geological units in our project area have a
minimum magnetic response of 150nT. You will now create a 150nT contour from
the magnetic grid to highlight these areas..

To create exact value contours:
1. Onthe Target Surface toolbar, click the Create Contours from grid on disk
button & .

The Create a contour plot of a grid dialog opens and remembers the parameters
you just used.

From the Output Type list, select shape file.
From the Contouring option list, select exact levels.
This option plots only the exact stated contours.
4. Forlinterval level 1, enter 150 and clear the value of 200 from Interval level 2.
This will create a contour at exactly the 150 nT level.
5. Click Next.
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The "Contour: Create a shape file as output" dialog box opens.
6. For Output shape file, enter mag_150nT and click OK.

The shapefile representing a value of exactly 150 nTis saved in your working
folder and displayed in the map display area. You may want to turn off the
display of your other contour layers and turn on the display of the mag_MC grid
layer.

Figure 1.44 Contoursat 150 nT

4

Data View versus Layout View
ArcMap provides two ways to view your data:

* Data View: Use this view for exploring, editing, displaying and querying your
data.

* Layout View: Use this view for designing your map and adding map elements
such as atitle, north arrow and scale bar.

To switch between Data View and Layout View:
* From the View menu, select Layout View.
The entire map is displayed and the Layout toolbar is activated.

? You can also switch between views by clicking the Data View button ®!
and the Layout View button °! on the lower left of the display window.

You will now add a legend and scale bar for your geochemical data.

To add a legend:
1. Ensure you are in Layout View.

2. From the Insert menu, select Legend.

www.geosoft.com
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The Legend Wizard opens. The Legend Items listed correspond to the layers in
your map that are currently displayed.

Figure 1.45 Legend Wizard

Choose which layers you want to include in your legend
Map Layers: Legend ltems
(¥
magnetics
£3
Set the number of columns in your legend: 1 %
[ <8sck [ Net> | [ Cancel

3. Click Preview to see a preview of your legend.
4. Click Finish.

A Legend is added to your map and displayed using default properties. You may
need to select it on the map and move it to a different location.

? Double-click any map element in the Layout View to change its
properties.

Figure 1.46 Layout View of map with legend
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Take some time now to explore the other map elements that you can add to your
map, such as a title, north arrow and scale bar. Note that you can also change the
map paper size, by using the "Change Layout" option on the ArcMap Map Layout
toolbar.

[

'} Now would be a good time to save your map document.

In this lesson you:

* Created multiple contour levels and output to a shapefile
* Applied colours to the contours

* Qutput contours to a Geosoft map layer

* Created exact contours

* Added alegend

www.geosoft.com
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Lesson 2.1 Creating a Drillhole Project and
Importing Data

In this lesson you will:
Create a drillhole project
Import data
Assign the coordinate system

Save the databases

Creating an MXD
You will begin by making a new .MXD file for your drilling project.

To create an MXD:
1. From the File menu, select New.
2. Select Blank Map and click OK.
A new, untitled map is created.
From the File menu, click Save.
Locate the Target for ArcGIS Training Data folder.

This is the location where all your data created by Target for ArcGIS will be
saved.

5. Forthe File name, enter Drillhole Mapping.mxd and click Save.

Geosoft Database Window

Target for ArcGIS stores your drillhole data within a series of Geosoft Databases.
You can view this data in the Geosoft Database Window.

To open the Geosoft Database Window:
On the Target Drillhole toolbar, click the Show Geosoft Database Window
button .

The Geosoft Database Window opens. Because you have not yet imported
drillhole data into the project, the window displays the “No Geosoft Databases
Loaded” message.

You may wish to dock the Geosoft Database Window at the bottom of your ArcMap
window.

W Toprevent a window from docking while moving it, hold down the CTRL
key.
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Figure 2.1 Geosoft Database Window docked at bottom of ArcGIS window
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Creating a Drillhole Project
Target for ArcGIS uses Geosoft Databases to store and process drillhole data.
Separate databases are created for each data type, which are linked by a common
project name.
For example, in a project named "Prospect” the following databases could be
created:
Prospect_Collar.gdb (collar information)
Prospect_Survey.gdb (hole dip-azimuth survey information)
Prospect_Geology.gdb (geology information - the “Geology” label is user
specified)
Prospect_Assays.gdb (assay information - the "Assays" label is user specified)

When you first create a new drillhole project, an empty collar database is created
and displayed in the Geosoft Database Window.

Target for ArcGIS scans the open project for all the databases currently loaded in
the project to see which data is available. If you happen to close one of the project
databases, it will not be visible to the system and will not be used when processing
your data. While working with a Target for ArcGIS project, if you wish to hide a
database, click the display of the Geosoft Database Window on and off instead of
closing it so it can continue to be accessed by Target for ArcGIS.

To create a drillhole project:
1. From the Target Project menu on the Target Drillhole toolbar, select New
Project.
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The Drill Hole - New Project dialog opens.

Figure 2.2 Drill Hole - New Project dialog

Drill Hole - Mew Project [~ 2| [zl
Project: E]
Maximum holes: 1000
Maximum data fields: 100

[ oK J [ Cancel ]

2. Forthe Project, enter Target.
The Project folder displays your current working folder.

3. Use the default values for Maximum holes and Maximum data fields per
dataset.

You should specify a number that is representative of the final estimated project
size. This ensures you have enough space available in your project while not
consuming excessive storage space. However, decreasing these values from
the defaults will not enhance performance.

PARS If you have more holes and fields to import later on, you can grow the
database to accommodate them by using the Grow option from the
Data then Maintenance menu.

4. Click OK.

The empty collar database with the project name Target_Collar.gdb is created
and displayed.

Figure 2.3 Collar Database

Importing Data

The Drill Hole Import Wizard guides you through the import process and
automatically displays your data in a spreadsheet window. You can import data in
many different formats, including ASCII and XLS/database formats.

Each type of data (collar, survey, from-to and point) has certain required fields. You
can include other fields as well, as long as the required fields are present. Each
type of data and their required fields are outlined below.

Collar Data (Drillhole Locations)

Collar data must contain unique Hole ID, Easting (X), Northing (Y), Elevation
(Relative Level), and Total Depth (EOH). The X, Y, and Depth data must all be in
the same units. The following is an example of these fields in CSV or Excel format:

Figure 2.4 Example Collar Data
Hole_ID,East,North,RL,EOH,Dip,Azimuth,

AXE001,10600,12400,367.7,38,-60,90,
AXE003,10700,12400,367.6,60,-60,90,
AXE005,10800,12400,367.5,60,-60,90,
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Hole_ID,East,North,RL,EOH,Dip,Azimuth,

AXE007,10900,12400,368.1,60,-60,90,
AXE009,11000,12400,368.3,52,-60,90,
AXEO011,11100,12400,368.9,54,-60,90,
AXE013,11200,12400,369.7,37,-60,90,
AXE014,11200,12200,369.9,33,-60,90,

Survey Data

Survey data can be in one of two forms; a Dip-Azimuth survey or an Easting-
Northing survey (less common). The required fields depend on the type of survey
you have:

Dip-Azimuth survey: Hole ID, Depth, Azimuth, Dip
Easting-Northing survey: Hole ID, Depth, Easting, Northing, Elevation

Survey data includes depth from the collar, increasing from 0 depth. The X, Y and
depth data must all be in the same units. A survey file is only required if a hole has
actually been surveyed and the dip and azimuth change at depth. If a survey is not
present, the collar dip and azimuth will be used. An example of a Dip-Azimuth
survey file is shown in the following table:

Table 2.1 Example Survey Data
Hole_ID,Depth,Azimuth,Dip

AXE001,0,90,-60
AXE003,0,90,-60
AXE005,0,90,-60
AXE007,0,90,-60
AXE009,0,90,-60
AXE011,0,90,-60
AXE013,0,90,-60
AXE014,0,90,-60

From-To Data

Also known as Interval data, this data is acquired over specified depth intervals
down the hole; for example, at a 1 m interval with a measurement starting at 0 m
and extending to 139 m. From-To data must include the Hole ID, Depth From,
Depth To and some data values. These data values can be assay results, lithology
results from core logging, grain size, mineral content, etc. Note that for assay
results you can include the units in the second row and these will be imported as
well. Table 2.3 shows an example of From-To assay data and Table 2.4 shows an
example of From-To lithology data.

Table 2.2 Example From-To Assay Data
Hole_ID,Sample,From,To,Au,As

AXE005,49040,50,54,-0.01,15
AXE005,49041,54,58,-0.01,25
AXE005,49042,58,60,0.04,20

Target for ArcGISTarget for ArcGIS Il | 45


http://www.geosoft.com/

Module 2: Managing Drillhole Data

Hole_ID,Sample,From,To,Au,As

AXE007,49043,0,2,0.01,15
AXE007,49044,2,6,-0.01,15
AXE007,49045,6,10,-0.01,15

Table 2.3 Example From-To Lithology Data
Hole_ID,From,To,Weathering,Rock,,,,,popm,ppm

AXE011,19,21Ls,S,,**.*
AXE011,21,25,Ls,Sp,,.**.*
AXE011,25,31,Ls,Sp,,.**.*
AXE011,31,37,Ls,Sp,,.**.*
AXE011,37,45,Ls,Sp,,.**.*
AXE011,45,54,Ls,Mb,,,*

Point Data

Point data is data acquired in discrete measurements made at specific depths. It
must include the Hole ID, Depth and some data values. The difference between
Point data and From-To data is that Point data only has one depth per sample, while
From-To has a depth interval. Below is an example of structural notes from the core
logger, but this could be any point source measurements (e.g., Magnetic
Susceptibility).
Table 2.4 Example Point Data

Hole ID,Depth,Type,Strike,Dip,

DDO003,35.24,FOLIATION, 356,20,
DD003,36.16,VEIN,19,25,
DD003,35.98,VEIN,15,65,
DD003,38.11,VEIN,59,40,
DD003,38.66,VEIN,343,45,
DD003,39.05,VEIN,264,60,

Now that you have created your drillhole project, you will import Collar, Survey,
Structure, and two types of From-To data: geochemical assay results and logged
geological rock codes.

Importing Drillnole Data

Target for ArcGIS has a multi-tab import tool that allows you to import all of your
drillhole data at once. This tool also allows import of multiple groups of the same
type of data, so you can import from-to data such as lithology, alteration and
assays all at once. You will now import drillhole data from a Microsoft Access
Database into Target for ArcGIS.

To import Collar data:

1. From the Data menu on the Target Drillhole toolbar, select Import then
XLS/Database.

The Drill Hole - Import XLS/Database dialog opens.
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6.

Figure 2.5 DrillHole - Import XLS/Database dialog

Drill Hole - Import XLS/Database [~ 2| (=23l
File to import: E]
Import mode: [Overwrite ']

I Wizard I [ Template ] [ Cancel ]

For the File to import, click the Browse button L,
Change the File of type from Files (*.xls) to Files (*.mdb).
From the Drilling Data folder, select Target Drilling.mdb and click Open.

Click Wizard.

The Drillhole Import Wizard opens.

Figure 2.6 Drillhole Import Wizard

s M
Drillhole Import sl [
Collar | survey | From-To [ Paint |
Collar View: [Collar -
Database Fields Channel Type
FEC| O Motimported
East ) Data
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evation )

Dip sting
Azimuth ) Narthing
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Local_X () Callar Azimuth
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Field name: HoleID

Data type: String 20

Data format: Normal

Filter Conditions... Dummy:
Ready to import Collar data.
o) Comm ) oo )

In the Collar tab, select Collar from the Collar View list.

7. Using the following table, select the appropriate Channel Type for each item in
the Database Fields list.

Database Fields

HolelD
East
North
Elevation

Dip

Channel Type
Hole ID

Easting
Northing
Elevation

Collar Dip

www.geosoft.com
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Database Fields Channel Type
Azimuth Collar Azimuth

EOH Total Depth (EOH)
GEO Data

PROSPECT

TENEMENTID

STARTDATE

Local_X

Local Y

8. Click on theOKtab to continue importing data

Importing Survey Data

Various types of surveys (for example, acid, gyroscope and magnetic orientation)
can be used to record hole depth (depth measured from the drillhole collar at the
surface).

Now that you have imported the collar data, you will import the survey data.

To import Survey data:
After the previous exercise, the Drillhole Import Wizard should be open to the
Survey tab

1. Inthe Survey tab, make sure to select Survey from the Survey View list and
that Dip-Azimuth is the chosen Survey Type.

The Wizard updates the list of Database Fields associated with the Survey
data. The Survey type is automatically detected as being Dip-Azimuth Survey
data.

Select the appropriate Channel Type for each item in the Database Fields list.

Click on the From-To tab to continue importing.

Importing From-To Data

Next, you will import two types of From-To data: geochemical assay results and
logged geological rock codes.

Importing Geochemical Assay Data

Geochemical assay data are typically acquired by obtaining core or rotary drill
samples over specific depth ranges (From-To ranges) and sending samples to an
assay laboratory. Numerical results are typically returned from the laboratory in
electronic format and can be imported quickly. Before import, you must make sure
that your data files contain the following information — HolelD, From, Toand a
series of Assay results.
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To import geochemical assay data:

The Drillhole Import Wizard should be open to theDH-Datatab..
1. Inthe From-To tab, select Assay from the From-To View list.

The Wizard updates the list of Database Fields associated with the Assay data.
2. Select the appropriate Channel Type for each item in the Database Fields list.

3. You canrename the Data Name by clicking the # icon next to the From-to
View list. For this lesson, use the default Assay.

Importing Geological Data

Target for ArcGIS provides a versatile environment forimporting a wide variety of
geological data ranging from rock codes, extended text descriptions, alteration
types, contact data such as fractures or faults, and other core log information that is
important in your drilling project.

This type of information generally consists of text, but you can also add numerical
values; for instance, if you want to retain numeric codes for statistical purposes or
you want to run your own advanced classification strategies in Target for ArcGIS.

To import geological data:
The Drillhole Import Wizard should be open to the From-To tab..

1. Click the "Add" next to the From-To View dropdown. This adds a second From-
To tab to the import wizard.

2. Inthe From-To tab, select Geology from the From-To View list.

The Wizard updates the list of Database Fields associated with the Geology
data. The Types of Data to import is automatically detected as being From-To
Data.

3. Using the following table, select the appropriate Channel Type for each item in
the Database Fields list:

Database Fields Channel Type
HolelD Hole ID

From Depth From
To Depth To
Weathering Data

Rock

Foliation

4. Forthe Data Name, use the default Geology and click on the Point tab to
continue the import
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Structure Data

Structural data is point data collected at specific depths down a drillhole. This data
often represents planar structures (bedding, cleavage, schistosity, faults, joints and
veins) or linear structures (planar structure intersections, mineral stretching, and
other forms of lineation). In general, each structure type consists of an alpha and
beta angle of measurement to determine the geological orientation of structures
down the drillhole. In the struture data you will shortly import, the "alpha" represents
the dip of the structure relative to the core reference line and the "beta" represents
the dip direction of the structure relative to the core reference line.

To import structure data:
The Drillhole Import Wizard should be open to the Point tab. .

1. Inthe Point tab, select Structure from the Point View list.

The Wizard updates the list of Database Fields associated with the structure
data. .

2. Select the appropriate Channel Type for each item in the Database Fields list.
3. Forthe Data Name, use the default Structure and click OK.

After importing all of your data, examine the databases and ensure all the data was
imported correctly. Note how the data is stored differently in each database. In the
collar database, data for each collar is stored on a separate row; other databases
store each drillhole as an individual table or “line”.

Collar data is now stored within the Target_Collar.gdb database. The coordinates
are now stored in the DH_East, DH_North and DH_RL channels.

Survey data is now stored within the Target_Survey.gdb database. DH_East,
DH_North and DH_RL channels have also been added to this database; these
channels are calculated from the collar and survey data.

Assay data is now stored within the Target_Assay.gdb database. DH_East,
DH_North and DH_RL channels have also been added to this database; these
fields are calculated from the collar and survey data.

Geology data is now stored within the Target_Geology.gdb database . DH_
East, DH_North and DH_RL channels have also been added to this database;
these fields are calculated from the collar and survey data.

Structure data is now stored within the Target_Structure.gdb database . DH__
East, DH_North and DH_RL channels have also been added to this database;
these fields are calculated from the collar and survey data.

W When the line header cell is selected, you can use the Page Up and Page
Down keys to scroll through the lines.

Applying Filters When Importing Data

The Filter Conditions option in the Import wizard can be used to import data that
meets a specific criteria.
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Next, you will re-import the structure data, using the Fracture/Joint Set structure
type as afilter condition, to create a new database with only Fracture/Joint Set
data.

To import structure data with a filter condition:

1. From the Data menu on the Target Drillhole toolbar, select Import then
XLS/Database.

The Drill Hole Import Wizard dialog box opens.
2. Click Wizard.
The Drill Hole Import Wizard opens.
From the Database Table list, select Structure.
For Types of Data to import, select Point Data.
Click Next.
Click Filter Conditions.

The Filter Conditions dialog box opens.

o g M~ W

~N

From the Field list, select Structure_Type [WChar].
From the Condition list, select equals.

In the Value field, type prt and click OK.

10. Click the Rename icon.

11. For the Data Name, type Fractures and click OK.

A new database (Target_Fractures.gdb) is created that contains only intervals
where the prt structure type (Fracture/Joint Set) is logged.

Assigning the Coordinate System
Now that you have imported your data and the coordinates from the collar table

have been added to your databases, you will assign the coordinate system to all
databases at once.

&y Drillhole coordinates and downhole depths must be in the same units. You
can work with local coordinate systems and projected coordinate systems,
but the DH_East and DH_North coordinates cannot have a geographic
(long, lat) projection.

To set the coordinate system information:

1. From the Data menu on the Target Drillhole toolbar, select Coordinate
System.

The Coordinate System dialog opens indicating the current coordinate system
is unknown.
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5.

Figure 2.7 Coordinate System dialog

Coordinate System @
Project name: Target
Coordinate system: () Projected (x.y)
Projection method: ¥
Datum: ¥
Local datum transform: ¥
Length units: metre i
Transformation: none
Orientation: none
ok || Cancel |
Coordinate System @
Project name: Drillhole
Coordinate system: () Projected (x.y)
© Urknoun
Projection method: ¥
Datum: ¥
Local datum transform: ¥
Length units: metre i
Transformation: none
Orientation: none
[ ok [ Cancel
For the Coordinate system, click Projected (x,y).
W You can also copy coordinate system information from a Database,

Grid, Voxel, Geosoft Projection, Esri Projection, Esri Coordinate
System, Warp, Polygon, or GM-SYS Model.

From the Projection method list, select Map Grid of Australia zone 50.

W For more information on the selected projection method or to create a

custom projection, click the More button.

From the Datum list, select GDA94.

The Local datum transform defaults to [GDA94] (1m) Australia - onshore.

Click OK.

The coordinate system is applied to the DH_East, DH_North and DH_RL channels
in all four of the databases in your Drillhole project. These channels are the current
X, Y and Z channels as indicated by the blue x, y and z markers in the channel
header cells.
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ALY To ensure consistency between your databases and grids, you should
define the coordinate system information for your database before creating
maps from it.

Saving a Database

Itis always a good habit to save changes you make to your databases, including
new databases.

To save all databases:
From the Target Project menu on the Target Drillhole toolbar, select Save
Databases.

To save changes to an individual database:
1. Inthe Geosoft Database Window, select the database you want to save.

2. From the Geosoft Data menu on the Geosoft Database toolbar, select Commit
Geosoft database changes.

The Save Changes dialog opens.

Figure 2.8 Save Changes dialog

Save Changes E3

:] Save all changes to current database?

[ ves || Mo

3. Click Yes.
The selected database is saved to your working directory.

L2 To undo changes, select Discard Geosoft database changes from the
Geosoft Data menu. This will restore your database to its last saved state.

by If you close your project without saving it you will be prompted to save any
modified documents.

In this lesson you:
Created a drillhole project
Imported data
Assigned the coordinate system

Saved the databases
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Lesson 2.2 Working with Geosoft Databases and
Profiles

In this lesson you will:
Examine the databases
Hide and view channels
Protect channels
View profiles
Use channel math tools
Display multiple profiles

Save changes to the database

Geosoft Databases

The Target drillhole project consists of a set of Geosoft Databases (*.GDBs). The
database is organised in lines, channels and elements and stores all data
“elements” of a particular type in individual “channels” (columns). Database “lines”
are a collection of related “channels”.

In Target for ArcGIS, the collar database contains a list of holes and collar-related
data stored in individual rows on one page or “line”. In the other databases, data is
stored in lines representing different drillholes; one drillhole is visible at a time.

The figure below outlines the main characteristics of a Geosoft Database.
Figure 2.9 Geosoft Database characteristics

Column [channel)

Line/Group |1{=qd-'=r cell Current X, Y_[and Z) column Columrln header cell
I¥ DH Collay DH Hole DH East DH Horth DH RL DH Dipj
B 6.0 pooo EEEE 09888 60.8 -60
1.0 pponz| 11697.3 9983 .1 60.6 -59
2.0 ppoez| 121@0.@ 9904 @ 60.0 —60
Fiducial 3.0 pDOBY| 128088.8| 108027.0 60.0 -55
cells "] RCOD1 114081.5| 18872.1 61.4 —6o} Data cell
.o RCOBZ| 11498 4| 1004085 60.8 —60
6.0 RCOBZ| 11597.6| 10048.2 60.5 -59
7.0 RCODY| 11696.5| 10868.6 60.2 —6@
2.0 RCOBS| 11697 .1 9992 4 60.5 _59
| 9.0 RCOB6| 12288.9 9970.9 60.9 -59
] _’|_I

You can customise the database display to your specifications. You can also
modify data within the database without actually committing to any changes until
you decide to save the database. After you save the database, your changes are
permanent.

Channel Header Cells are label cells used to identify the type of data contained in a
spreadsheet column. The channel headers provide a visual indication of the current
status of the displayed channel. A black triangle in the top left corner of the header
cell indicates the channel is read-only and may not be modified.
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Now you will examine the databases and learn how to manipulate and display data
within them.

To select a line in a database:
1. Inthe Geosoft Database Window, select Target_Assay.gdb.

Data for drillhole AXEQO5 is currently displayed.
Click the line/group header cell in the top left corner of the spreadsheet.
Right-click and select List.
A list of line numbers corresponding to each drillhole in the current database is
displayed.

4. Scroll down and select SKA332.
The spreadsheet window displays the data for drillhole SKA332.

v You can also use the Go to First, Last, Previous and Next line/group in
Geosoft database buttons on the Geosoft Database toolbar.

v When the line header cell is selected, you can use the Page Up and
Page Down keys to scroll through the drillholes.

A single asterisk (*) indicates a dummy or null value. A double asterisk
(**) indicates the channel is not wide enough to display the values and
should be resized.

B

When you import data, all of your data is automatically displayed. You may want to
hide certain channels from display in the Geosoft Database window.

To hide a channel from view:
1. Inthe Target_Assay database, click the channel header cell of the Au
channel.

The Au channel is selected.
2. Right-click and select Hide Column.

The channel is hidden from view; however, the Target_Assay database still
contains the data.

W You can also hide the selected channel by pressing the Spacebar.

To view a channel in the database:
1. Click the channel header cell of the empty channel.

The empty channel is selected.
2. Right-click and select List.

A box appears beneath the empty channel header cell listing the available
channels that currently are not being viewed in the spreadsheet window.

3. Select Au and click OK.

The channel is now displayed in the spreadsheet.
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v If you know the name of the data channel, you can position the cursorin
an empty channel header cell, type the name of the channel and press
Enter.

After importing your data into a database, there may be a channel you want to
protect. When channels are protected, they cannot be edited.

To protect a channel:
Right-click the Au channel header cell and select Protected.

The black triangle appears in the channel header cell and the channel is
protected. You can also select Protect All and all channels will be protected
from editing.

To remove channel protection:

Right-click the Au channel header cell and clear the check mark beside
Protected.

The black triangle disappears and the channel is no longer protected. You can
also select Protect None and all channel protections will be removed.

Channel Statistics

Statistical information about your data can be very useful for general quality control
and to ensure the values are in range with what you would expect.

You will now calculate statistics for the Au channel.
Table 2.5 Methods for calculating statistics
To: Do this:

Calculate statistics for selected cells Click and drag to select the desired
cells, right-click and select Statistics.

Calculate statistics for a selected Click the channel header cell two
line of the database times, right-click and select
Statistics.

Calculate channel statistics for all of Click the channel header cell three
the selected lines in the database times, right-click and select
Statistics.

The Stat Report dialog opens.
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Report dialog

Stat Report

Channel:
Line(s):
Fid range:

Number of items:

Length:
Standard deviaticn:

Arithmetic sum:

Au
SKA332
8328 to 8348

21

Number of dummies: 0

Minimum: 0.01
Maximum: 0.05
Mean: 0.01

Length-weighted mean: 0.01

61.00

0.01

0.23

[ ok ][ savestats |

You will now edit the properties of the Au channel to display more decimal places.

To edit the channel properties:
1. Right-click the Au channel header cell and select Edit.

The Edit Channel dialog opens.

Figure 2.11 Edit Channel dialog

Edit Channel (=23
Mame Au
Label Au
Data type Double
Array Size 1
Class Assay
Units
[ Protected

Display

Field width 10

Decimals 2

[ OK ]’ Cancel ” Help ]

2. ForDecimals, enter 3 and click OK.

The Au values are now displayed with three decimal places.

Profile Window

The Profile window shows a graphical representation of the data in your Geosoft
Database. The profile appears directly below its corresponding database in a profile
window. You can display up to five profile windows and up to a total of 128 profiles.

The figure below outlines the main characteristics of the Profile window.
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Figure 2.12 Profile window

Selected profile window
<

CRT: |
/ Profile window
Verlical scaleq- 8.085
0. 00]
194
5}fmb0| mei|e windaow .
Data range— 101 ' " ‘
: Gz @
Selected —— Au -1.3 62.5 126 .3
channel (Fid) i Fd
e l Fa
o e~

Fiducial increments

To display a profile:
1. Undock the Geosoft Database Window by double-clicking on the title bar.

The window undocks and can be resized as necessary.
2. Right-click in the Au channel and select Show Profile.
The Profile Window opens below the spreadsheet.

Figure 2.13 Profile of Au channel

Geosoft Databaze Window =]
Target_Collar.gdb | Target_Survey.gdb Target_Assay.gdb | Target_Geology.gdb | Target_Structure.gdb 4Bk X
v SKA332 | DH From | DH To | Sample [ MW  As | DH_East ] DH_Nortj -
8328._d 0.00 3.040 0.020 11.200  716150.0 6531527| |
8329.8 3.008 6. 08 8.818 9.280 716168.5 6531527
8336.8 6.008 9.068 8. 805 11.880 716162.8 6531527
8331.8 0.0608 12.08 8. 805 25.88 716163.5 6531527
8332.8 12.88 15.08 8. 805 53.88 716165.8 6531527
8333. 9 15.88 18.68 8. 885 54.280 716166.5 6531527
< [l 3
8.851
6.828
.88
fiu 8327 .8 8338.5 83409 .2
(Fid) .l
Chan Au

Profile windows are dynamically linked to their corresponding database. When you
select a value or range of values in either the database or profile window, they are
also highlighted in the other window.

To remove a profile:
Right-click in the "Mag" channel header cell and select Remove Profile.

The profile is no longer displayed.
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Creating a New Channel

You can create new channels in your database to store the results of mathematical
expressions or other processing operations. You should create a new channel for
storing any changes you make to the original imported data.

In this lesson, you will create a new channel to store the results of a mathematical

expression.

To create a new channel:

1. Inthe Geosoft Database Window, ensure the Target_Assay.gdb database is

selected.

2. Right-click inthe DH_East channel header cell and select Insert Column.

A new empty channel appears to the left of the DH_East channel.

3. Inthe empty channel header cell, type Au_As and press ENTER.

The Create Channel dialog opens.

Figure 2.14 Create Channeldialog

s

Create Channel
Mame Au_As
Label
Data type Double hd
Array Size 1
Class
Units
[ Protected

Display

Field width 10

Decimals 2

[ 0K ” Cancel ” Help ]

4. ForLabel, enter Au/As.

When plotting channel information, this optional Channel Label will be used

instead of the Channel Name.
For Decimals, enter 4.
Click OK.

The new channel is added and is filled with dummy, or null, values indicated

with a single asterisk.
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Figure 2.15 Assay database with new empty channel

Geosoft Databaze Window =]
Target_Collar.gdb | Target_Survey.gdb Target_Assay.gdb | Target_Geology.gdb | Target_Structure.gdb 4Bk X
v SKA332 | DH_From | DH_To | Sample Au As MT
83284 .69 3.00 8.0620 11.2 * 716159
8329.8 3.008 6. 08 8.818 9.20 * 716168
8336.8 6.008 9.068 8. 805 11. 88 *  F16162
8331.8 0.0608 12.08 8. 805 25.88 * 716163
8332.8 12.88 15.08 8. 805 53.88 * 716165
8333.8 15 .88 18.08 8. 805 54,208 *  F16166
8334. 8 18.88 21.08 8. 805 4. 68 * 716168
8335.40 21.88 24. 08 0. 885 58.48 ® ¥16169
8336. 8 24 .88 27 .08 8.818 66 .28 *  F16171
8337.8 27 .88 30.08 8.818 41. 88 *  F16172
8338.8 38.88 33.08 8. 805 147 .98 * 716174
83392.8 33.88 36.08 8. 805 124 .98 *  F16175
8340.09 36.00 39.08 0. 885 47.28 ¥  ¥16177
8341. 8 39.88 42 .08 8.8208 57 .48 * 716178
8342 .9 42 .88 45.068 6.8208 08.28 * 716188 A
] ;
Chan fiu_fs

&y A single asterisk (*) indicates a dummy or null value. A double asterisk (**)
indicates the channel is not wide enough to display the values and should
be resized.

Computing a Mathematical Expression

Now that you have added a new empty channel, you will use the advanced status
bar feature in the spreadsheet window to apply a mathematical expression to the
data selected in your spreadsheet window. You can select a portion of a channel,
an entire channel on a single line, or the same channel on all lines in your database.

In this example, the contents of the new channel will be the results of dividing the
Au channel by the As channel.

To compute a new channel of data:
1. Click the Au_As channel header cell three times.

This entire channel is selected in the database.
2. Press the equal sign (=) on your keyboard.

This changes the status bar at the bottom of the spreadsheet window to
"Formula=".

3. Inthe Formula= box, type Au/As and press ENTER.

The values are calculated and output to the Au_As channel.
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Figure 2.16 Assay database with new calculated channel of data

Geosoft Databaze Window =]
Target_Collar.gdb | Target_Survey.gdb Target_Assay.gdb | Target_Geology.gdb | Target_Structure.gdb 4Bk X
v SKA332 | DH_From | DH_To | Sample Au As MT
83284 .69 3.00 8.0620 11.2 8.8018 716159
8329.8 3.008 6. 08 8.818 9.20 8.8611 71616 8|
8336.8 6.008 9.068 8. 805 11. 88 6.8885 716162
8331.8 0.0608 12.08 8. 805 25.88 8.868682) 716163
8332.8 12.88 15.08 8. 805 53.88 6.86861 F16165
8333.8 15 .88 18.08 8. 805 54,208 6.86861 716166
8334. 8 18.88 21.08 8. 805 4. 68 6.86861 716168
8335.40 21.88 24. 08 0. 885 58.48 0.9881 716169
8336. 8 24 .88 27 .08 8.818 66 .28 8.86882 716171
8337.8 27 .88 30.08 8.818 41. 88 8.8882 716172
8338.8 38.88 33.08 8. 805 147 .98 6.86888 716174
83392.8 33.88 36.08 8. 805 124 .98 6.86888 716175
8340.09 36.00 39.08 0. 885 47.28 B.0881 716177
8341. 8 39.88 42 .08 8.8208 57 .48 8.86883 716178
8342 .9 42 .88 45.068 6.8208 08.28 6.868682 716186 A
] ;
Chan fiu_fs

Channel Math Expression Builder

Now you will use the Channel Math Expression Builder to compute new data. With
the Channel Math Expression Builder you can create, save, load and execute math
expressions on data that is stored in database channels.

In this example, you will use a true/false expression to create a new channel named
High_Au representing Au values higher than 10 ppm; if the value is less than 10
ppm, it will receive a dummy value.

To use the Channel Math Expression Builder:

1. From the Data menu on the Target Drillhole toolbar, select Utilities then
Channel Math.

The Channel Math Expression Builder dialog opens.

Figure 2.17 Channel Math Expression Builder dialog

E xpression:

Channel Math Expression Builder

Step 1: Tvpe in a makhematical expression, Use yvour own variable names o use the button below to insert
default variable names,

Example: CO=C14+C2

e =)

|co =

Clear

¥ Operators ]

[

Inzert Channel W ariable

Azzign channels:

Commar tasks:

Espression file:

Step 2 Azzign actual channels to the vanable names used above.

co=

™

[ OK ” Cancel ]

2. From the list of Common tasks, select True/False statement.
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The Expression box at the top updates with an example mathematical
expression.

In the Expression box, change the value of 5000 to 10.
In this example, all Au values greater than 10 will be output to the new channel.

In the Assign channels box, click in the list beside the C0 channel and enter
High_Au.

A new channel called High_Au will be created when this expression is
computed.

From the list beside the C1 channel, select Au.

The expression that will be computed [cO = (c1>10) ? (Cl) : (DUMMY);]
can be read as follows: the new High_Au channel (CO) will contain values of Au
(C1) that are greater than 10 ppm; otherwise, a dummy value will be output.

Click OK.

A new channel named High_Au containing the results of this expression is
added to your Target_Assay database.

Figure 2.18 Assay database with new High_Au channel

Geosoft Databaze Window El
Target_Collar.gdb | Target_Survey.gdb  Target_Assay.gdb | Target_Geology.gdb | Target_Structure.gdb 4k X
v SHA332 As Au_As DH East[] DH Northl] DH RL [ Hask [PUFLTI ~
8328. 9 11.24 8.8818 716159.8 6531527.3 399.2 1 A
8329.9 9.28 8.8811 716168.5 6531527.3 3066 1 A
8330.89 11.084 8.8885 716162.8 6531527.3 394.49 1 A
8331.9 25.840 0.08802] 716163.5 6531527.3 391.4 1 A
8332.9 53.84 8.8881 716165.8 6531527.3 388.8 1 A
8333.9 54.20 8.8881 716166.5 6531527.3 386.2 1 A
8334. 5 74.60 8.8881 716168.8 6531527.3 383 .6 1 A
8335. 8 58.40 8.8881 716169.5 6531527.3 381.49 1 A
8336.19 66.20 8.8802 716171.8 6531527.3 378.4 1 A
8337.9 41.084 8.8882] 716172.5 6531527.3 375 .8 1 A
8338.5 147 .08 8.8888 716174.8 6531527.3 373.2 1 A
8339.9 124.089 8.8888 716175.5 6531527.3 370.6 1 A
8340. 5 47.24 a.8881 716177.8 6531527.3 368.0 1 A
83u1.49 57.40 8.8883 716178.5 6531527.3 365 .4 1 A
83424 98.24 8.8882] 716188.8 6531527.3 362 .8 1 4 _
“ 3
Chan High_Au

Next, you will use tools in the profile window to display and compare the values in
the High_Au and Au channels to visually identify lines that have high Au values.

To compare the Au values and the High_Au values:

1.
2.

Go toline SKC242.

Right-click in the High_Au channel and select Show Symbol Profile.
This displays the High_Au values with a default symbol style.
Right-click in the Au channel and select Show Profile.

Right-click in the profile window and select Y Axis Options.

The Panel Y-Axis Scale Options dialog opens.
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Figure 2.19 Panel Y-Axis Scale Options dialog

Panel ¥-Axis Scale Options @
Changing Lines
@ Scale to fit for each line
(") Same axis scale for all lines

() Same dynamic range, centered for each line

Profile Scaling
@ Scale each profile separately
(") Same axis scale for all profiles

() Same dynamic range, centered for each profile

[ OK. ][ Cancel H Help ]

5. Inthe Profile Scaling section, select Same axis scale for all profiles and
click OK.

Although the High_Au and Au channels have different dynamic ranges, they are

displayed using the same axis scale.

Figure 2.20 Comparing High_Au and Au profiles

Geosoft Databaze Window =]
Target_Collar.gdb | Target_Survey.gdb  Target_Assay.gdb | Target_Geology.gdb | Target_Structure.gdb 4k X
v SHC242 As__ | Au_As | DH_East ] DH_Horthl] DH_RL [] Mask | High_fu |~
2082. 8.828 * ¥ 716648.8 6531329.2 429.49 1 |
9903.4 a.018 * ¥ 716658.3 6531329.2 4264 1
99[111.[1| 0. 685 * ¥ 716651.8 6531329.2 423.8 1
9905.4 8. 085 * ¥ 716653.3 6531329.2 421.2 1
99[16.[1| 8. 685 * ¥ 716654.8 6531329.2 418 .6 1
9907.4 8. 085 * ¥ 716656.3 6531329.2 4161 1
9908.4 a.018 * ¥ 716657.8 6531329.2 4135 1
[TTTH: | 8. 885 * ¥ 716659.3 6531329.2 418.9 1
< [ [
83.915
41.138
1.6 . .
Au 9068.8 9962.0 10823 .2
(Fid) |
Chan Au

6. Click inthe line header cell and use the Page Up and Page Down keys to
move to different lines in the Geosoft Database.

Lines that have High_Au values are more easily identified by examining the
profiles.

Saving a Database

Changing how data appears in the spreadsheet (i.e., showing or hiding channels)
does not alter the data in your database; however, editing (i.e., adding or deleting
channels or altering data values) does change your underlying database.

You should save changes to your database whenever you perform a major editing
or processing step. If you process your data and the results are not as you
expected, you can restore your database to its previously saved state.
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To save changes to your database:
1. From the Geosoft Data menu on the Geosoft Database toolbar, select Commit
Geosoft database changes.

The Save Changes message window opens asking if you want to save all
changes to the current database.

2. Click Yes.
Your database changes are now saved.

i) To undo changes, select Discard Database Changes from the
Database menu. This will restore your database to its last saved state.

In this lesson you:
Examined the databases
Hid and viewed channels
Protected channels
Viewed profiles
Used channel math tools
Displayed multiple profiles
Saved changes to the database
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Lesson 2.3 Using QA/QC Tools

In this lesson you will:
Run QAQC tools on all data
Run QAQC tools on the From-To data

Quiality Control and Quality Assurance Tests

Target for ArcGIS provides tools to perform Quality Control and Quality
Assurance (QAQC) tests on each of the five different database types (Collar Data,
Dip/Azimuth Survey, Easting-Northing Survey, From-To Data, and Point Data). For
each database type you can select different QAQC options.

iy The QA/QC tool also reports unregistered holes in each database. These
are drillholes in the databases that do not correspond to any entry in the
collar table.

An important point to note about the QAQC tools is that they are designed to look
for various errors in your datasets and report them to you; the tools themselves do
not fix these errors for you but indicate to you where you may need to investigate
your data.

The following table lists the QA/QC tool options for each data type:
Table 2.6 QA/QC Tools

Data Type QA/QC Tools

Collar data Dummy East, North or RL
Duplicated Locations
Reversed Easting/Northing
Dip out of range -90 to 90
Azimuth out of range -360 to 360
Dip sign discrepancy
Top of hole depth less than 0
Hole depth less than 0
Hole depth less than top of hole

Dip-azimuth Dummy Depth
survey Depth less than hole top
Depth greater than hole bottom
Duplicated Depths
Out-of-sequence Depths
Dummy Dip or Azimuth
Dip out of range -90 to 90
Azimuth out of range -360 to 360
Dip sign discrepancy
Max curvature - degrees per metre (or feet)

East-North survey Dummy East, North or RL
Duplicated Locations
Reversed Easting/Northing
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Data Type QA/QC Tools

Broken trend in RL
Max curvature - degrees per metre (or feet)

From-To data Dummy From or To
From greater than To
From equals To
From or To less than hole top
From or To greater than hole bottom
Duplicated From-To intervals
Out-of-sequence Depths
Overlapping intervals
Missing intervals
Duplicated sample numbers

Point data Dummy Depth
Depth less than hole top
Depth greater than hole bottom
Duplicated Depths
Out-of-sequence Depths
Duplicated sample numbers

You will run the QAQC tools first on all data and then you will change some of the
From-To options and run the tools again.

To run the QAQC tools on all data:
1. From the Data menu on the Target Drillhole toolbar, select QA/QC.

The Drill Hole - QAQC tools dialog opens.
Figure 2.21 DrillHole - QAQC tools dialog

Drill Hole - QAQC tools [~ 5| (23]
Data Type to QAQC: [Cullar Data ']
Hole selection: [Selec:ted holes ']

[ Ok ] [ Options ] [ Cancel ]

From the Data Type to QAQC list, select All Data.
From the Hole selection list, select All holes.
Click OK.

If this is your first time editing a file in Target for ArcGIS, the Select a default
text editor dialog opens.

Figure 2.22 Select a default text editor dialog

Select a default text editor @
Editor program name: notepad.exe E]

5. Click the Browse button to select a default text editor or click OK to select the
default.
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The QAQC.log file opens in a text editor.
Figure 2.23 QAQC.log file

File Edit Format View Help

" QAQC.log - Notepad =R |ESR |

collar pata-----—------

] »

Dip-aAzimuth Survey Data

East-North Survey Data

There is no East-North survey database.

From-To Data------------
Database: c:‘.geosoft training data\Target_Assay.gdb

AXECQOS [line 0] : M'ISS'II"Ig From/To interval at_hole top [0.00 : 50.00].
AXRCO13 [1ine 1928] Missing From/To interval at hole top [0.00 : 34.00].
AXRCO16 [1ine 2233] : Missing From/To interval at hole top [0.00 : 34.00].
AXRC027 [l1ine 3711] : Missing From/To interval [36.00 : 40.00].

AXRC030 [Tine 4319] : Missing From/To interval at hole bottom [189.00 : 190.00].
AXRCO036 [1ine 5213] : Missing From/To interval [153.00 : 154.00].

AXRCO46 [1ine 5924] : Missing From/To interval at hole top [0.00 : 34.00].
SKA041 [Tine 7098] : Missing From/To interval at hole bottom [81.00 : 83.00].
ska052 [line 7146] : Missing From/To interval at hole bottom [87.50 : 88.00].
ska053 [line 7172] : Missing From/To interval at hole bottom [75.50 : 76.00].
SKA065 [1ine 7467] : Missing From/To interval at hole bottom [72.00 : 73.00].
SKa070 [line 7580] : Missing From/To interval at hole bottom [75.00 : 78.00].
skC255 [line 11057] : Missing From/To interval [39.00 : 42.00].

SKC380 [1ine 14601] : Missing From/To interval [87.00 : 90.00].

SKC386 [line 14878] : Missing From/To interval at hole top [0.00 : 36.00].
SKC389 [line 14942] : Missing From/To interval at hole top [0.00 : 36.00].
SKC390 [1ine 15016] : Missing From/To interval at hole top [0.00 : 36.00].
SKC391 [line 15100] : Missing From/To interval at hole top [0.00 : 42.00].
SKC392 [line 15138] : Missing From/To interval at hole top [0.00 : 42.00].
5KC392 [1ine 15150] : Missing From/To interval [54.00 : 55.00].

SKC393 [line 15245] : Missing From/To interval at hole top [0.00 : 36.00]. ik

Examine the contents of this report. It shows that there are no errors in the Collar
Data, the Dip-Azimuth Survey Data, nor the Structure data, and that an East-North
Survey database was not imported.

However, the From-To data returned several “errors”. Errors occur in the Geology
database; most of these are caused by missing and overlapping intervals. There
are numerous drillholes with overlapping intervals and it may be necessary for the
data logger to return to the source and make the necessary corrections.

The Assay database also has numerous missing intervals and a few errors where
the final “To” of the "From-To" data is greater than the total hole bottom.

Errors in the databases should be corrected in the original source data rather than in
the Geosoft Databases. That way, any colleagues using the same data will have
access to the latest, updated data. As long as the channel names do not change
and additional channels are not created, drillhole data can be re-imported intoTarget
for ArcGIS by selecting the Refresh Project tool from the Target Project
menumenu. Any new drillholes that are added to the source data will also be
imported into the drillhole project.

Next, you will run the QAQC tools on the From-To data and select some specific
options.

To run the QA/QC tools on the From-To data:
1. From the Data menu on the Target Drillhole toolbar, select QA/QC.

The Drill Hole - QA/QC tools dialog opens.
From the Data Type to QA/QC list, select From-To Data.
Click Options.
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The QA/QC - From-To data options dialog opens.

Figure 2.24 QA/QC - From-To data options dialog

QA/QC - From-To data options

Dummy From or To:

From greater than To:

From equals To:

From or To less than hole top:

From or To greater than hole bottom:
Duplicated From-To intervals:
Out-of-sequence intervals:
Overlapping intervals:

Missing intervals:

Duplicated sample numbers:

= |[= =
b6 |5
I

<
i

yes

< |[=[<
R
I

= |[=
b6
4

L2 sl

A

4

Cancel

For Overlapping intervals
Click Back.
Click OK.

and Missing intervals,select no.

The FromToData.log file opens in a text editor. The QA/QC tools are run only on

the From-To data.

Figure 2.25 FromToData.log file

j FromToData.log - Notepad

File Edit Format View Help

[E=3 EoR =)

Database: C:'\Geosoft Training
SKD388 [Tine 19414]
skpd11l [line 19560]
skD514 [1ine 20080]

Database: C:'\Geosoft Training

SKD3I8E [line B448] : To [112.
skD411 [1ine 8518] : To [141.
skD434 [1ine 8720] : To [352.
skDp514 [line 8838] : To [327.

 To [112.
: To [141.
: To [327.

Data\Target_Assay. gdb

Data‘\Target_ceology.gdb

50]
50]
20]
33]

[112.00].
[141.00].
[352.00].
[327.00].

Hole Bottom
Hole Bottom
Hole Bottom
Hole Bottom

than
than
than
than

is greater
is greater
is greater
is greater

50] 1is greater than Hole Bottom [112.00].
50] is greater than Hole Bottom [141.00].
33] is greater than Hole Bottom [327.00].

Now would be a good time to save your map document.

In this lesson you:

Ran QAQC tools on all data

Ran QAQC tools on the Frol
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Lesson 2.4 Creating Composite Databases

In this lesson you will:
Create a composite database using the fixed interval method
Create a composite database using the lithological interval method
Create a composite database using the best-fit lithological interval method

Create a composite database using the significant intersections method

Composite Databases

A composite database is a database where the From—To data intervals have been
re-calculated to an alternative interval. This practice is common when dealing with
geochemical data; for example a geologist might want to re-calculate assay values
over larger intervals than those originally sampled, perhaps to suit a certain deposit
style or geotechnical scenario. The composite database will include all the selected
lines from the input database and the From, To, Mask and all the assay channels
from the input database.

In this lesson, you will create a composite database from the Assay database. The
original Assay database has inconsistent 'From-To' intervals; you will make the
intervals an even 10 m with the average assay value calculated over this new
interval.In this lesson, you will create composite databases based on lithology,
best-fit lithological interval and significant intersections.

To create a composite database using fixed intervals:
1. From the Data menu on the Target Drillhole toolbar, select Composite
database.

The Drill Hole Composite Database dialog box opens.
Figure 2.26 Drill Hole Composite Database dialog box
Drill Hole Composite Database [~ 5| (3]

Input assay database: [Target_Assay.gdb ']

Output composite database tag: composite

Holes to process: [Selected holes ']
Interval selection: [Fixed interval ']

2. Ensure the Input assay database is Target_Assay.gdb.
For the remaining parameters, use the defaults.
3. Click Next.

The Fixed interval dialog box opens.
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Figure 2.27 Fixed interval dialog box

Fixed interval @
Interval length: 1.0
Weighting channel: [ v]
[ Next= ] [ <Back ] [ Cancel ]

4. Forthe Interval length, enter 10 and click Next.

The Reject options dialog box opens. For this lesson there is no need to specify
any rejection options.

Figure 2.28 Reject options dialog box
Reject options @

Reject intervals shorter than:

Reject intervals gaps greater than:

Reject intervals where the value of: [ v]

is...: [ v]

value:

[ Finish ][ <Back ” Cancel ]

5. Click Finish.
The composite From-To assay database is created.

Figure 2.29 Target_composite.gdb

Geosoft Database Window B
gdb | Target_Survey.gdb | Target_Assay.gdb | Target Geology.gdb | Target_Structure.gdb Target_composite.gdb | 48 x
v AXEABS DH _From DH To Au_As Au As High_Au Mask DH_East
0.5 0.8 10.8 * * * * 1 16677

1.9 10.08 20.0 * * * * 1 716682

2.8 20.08 30.0 *| *| * | 1 716687

3.9 30.08 40,0 * * * * 1 716692

4.9 40.08 50.0 * * * * 1 16697

5.0 50.0 60.6 0.080806 8.812 20.00 | 1 7167082

< [ ;
-8.1 3.8 6.1

(Fid)
Line AXEARS

The assay values are now averaged over intervals of 0-10 m, 10-20 m, 20-30 m,
etc. This can be useful for many reasons, but in particular it is useful for labelling. In
Module 3, you will plot assay values down drillholes on a section map; if the values
are pulled from the original assay database (which has samples at every 1-2 m), the
section map can become very cluttered.

Databases can also be composited based on rock codes. For example, a geologist
might want to determine assay values within a specified geological unit. The tool
can also be used to merge adjacent intervals that have the same rock code. You
will now do the latter using the lithological interval method.

www.geosoft.com
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To create a composite database using lithological intervals:

1. From the Data menu on the Target Drillhole toolbar, select Composite

database.
The Drill Hole Composite Database dialog opens.
Figure 2.30 Drill Hole Composite Database dialog

' ™
Drill Hole Composite Database M

Input assay database: [Target_Assay.gdb ']

Cutput composite database tag:  composite

Holes to process: [Selected holes ']

Interval selection: [ Fixed interval hd ]

o

" J

From the Input assay database list, select Target_Assay.gdbDrillhole_
Geology.gdb.

For the Output composite database tag, enter litho_composite.
From the Interval selection list, select Lithological interval and click Next.
The Lithological interval dialog opens.

Figure 2.31 Lithological interval dialog

Lithological interval @
Lithology data channel: [ v]
Weighting channel: [ v]

[ Next> ] [ <Back ] [ Cancel ]

From the Lithology data channel list, select Rock [Geology] and click Next.

The Reject options dialog opens. For this lesson there is no need to specify any
rejection options.

Figure 2.32 Reject options dialog
Reject options @

Reject intervals shorter than:

Reject intervals gaps greater than:

Reject intervals where the value of: [ v]

is...: [ v]

value:

[ Finish ][ <Back ][ Cancel ]

6. Click Finish.

The Drillhole_litho_composite.gdb database is created.

The Target_litho_composite from-to assay database is created.
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Figure 2.33 Lithological interval composite database

Geosoft Databaze Window =]
rget_Assay.gdb | Target_Geology.gdb | Target_Structure.gdb | Target_composite.gdb Target_litho_composite.gdb| 40X
v SKAB28 DH From DH To | Rock Hask DH EastE DH Northm DH RL | »
8.0 8.8 S.q[:a 1 717127.4 6531228.2 auy |

1.8 30.49 36.6 1 717141.9 6531228.2 419

2.8 36.0 !IZ.qM 1 717144.9) 6531228.2 41y

3.8 42.49 46 . gHb 1 7171474 6531228.2 418

[ b
-8.8 1.8 2.8

(Fid)
Line SKa@28

Geosoft Database Window O x

zology.gdb | Drillhole_Structure.gdb | Drillhole_Assayl0.gdb | Drillhole_Fractures.gdb Drillhole_litho_composite.gdh| 40X

v SKAB28 DH_From DH To | Rock RockHask Hask DH_East [] DH_Horthl] |
6.9 0.9 8.0Ca 1 | 717127.4 6531228.2
1.9 30.9 36.0 1 1| 717141.9] 6531228.2
2.0 36.9 429 1 1| 717144_9] 6531228.2
3.0 429 146 . Atb 1 1| 717147 .4 6531228.2
4 [ r
6.8 8.5 1.9
(Fid)
Line SKAB28

The new database contains composited lithology and assay values that have been
averaged over the composited interval. This average is weighted according to the
length of the constituent intervals in the input database. The output database is also
useful for creating less cluttered labelling on section maps.

v Now would be a good time to save your map document.

Best-Fit Lithological Interval Composite Databases

The best-fit lithological interval combines aspects of the fixed interval and the
lithology interval composite databases. It requires an assay database and a
lithology database.

The composite database is created by breaking the assay data into user-defined
fixed intervals. Lithology is then matched to those intervals as best as possible. If a
lithological interval is shorter than the user-defined interval value, then it is output
"as-is". A lithological interval is subdivided if it is larger than the user-defined
interval.
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To create a best-fit composite database:

1.

o > 0N

From the Data menu in the Target Drillhole toolbar, select Composite
Database.

The Drill Hole Composite Database dialog opens.

For the Input assay database select Target_Assay.gdb.

For the Output composite database tag, enter best_fit_composite.
For the Interval selection, select Best-fit lithological interval.
Click Next.

The Best-fit Lithological interval dialog opens. The Rock [Geology] lithology
data channel is already selected as this channel was just used to create the
lithological interval composite database.

Figure 2.34 Best-fit Lithological interval dialog

Best-fit Lithological interval -7 |z
Lithology data channel: [Rock [Geology] ']
Interval length: 1.0
Weighting channel: [ v]

[ Next= ] [ <Back ] [ Cancel ]

For the Interval length, enter 10 and click Next.

The Reject options dialog opens. For this lesson there is no need to specify any
rejection options.

Click Finish.
The Target_best_fit_composite from-to assay database is created.

Figure 2.35 Best-fit composite database

Geosoft Database Window (4
3 | Drillhole_AssaylO.gdb | Drillhole Fractures.gdb | Drillhole_litho_composite.gdb  Drillhole_best fit composite.gdb | 4 [ X
DH_From DH_To | Rock Au As RockMask Hask
[ [ 2. 8 El El 1 1
1.9 2.4 11.6 E E 1 1
2.0 11.4 13.0Ca El El 1 1
3.6 13. 8 18. 0 = = 1 1
4.8 18. 8 25.3[Ca * * 1 1
5.0 25._3 32.7Ca *| *| 1 1
6 . 6 32.7| 48.8Ca 6.06 * 1 1
7.0 48.8 47 .8 8.681 * 1 1
8.0 47 .0 54_10 a.a82 *| 1 1
9.8 54 .8 61. 8 8.84 * 1 1
16. 8 61.8 62.8lac 2.0y * 1 1
1.0 62.0 67 5|MI] B._83 *| 1 1
12 .8 67 .5 73.6Hb 8.31 * 1 1
13. 6 73.9 80.8Uac 8. 84 il 1 1
14 .0 80.08 88.[1#"] a.29 *| 1 1
15. 6 88.9 96.8Uac 8. 83 *| 1 1
16. 04 96.0 168 qMD 8.083 | 1 1
|
< 2
Line AXRCB51

When the line header cell is selected, you can use the Page Up and Page
Down keys to scroll through the lines.
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Significant Intersections Composite Databases

You can use this tool to identify significant grade intersections in your assay
database. You are able to define significant intersection criteria (i.e. minimum
composite length and minimum composite grade). The tool uses the specified
cutoff grade to divide assay intervals into high- and low-grade intervals. Adjacent
high-grade intervals (those greater than or equal to the cutoff grade) will be
composited. If the resulting composited interval satisfies the defined significant
intersection criteria, it is added to the newly created database. You may also
specify dilution zone criteria to include short, low grade intervals in the compositing.
The resulting database will include the new from-to intervals, the length of the
interval, and the composited data for all your assay channels. The database will
also contain a channel with labels you can use when plotting maps.

To create a composite database using significant intersections:

1. From the Data menu in the Target Drillhole toolbar, select Composite
Database.

The Drill Hole Composite Database dialog opens.

From the Input assay database list, select Target_Assay.gdb.

For the Output composite database tag, enter significant_int_composite.
From the Interval selection list, select Significant intersections.

Click Next.

The Significant intersection options dialog opens.

o > 0D

Figure 2.36 Significantintersection options dialog

Significant intersection options IEI
Primary assay data channel: [ v]
Minimum composite grade: 1.0
Minimum composite length: 1.0

Cutoff grade:

Clip values higher than:

Grade for missing assays ! 0.0
Maximum internal dilution length: 1.0

Minimum internal dilution grade: 0.0

[ Finish ][ <Back H Cancel ]

For the Primary assay data channel, select Au [Assay].
For Minimum composite grade, enter 0.3.

Output only composite intervals whose composite (weighted mean value) grade
is equal to or greater than this value.

8. For Cutoff grade, enter 0.1.

The Cutoff grade must be less than the Minimum composite grade, which in this
caseis 0.3.
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Only individual from-to intervals where the primary assay data channel's grade
is greater than or equal to this value will be included in the composite interval.

9. For Clip values higher than, enter 100.

If the clip limit is defined, any values above the clip limit are set to the clip limit

value.
e Any missing intervals, or any intervals whose grade is recorded as a

nmin

dummy "*", are assigned the "Grade for missing assays".

10. Click Finish.
The Target_significant_int_composite.gdb database is created.

Figure 2.37 Significant intersections composite database

Geosoft Database Window O x
ures.gdb | Drillhole_litho_composite.gdb | Drillhole_best_fit_composite.gdb  Drillhole_significant_int_composite.gdb | 4 I X
Hole ID DH _From DH To Length Au Au Labels LES
0.gAXRCA35 67 .00 68.00 1.9 0.841.6m @ 084 Au
1. 8A%RCA3S 71.04 73.00 2.9 1.222.6m @ 1.22 Au
2. gAXRC O3S 806.00 82.00 2.4 1.2372.6m @ 1.23 Au
3. gAXRC A3 88.00 89.00 1.9 1.381.6m @ 1.38 Au
4. AXRC O3S [T 960 1.9 0.961.8m @ B.98 Au
5 BAXRCO35 99.04 100.00 1.9 2.551.6m @ 2.55 Au
6. BAXRC O3S 10200 103. 64 1.9 2.151.8m @ 2.15 Au
7 . BAXRCO35 136. 06 138.00 2.9 2.342.6m @ 2.34 Au
8. flAXRC O35 140. 08 141.04 1.9 5.951.8m @ 5.95 Au
9. gAXRCA3S 160. 00 161.00 1.9 1.271.6m @ 1.27 Au
10. BAXRC O3S 163. 00 164.00 1.4 1.5681.6m @ 1.50 Au
11. 6AXRC B35 166. 00 167.00 1.9 2.651.6m @ 2.65 Au
4 2
Line AXRCO35
o Now would be a good time to save your project.

In this lesson you:
Created a composite database using the fixed interval method
Created a composite database using the lithological interval method
Created a composite database using the best-fit lithological interval method

Created a composite database using the significant intersections method
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Lesson 2.5 Using Drillhole Data Management Tools

In this lesson you will:
Create, edit and delete a drillhole
Create and edit a rock code file
Set global drillhole preferences

Target for ArcGIS provides several drillhole management tools, including tools to
create, edit and delete drillholes, edit rock and structure codes and set project
preferences.

Adding a Proposed Hole to a Drillhole Project
With the New Drill Hole tool, you can manually add new drillholes to your project.
There are a number of different ways of manually defining a new drill hole:

based on the collar and end-of-hole locations

based on the collar location, dip and azimuth

based on setting a target location to be intersected from a given dip and azimuth

In this lesson, you will define the location for a new proposed hole.

To create a new drillhole:
1. From the Data menu on the Target Drillhole toolbar, select New drill hole.

The New Drill Hole dialog box opens.
Figure 2.38 New Drill Hole dialog
New Drill Hole -5 |3

Drill Hole name:

Description: Planned Hole
Collar Coordinates
X Y z Calculate
Location: 0 0 0 ]

[ Extract XYZ from grid:

Cip: 90

_ O
Azimuth: 0

End of Hole Coordinates
X Y z Calculate
Location: 0 0 0
Flanned depth: 1]
oK ] [ Cancel

For Drill Hole name, enter SKC350.
For Location, enter the following:

X: 716756.5

Y: 6531283.4

Z:441.2
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For Dip, enter -60.0.

For Azimuth, enter 90.0.

For Planned depth, enter 170.
Click OK.

Note how the fields that are checked to "calculate" update (in this case the End
of Hole coordinates) as you define your drillhole attributes. The new proposed
drillhole is added to your collar and survey databases.

N o o A&

Edit Drill Hole

With Target for ArcGIS you can edit drillhole collar information and save the
changes to your project database. By using this editing tool, any edits you make to
a drillhole will be propagated to all relevant databases in the drillhole project. Here,
you will edit the proposed drillhole and move it 5 m to the east.

To edit a drillhole:
1. From the Data menu on the Target Drillhole toolbar, select Edit drill hole.

The Edit Drill Hole dialog opens.
2. From the Drill Hole name list, select SKC350.

The Edit Drill Hole dialog displays the drillhole collar information for your
proposed hole SKC350.

Figure 2.39 DrillHole dialog

Edit Drill Hole =
Drrill Hole name: [SKCSSO v]
Description: Flanned Hole
Collar Coordinates

X Y z Calculate
Location: 716756.5 6531283.4 441.2 I:‘

[T Extract XYZ from grid:
Dip: -60
i O
Azimuth: 90
End of Hole Coordinates

X Y z Calculate
Location: 716841.5 6531283.4 294
Flanned depth: 170

[ oK J [ Cancel ]

In the Collar Coordinates section, change the Location X value to 716761.5.
Click OK.

The edited location for the proposed drillhole is now updated in both the Target
Collar and Target_Survey databases.

Lah If you are sharing data with colleagues, you should edit the original source
data rather than making edits in the Geosoft Databases. Once changes are
made to the source data tables, they can be re-imported into your project
using the Refresh Project tool from the Target Project menu.
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Delete Drill Hole

Target for ArcGIS enables you to delete a drillhole from your project collar
database. The tool will remove all data associated with the selected hole(s) from
each database in the project.

To delete a drillhole:
1. From the Data menu on the Target Drillhole toolbar, select Delete drill hole.

The Delete Hole(s) dialog opens.

Figure 2.40 Delete Hole(s) dialog

Delete Hole(s) [~ 5| (23]
Drill Hole or Mask:  Select from list -

2. From the Drill Hole or Mask list, select SKC350 and click OK.

A message window opens indicating the drillhole has been removed from the
project.

Next, you will examine the tool for editing rock codes.

Editing Rock Codes

Rock codes and their associated patterns are usually used with From-To data to
represent lithology and other logged rock properties on maps. You can use the
editing tool to edit an existing rock code file, or to create a new one.

To create a new rock code file:
1. From the Data menu on the Target Drillhole toolbar, select Edit rock codes.

The Drill Hole - Edit Rock Codes dialog opens listing the default agso.csv rock
code file or which ever rock code file that was used in your last drillhole project.

Figure 2.41 DrillHole - Edit Rock Codes dialog

Drill Hole - Edit Rock Codes [~ 5| [zl
Rock codes list file (*.csv): agso.csv E]

Forthe Rock codes list file (*.csv), click on the browse button.

Navigate to your "Logos and Legends" enterNew rock codes.csv as the
filename.

This will create a new rock code .csv file.
4. Click Edit.
The Edit Rock Codes dialog opens.
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Figure 2.42 Edit Rock Codes dialog

Edit Rock Codes (23]
Rock Codes 1:16

Code Diescription Pattern

| Populate from
channel

Previous
Mare...

QK ] [ Cancel ] [ Help ]

o LLLEALREAEEREAR
W

5. Click Populate from channel.

The Select data source dialog opens. This lets you select a channel from which
the rock code file will be automatically populated.

Figure 2.43 Select data source dialog

Select data source @
Channel/D atabase

7]

[ QK ][ Cancel ” Help ]

6. From the Channel/Database list, select Rock [Geology] and click OK.
This is the Rock Channel from the Geology database.

A message window opens indicating there are new items to import into the rock
code file.

7. Click Yes.

The Edit Rock Codes dialog is populated with the rock codes from the Rock
channel in the Target_Geology.gdb database.
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Now you will assign descriptions and patterns for the rock codes.

-
Edit Rock Codes

=5)

Rock Codes 1:16
Code

|| o

a3

I
(3]

o

o || o

o
(5]

=

o
£l

Description

Pattem

Populate from
channel

Previous

AT

More...

[

0K

] [ Cancel

] [ Help

]

s

J

To edit rock codes:

1.

3. From the Pattern Family menu, select a category of patterns.

Click in the Description box beside the Ca rock code and type Alluvium -
depositional.

Click in the Pattern box beside the Ca rock code.

The Pattern Attributes dialog opens. You can use this to select the Pattern
Family (Solid Fill, Objects, Hatches and Geology), Colour, Background Colour,
Pattern, Size, Density and Thickness.

Figure 2.44 Pattern Attributes dialog

Pattern Attributes

Pattern Family
Solid Fil

Pattern

l

I

EXS

Colour

Background

e

Tile Size (mm)
2

Tile Density
1

Line Thickness (% of
Tile Size)

=

Example

~a25mm
Solid Fil

[ 0K ] [Canoel ][Reﬁesh] [ Help ]

80 | Target for ArcGISTarget for ArcGIS I

www.geosoft.com


http://www.geosoft.com/

www.geosoft.com

Lesson 2.5 Using Drillhole Data Management Tools

4. Select a Pattern and click OK.

5. Once you have edited the Description and Pattern for a few rock codes, click
(0]

Because there are a number of rock codes in this file, you will now view an existing
rock code file. You will then specify this as your default rock code file.

~

To view an existing rock code file:
1. From the Data menu on the Target Drillhole toolbar, select Edit rock codes.

The Drill Hole - Edit Rock Codes dialog opens.
2. Forthe Rock codes list file (*.csv), click Browse.

From the Logos and Legends folder in the Geosoft Training Data folder, select
Lithology Rock Code.csv and click Open.

4. Click Edit.

The Lithology rock codes are displayed in the Edit Rock Codes dialog. Edits
can now be made to this file, although it is not necessary for this lesson.

Figure 2.45 Lithology Rock Code.csv displayed in the Edit Rock Codes dialog

Edit Rock Codes (23]
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channel
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Structure Code File

The Structure Code file is similar to a Rock Codes file, except that only solid
colours can be specified, not patterns. Structure data can be represented on maps
as one of several types of symbol; the structure code file dictates the colour of
those symbols.

Examine the Structure_Type channel in the Drillhole_Structure database. You will
now view the associated structure code file which provides a description and colour
for each of these structure types.
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To view the structure code file:

1. From the Data menu on the Target Drillhole toolbar, select Edit structure
codes.

The Drill Hole - Edit Structure Codes dialog opens.

Figure 2.46 DrillHole - Edit Structure Codes dialog

Drill Hole - Edit Structure Codes -5 |[E3a]
Structure codes list file (*.cav): E]

For the Structure codes list file (*.csv), click the Browse button.

From the Logos and Legends folder, select Structure Codes.csv and click
Open.

4. Click Edit.

The Edit Structure Codes dialog opens. It lists the code, description and colour
for each structure code.

Figure 2.47 Edit Structure Codes dialog

Edit Structure Codes @

Populate fram
channel

Structure Codes 1:16

Code Diescription Colour
b Boudin Axiz
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pzs Sharp Contact

Previous

Mare...

i

- LLLLLELL

QK ] [ Cancel ] [ Help ]

Note the structure type described as a Fracture/Joint Set and its code, prt.
5. Click OK.

Drillhole Preferences

Drillhole preferences are global settings that allow you to customise various
aspects how data is processed and visualised within Target for ArcGIS. Once set,
they apply to all Target for ArcGIS projects that you create.
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To set drillhole preferences:

1. From the Target Project menu on the Target Drillhole toolbar, select

Preferences.
The Drill Hole Preferences dialog opens.

Figure 2.48 DrillHole Preferences dialog

Drill Hole Preferences @
Rock codes list file (*.csv): agso.csv E]
Structure codes list file (*.cav): E]
Resurveying method: Radius of curvature -
Order for polynomial fit: [5 V]
Hole discretization interval: 0.1

Hole survey dip angle sign (downward): [negative

Right/left for posted data: [hule reference ']
N-5 sections face...: [west V]
Auto-convert negatives on import?: [yes v]

Use mask channel for plotting/export?: [nu

Default mask channel: Mask
Azimuth magnetic declination correction: 0

Angled section axis origin: Center

Drill Hole Preferences
Rock codes list file (*.csv): agso.csv
Structure codes list file (*.cav): structcodes.cev
Resurveying method: Radius of curvature
Order for polynomial fit: [5
Hole discretization interval: 0.1
Hole survey dip angle sign (downward): [negative
Right/left for posted data: [hule reference
N-5 sections face...: [west
Auto-convert negatives on import?: [yes

Use mask channel for plotting/export?: [nu

Default mask channel: Mask
Azimuth magnetic declination correction: 0

Angled section axis origin: Center

L5 ]
[e)
[e)

7)
2
7)
7
7)
7

For Rock codes list file (*.csv), click Browse.

From the Logos and Legends folder, select Lithology Rock Code.csv and

click Open.

By selecting your default rock code file here, you will not need to browse for it
while creating section maps, strip logs or 3D views.

For Structure codes list file (*.csv), click Browse.

From the Logos and Legends folder, select Structure Codes.csv and click

Open.
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By selecting your default rock and structure code files here, you will not need to
browse for them while creating section maps, strip logs or 3D views.

6. Click OK.

=,
-3

o Now would be a good time to save your map document.

In this lesson you:
* Created, edited and deleted a drillhole
* Created and edited a rock code file

* Set global drillhole preferences
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Module 3 has Seven Lessons:

Lesson 3.1 Selecting Drillholes ... .. . . ... 86
Lesson 3.2 CreatingaPlanMap ... ... ... ... 89
Lesson 3.3 CreatingaSectionMap ... ... ... 106
Lesson 3.4 Creating a Stacked SectionMap ... ... ...................... 123
Lesson 3.5 Creating a Fence Diagram ... ... ... .. ... ... ... 129
Lesson 3.6 CreatingaStripLog ................ ... 134
Lesson 3.7 Creatinga3D Map ... ... ... ... ... 147
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Lesson 3.1 Selecting Drillholes

In this lesson you will:
Select drillholes

Change the page size and orientation

Selecting Drillholes

A key requirement for geologists and geochemists evaluating and presenting
drillhole data is the ability to select or deselect various combinations of drillholes.
The following selection methods are available:

Selecting (or Deselecting) All Holes: Allows you to quickly select or deselect
all holes and enables quick development of plan maps or resetting of drillholes
prior to making new selections.

Selecting Holes by Name or Name Mask: Enables batch selection of
multiple holes with systematic drillhole identifiers. This requires a standard
drillhole naming scheme for identifying related holes.

Selecting Holes from List: Enables single or multiple selection from a list.

Selecting Holes via a Selection Tool: Enables custom selection of single or
multiple holes from a list of all the holes in the database. You can select
interactively by drawing a polygon around or clicking holes individually.

You can also select or mask data by code or range:

Masking Data by Code: Enables the creation or update of a mask channel
based on values matched from any other channel.

Masking Data by Range: Enables the setting of a mask channel dependent on
whether values in a specified channel are within a specified range.

In addition, you can also save and load your selections:

Save and/or Load Selections: Enables you to save the current hole
selections, orload previous hole selections from a selection file (*.sel).

Selecting Holes using the Hole Selection Tool

The Hole Selection Tool enables you to interactively select single or multiple holes
from a plan view of the drillhole project. You can view all holes, selected holes and
holes including full traces or labels.

You will now use the Hole Selection Tool to select the holes to be plotted on your
plan map.

To select holes using the Hole Selection Tool:
1. From the Selection menu on the Target Drillhole toolbar, select Selection tool.

The Hole Selection Tool dialog opens. By default, all the holes are selected.

86 | Target for ArcGISTarget for ArcGIS I www.geosoft.com


http://www.geosoft.com/

Lesson 3.1 Selecting Drillholes

Figure 3.1 Hole Selection Tool dialog
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To clear the selected holes, click Select None.
Ensure the Selection Mode is set to Select.
Click the Select/Deselect using rectangle tool button o,

Click and move your mouse to define the size and location of the rectangle

selection tool, as shown in the figure below.

The drillholes within the rectangle you defined are now selected.

Figure 3.2 Selected drilholes
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6. Click OK.

To change the page size and orientation:
1. From the ArcMap File menu, select Page and Print Setup.

The Page and Print Setup dialog opens.
From the Paper Size list, select either 11x17 or A3.
For Orientation, select Landscape.

For Map Page Size, select the Use Printer Paper Settings option.

o > 0N

Select the Scale Map Elements proportionally to changes in Page Size
option and click OK.

6. Save the map document (.mxd) file.
In this lesson you:

Selected drillholes

Changed the page size and orientation
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Lesson 3.2 Creating a Plan Map

In this lesson you will:
Create a Geosoft Map Layer plan map
Change the collar symbol and hole trace parameters
Plot a grid
Add a legend and titles
Create a plan map in shapefile format

Symbolise the shapefiles and add map elements

Plan Maps

Plan maps provide a surface view of drillhole collars, drillhole traces, graticules,
and surface grids. You can also include a title block, list of the holes, map
information, north arrow and scale bar. Plan maps allow you to quickly display
drillhole collars and traces, to help establish subsurface drilling coverage. Plan
maps can also be used to define the location and orientation of section maps.

The Target for ArcGIS plotting tools provide two types of output; shapefiles and
Geosoft Map Layers. The Shapefile output creates points, lines, and polygons to
represent data in your maps which you can then modify using the tools available
within ArcMap and create ESRI-style map layouts.

Geosoft Map Layers are static images that are ready for printing; they contain
Geosoft's pre-defined annotations and legends, and allow you to pre-define colours,
patterns and line styles. The Geosoft Map Layers is not a typical GIS layer. The
ArcMap ‘Identify’ cursor, symbology and labelling tools are not available for Geosoft
Map Layers. You cannot modify a Geosoft Map Layer; if changes are required, you
must create a new one.

Since ArcMap is designed to function as a single-map environment, you will save
the Target for ArcGIS Drilling.mxd file as a new .mxd file in which you will create
the plan map.

To create a new .MXD:
1. From the File menu, select New.

2. Select Blank Map and click OK.
A new, untitled map is created.
From the File menu, click Save.
For the File name, type Plan Map.mxd and click Save.

The new map document opens with the existing drillhole project open. The
drillhole selection for your project is also maintained, as well as the page setup
parameters for the MXD itself.

v You can also click the New Map File button on the Standard toolbar.
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Geosoft Map Layer Output

You will now create a plan map in Geosoft Map Layer format. You will begin by
creating a plan map of the selected drillholes using the default parameters. Then,
you will adjust various parameters to change the display of the map.

To create a plan map:
1. Onthe Target Drillhole toolbar, click the Generate Target Plan Plot button .

The Target Plan Generation initial parameters dialog opens.

Figure 3.3 Target Plan Generation initial parameters dialog

Target Plan G tion initial ¢

@ |ze default/previous parameters
() Use active Data frame's current extents
() Define extents using rectangle toal

[ QK J [ Cancel ] [ Help ]

2. Select Use default/previous parameters and click OK.

The Plan Map Parameters dialog opens. Both Geosoft Map Layer and Shape
File outputs are selected by default. In this lesson you will start by only creating

a Geosoft Map Layer.
Figure 3.4 Plan Map Parameters dialog
Plan Map Parameters @
Data Reference Grids | Plan Grid Load/Save | Slices
Output Page Layout I Plan Location Collars I Hole Traces

Frame/Layer Name Tag

[¥] Geosoft Map Layers
Shape File Output

Filename Tag

Auto-Load into cument document

() Load to curent data frame
(@ Load to separate data frame(s)

[ ok [ cancel |[ Heb

For Frame/Layer Name Tag, enter Map 1.
Clear the Shape File Output option.

Click OK.

The PlanC_Map 1 data frame is added to the Table Of Contents; it contains the
Holes and RefGrids layers which are parts of the Geosoft Map Layer output.
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Figure 3.5 Default Plan Map
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The Layers data frame is not needed and can be removed.

To remove the default data frame:

In the ArcMap Table Of Contents, right-click the Layers data frame and select
Remove.

There are several parameters available to help you customise the display of your
plan map. The following table describes each tab in the Plan Map Parameters

dialog:
Table 3.1 Plan Map Parameters dialog tabs

Description

Use this tab to specify the output of the plan map as
either Geosoft Map Layer or shapefile format.

Use this tab to specify the page layout of the plan plot(s),
including the map components, legend, and titles.

Use this tab to specify the location of the plan map. By
default, this is defined by the extent of the selected
holes.

Use this tab to select specific symbols for plotting hole
collars. These options only affect Geosoft Map Layer
output.

Use this tab to define the hole traces on the plan map.
The hole traces can be modified in the shapefile output;
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Tab

Data

Reference Grids

Plan Grid

Load/Save

Slices

Description

line width and colour options only apply to Geosoft Map

Layer output.

Use this tab to specify the data and plot type for your

map.

Use this tab to specify the parameters for displaying
reference grids of local eastings and northings on the
plan map. These options only affect Geosoft Map Layer

output.

Use this tab to plot a plan grid on the map.

Use this tab to load and/or save map and data plotting

parameters to a file for sharing or for reuse.

Use this tab to plot a slice from a voxel, 3D DXF or 3D
Shapefile on the plan map.

The collar locations are plotted using a circle symbol by default. You will now
reopen the Plan Map Parameters dialog and change the way the collars are
displayed on the Geosoft Map Layer.

To change the collar symbols:
On the Target Drillhole toolbar, click Generate Target Plan Plot.

1.

6. For Size (mm), enter 2.

Select Use default/previous parameters and click OK.

Click the Output tab.

The Plan Map Parameters dialog opens.

For Frame/Layer Name Tag, enter Map 2.

Click the Collars tab.

Figure 3.6 Plan Map Parameters Collars tab

The Target Plan Generation initial parameters dialog opens.

Plan Map Parameters @
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7. Select the Zone Coloured Symbols option.
8. From the Zone Channel list, select DH_Bottom.

DH_Bottom is a channel created in your Collar Database that is based on the
total depth values there were imported into the drillhole project. Each collar will
be coloured based on these values.

9. Click Define.

The Define Colour Zones dialog opens. Here you can specify the number of
zones, the maximum value of each zone, the colour to represent each zone and
the distribution of the data.

Figure 3.7 Define Colour Zones dialog
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10. For Zone 1, click the black colour box and change the colour to grey.
11. Click OK.

A Zone File called DH_DH_Bottom.itr will be created and saved in your project
folder. This file saves the zones and colours you define. You can use this file
again later on if you want to use the same parameters in another map.

12. Click OK.

A new data frame, PlanC_Map 2, is added to the Table Of Contents. The collars
are now plotted using coloured symbols based on the drillhole depth.
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Figure 3.8 Plan Map with Zone Coloured Collars (zoomed)
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The PlanC_Map 1 data frame is no longer needed and can be removed.

To remove the data frame:

In the ArcMap Table Of Contents, right-click the PlanC_Map 1 data frame and

select Remove.

Now you will adjust the parameters for the Hole Traces.

To change the hole trace parameters:

1. Openthe Plan Map Parameters dialog
2. Click the Output tab.
3. For Frame/Layer Name Tag, enter Map 3.
4. Click the Hole Traces tab.
Figure 3.9 Plan Map Parameters Hole Traces tab
Plan Map Parameters @
Data Reference Grids | Plan Grid Load/Save I Slices
Output Page Layout I Plan Location Collars | Hole Traces
Trace Style [ Plot Depth Ticks
@ Collars Left side (@ Right side
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Width {mm) 0.1 Plot depth labels
Font
Hole Labels -
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[T Depth at bottom or exit [ Depths at crossings
[ Entry locations =/~
[ ok [ cancel |[ Heb |

5. Forthe Trace Style, select Hole Traces.

6. Inthe Hole Labels section, click Advanced.
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The Hole Labels Advanced Options dialog opens.

Figure 3.10 Hole Labels Advanced Options dialog
Hole Labels Advanced Options
Label Text
Fant: -
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)
Fosition: .
| K.eep perpendicular to hole trace
| Plat label lines
| Overplot protection
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7. ForLabel Text Size (mm), enter 2.0.

8. Clearthe Plot label lines option.

9. Click OK.

10. Clear the Plot Depth Ticks option.

11. Click OK.

A new data frame, PlanT_Map 3, is added to the Table Of Contents and
displays the hole traces for each drillhole.

Figure 3.11 Plan Map with Hole Traces
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The PlanC_Map 2 data frame is no longer needed and can be removed.

To remove the data frame:

In the ArcMap Table Of Contents, right-click the PlanC_Map 2 data frame and

select Remove.
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Next you will change the display of the Reference Grid and display a topography
grid on the plan map.

To change the display of the Reference Grid and display topography:
Open the Plan Map Parametersdialog .

1.

2
3.
4

Click the Output tab.

For Frame/Layer Name Tag, enter Map 4.

Click the Reference Grids tab.

Figure 3.12 Plan Map Parameters Reference Grids tab

Plan Map Parameters @
Qutput Page Layout | Flan Location Collars I Hole Traces
Data Reference Giids | Plan Grid Load/Save | Slices
Plot grid? ;
Fort Attributes {mm)
Label size 2
Grid Option Line thickness 01
@ Solid line Cross size 2
() Dashed line )
©) Crosses Border tick length 2
(2 Border ticks Colour -
Grid Intervals Secondary Grid
@ Automatic () Foeed )
Esst 50 || Plot secondary grid
North 50 Options...
Elevation 50
[ ok | camcel |[ Hep
For the Grid Option, select Border ticks.
Click the Plan Grid tab.
Figure 3.13 Plan Map Parameters Plan Grid tab
Plan Map Parameters @
Qutput Page Layout I Flan Location Collars I Hole Traces
Data Reference Grids | Plan Grid | Load/Save I Slices
[] Plot grid or image in plan view
Grid orimage file
File name
Colour zones
File name
colourtbl
[ ok |[ camcel |[ Hep |

Select the Plot grid or image in plan view option.

For the Grid or image file name, click Browse.

From the Topography folder, select Topo.grd and click Open.
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11. Within the Geosoft Colour Table Directory, navigate to the monochromatic

folder and selectgrey.tbl and click Open.

12. Click OK.

A new data frame, PlanT_Map 4, is added to the Table Of Contents; the
reference grid is now displayed with border ticks instead of solid lines and the

topography grid is displayed.
Figure 3.14 Plan map with topography grid
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The PlanT_Map 3 data frame is no longer needed and can be removed.

To remove the data frame:
* Inthe ArcMap Table Of Contents, right-click the PlanT_Map 3 data frame and

select Remove.

Finally, you will specify the map scale and add a legend and titles to your map.

To specify the scale and add a legend and titles:

1.

2.
3.
4

Open the Plan Map Parameters dialog.
Click the Output tab.

For Frame/Layer Name Tag, enter Map 5.
Click the Plan Location tab.

www.geosoft.com

Target for ArcGISTarget for ArcGIS Il | 97



http://www.geosoft.com/

Module 3: Mapping Drillhole Data

Figure 3.15 Plan Map Parameters Plan Location tab

Plan Map Parameters @
Data Reference Grids | Plan Grid Load/Save I Slices
Output Page Layout | Plan Location Collars | Hole Traces
Location Horizontal Slice(s)

Easting Ref T18677 Plot Full Plan
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Justify
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[Middle-center - Thickness 38.6
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Map Scale 1404
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5. For Map Scale, enter 1500.
6. Click the Page Layout tab.
Figure 3.16 Plan Map Parameters Page Layout tab
Plan Map Parameters @
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7. Select the Plot Legend and Compass diagram options.

8. Select Plot Titles and enter the following information:

Company: Geosoft

Property: Mt Palmer
Title: Drillhole Plan Map
Subtitle: Target for ArcGIS Training

9. Click OK.

Two new data frames are added to the Table Of Contents; PlanT_Map 5 and
PlanT_Legend_Map 5. The legend data frame contains several Geosoft Map
Layers for which you can turn the display off and on.

The PlanT_Map 4 data frame is no longer needed and can be removed.

10. In the ArcMap Table Of Contents, right-click the PlanT_Map 4 data frame and

select Remove.
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Figure 3.17 Plan Map with legend and titles
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o Now would be a good time to save your map document.

You will now create a plan map in shapefile format.

To create a plan map in shapefile format:
1. Open the Plan Map Parameters dialog.

All the parameters you used to create the Geosoft Map Layer are remembered.

Click the Output tab.

For Frame/Layer Name Tag, enter Shapefiles.

Click the Page Layout tab and clear the Plot Legend option.
Click the Reference Grids tab and clear the Plot grid option.
Click OK.

N o g s~ w D

Three shapefiles are created in the new PlanT_Shapefiles data frame: PlanT _

Collar and PlanT_Bottom are point layers representing the locations of the

drillhole collars and the bottom of the traces, respectively; the PlanT_Traceis a

line layer representing the hole traces.

8. Turn off the display of the PlanT_Map 5 and PlanT_Legend Map 5 data frames.

Clear the Geosoft Map Layer option and select the Shape File Output option.
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Figure 3.18 Plan Map shapefile output
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Currently, the PlanT_Collar layer is displayed with the default symbology. You will
now edit the symbology to display this layer similarly to the Geosoft Map Layer.

To change the symbology of the collar shapefile:

1.

Double-click the PlanT_Collar layer in the Table Of Contents.
The Layer Properties dialog opens.

Click the Symbology tab.

In the Show area on the left, click Quantities.

The Graduated colors option is automatically selected.

From the Value list, select Depth.

The Symbol, Range and Label columns update to show the data classified
based on the natural statistical groupings of data values.

From the Classes list, select 8.

Click the Symbol column header and select Properties for All Symbols.
The Symbol Selector dialog opens.

Select Circle 1 and for Size enter 12.

Click OK.

Referring to the table below, change the Symbol colours and enter the following
Range values.

Symbol Colour Range Maximum

grey 57

100 | Target for ArcGISTarget for ArcGIS Il

www.geosoft.com



http://www.geosoft.com/

Lesson 3.2 Creating a Plan Map

Symbol Colour Range Maximum
dark blue 64
light blue 75
green 97
yellow 125.8
orange 147
red 175
magenta 230
10. Click OK.
These symbol colours and range values now correspond to those in the Geosoft
Map Layer.

Next you will change the symbology of the hole traces and trace bottoms.

To change the symbology of the hole traces and trace bottoms:
1. Double-click the PlanT_Trace layer.

The Layer Properties dialog opens.

2. Onthe Symbology tab, click the Symbol button showing you the current
default symbol.

The Symbol Selector dialog opens.
Change the line colour to Black and click OK.
Click OK.
The hole traces are now displayed as black lines.
5. Change the symbology for the PlanT_Bottom layer to a black cross.
v It is a good idea to change the symbology of the shapefiles once you are
happy with the output from Target for ArcGIS; otherwise, if you recreate

them your shapefiles may be overwritten and will be displayed with the
default symbology.

Before inserting map elements on your map, ensure you are in Layout View mode
and that PlanT_Shapefiles is the active data frame.

To switch between Data View and Layout View:
From the View menu, select Layout View.

The entire map is displayed and the Layout toolbar is activated.

Y You can also switch between views by clicking the Data View button *
and the Layout View button 2! on the lower left of the display window.

You will now add a legend and scale bar for your geochemical data.
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To activate a data frame:

In the ArcMap Table Of Contents, right-click the Plan Map Shapefiles data
frame and select Activate.

v You can also activate a data frame by pressing the ALT key and clicking
the name of the data frame.

W Torefresh the active view, click the Refresh View button = in the lower
left of the display window or press F5 on your keyboard.

You will now insert a title, legend, north arrow and scale bar to your map using the
ArcMap tools.

To insert a title:
1. From the Insert menu, select Title.

The Insert Title dialog opens.

Figure 3.19 Insert Title dialog
Insert Title @

What tite would you like to give your map?

[ OK J[ Cancel ]

2. Type Mt Palmer Plan Map and click OK.

You can resize and reposition the title as necessary. You can also use the
Symbol Selector to change the text properties.

v Forany of the map elements you insert, you can double-click them on
the map and a Properties dialog opens where you can make changes to
their display.

To add a legend:
1. From the Insert menu, select Legend.

The Legend Wizard opens. You can use this wizard to control which layers are
included in your legend as well as the size, spacing and text properties.
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Figure 3.20 Legend Wizard

Legend Wizard @

Choose which layers you want to include in your legend

Map Layers: Legend ttems
o PlanT_Trace |
- PlanT_Collar Elaq_ggﬂtar L3
PlanT_Bottom e an | _botiom
Topo.grd . Topo.grd -
*

Set the number of columns in your legend: 1 =

cBack  |[ Ned> | [ Cancel

2. Click Nextin each window to use the defaults.

You can also use the Preview button to help adjust the display properties.
3. Click Finish.

The legend is added to your map.

4. Using the Select Elements tool ® | you can select the legend on your map and
resize and reposition as necessary.

You will now insert a north arrow.

To insert a north arrow:
1. From the Insert menu, select North Arrow.
The North Arrow Selector dialog opens.

Figure 3.21 North Arrow Selector dialog

MNorth Arrow Selector @
Preview
Il N
3 W$E
ESRI North 1 ESRI North 2 ESRI North 3 3
N N
W¢> E y E
s '- N
ESRI North 4 ESRI North 5 ESRI North &
at Scale to fit page
5 : il [ Properties... ]
ESRI North 7 ESRI North 8 ESRI North § [ Mo S ]
ore Styles -
N
P .F [ Save... ] [ Reset ]
W E
. g% </ [ ok | [ cancel |
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2. Select a north arrow from the list and click OK.

The selected north arrow is added to your map. You can resize and reposition it

as necessary.

Next, you will insert a scale bar.

To insert a scale bar:

1. From the Insert menu, select Scale Bar.

The Scale Bar Selector dialog opens.

Figure 3.22 Scale Bar Selector dialog

Scale Bar Selector @
Preview
0 10 200 Miles ol
ST T Y T |
Scale Line 1 o
0 5 100 200 Miles
————————
Scale Line 2
L L | 1
0 5 100 200 Miles
Scale Line 3
M1
Stepped Scale Line |
s @ m  wm [¥] Scale to fit page
Altemating Scale Bar 1 [ Properties... ]
e [ More Styles ']
Altemating Scale Bar 2 [ [ ] [ Reset ]
100 _ <[ ok ][ camcel |

2. Select a scale bar style from the list and click OK.

The selected scale bar is added to your map and shows the scale based on the
extent of your data frame. You can reposition the size and location of the scale
bar as necessary; the scale bar intervals will update automatically when you re-

sizeit.

As you insert map elements on your map, they may overlap the data displayed in
your PlanT_Shapefiles data frame. You will now resize the data frame to improve
the map layout.

To resize the Plan Map Shapefile data frame:

1.
2.

Click on the map to select the PlanT_Shapefiles data frame.

Click and drag the right selection handle towards the left side of your map.

As you resize your data frame, your scale bar is automatically updated.

Your map should look similar to the one below.
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Figure 3.23 Plan Map created from shapefile output

Legend
PlanT_Cellar
Depth

*  4400-57.00
i @ 57.01-6400
64.01-75.00
75.01-87.00
a7.01-12580
e 125.81-147.00
e 147.01-175.00
e 1T501-230.00
PlanT Trace
+  PlanT_Botton

Topo.grd

Value N
—+ High : 486.843
- Low : 378.384 A

Mt Palmer Plan Map

o i 120 FILERYY
L L L L '

@ Now would be a good time to save your map document.

In this lesson you:

* Created a Geosoft Map Layer plan map

* Changed the collar symbol and hole trace parameters
* Plotted a grid

* Added alegend and titles

* Created a plan map in shapefile format

* Symbolised the shapefiles and added map elements
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Lesson 3.3 Creating a Section Map

In this lesson you will:
Select drillholes for the section map
Create a Geosoft Map Layer section map
Change the display of the collar symbols and hole traces
Plot topography
Plot rock patterns, a bar plot, a grid and post values
Add alegend and plan view

Create a section map in shapefile format

Section Maps

Section maps allow you to visualise any of your drillhole data on a cross-section.
Section maps can be generated in any orientation, in terms of strike and dip.

Since ArcMap is designed to function as a single-map environment, you will begin
by creating a new map file in which you will create the section map.

To create a new .MXD:

1. Onthe Standard toolbar, click the New Map File button D,
The New Document dialog opens.

2. Click OK.

A new, untitled map with the Target Project loaded, the drillholes selected and
the correct page setup is created.

3. Save the map as Section Map.mxd.

Geosoft Map Layer Output

You will now create a section map in Geosoft Map Layer format.

To create a section map:
1. Onthe Target Drillhole toolbar, click the Generate Target Section Plot button

Fect

The Target Section/Stacked Section Generation initial parameters dialog
opens.

Figure 3.24 Target Section/Stacked Section Generation initial parameters dialog

Target Section/Stacked Section Generation initial pararmeters

@ |ze default/previous parameters
() Define EAW section on active data frame 1
() Define N-S section on active data Frame

() Define Angled section on active data frame

[ ok J [ Cancel ] [ Help ]

2. Select Use default/previous parameters and click OK.

106 | Target for ArcGISTarget for ArcGIS Il www.geosoft.com


http://www.geosoft.com/

www.geosoft.com

Lesson 3.3 Creating a Section Map

The Section Parameters dialog opens. Both Geosoft Map Layer and Shape File
outputs are selected by default. In this lesson you will start by only creating a

Geosoft Map Layer.
Figure 3.25 Section Parameters dialog
Section Parameters @
Profiles Reference Grid I Topography I Flan View I Load/Save | Slices
Output | Page Layout I Section Location I Collars I Hole Traces | Data
Frame/Layer Name Tag
[¥] Geosoft Map Layers
Shape File Output
Filename Tag
Auto-Load into cument document
() Load to curent data frame
(@ Load to separate data frame(s)
[ ok |[ camcel |[ Heb
For Frame/Layer Name Tag, enter Map 1.
Clear the Shape File Output option.
Click the Section Location tab.
Figure 3.26 Section Parameter Section Location tab
Section Parameters @
Profiles | Reference Grid | Topoara Plan View I Load/Save | Slices
Output | Page Layout | Section Location | Collars I Hole Traces | Data
Location and Orientation
Easting Ref 716700 Ref Blev 434
Morthing Ref 6531280 Justfy
Length 4439
Vert Extent 2796
Thickness 3304
Azimuth Vert Exag !
Swing i) Map scale 1078
Section Azimuth Multiple Sections
@ EW [ Dot ][ Define ] Number of sections 1
. Perpendicular Spacing
©ONS [ Defaut || Define |
O Anged | Defaut || Define | Spacing 3304
[ ok |[ cameel |[ Hep |

Beside E-W in the Section Azimuth section, click Define.

The Define Section View dialog opens.

Click the Zoom into selected area button and zoom to the currently selected

holes.

Beside E-W in the Section Azimuth section, click Define.

Click and move your mouse to define the size and location of the section.

Define your section as narrow as possible making sure to include the hole
traces, as shown in the figure below.
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Figure 3.27 Defining the section location

Define Section View (=23
Dizplay
@ All holes 1 oS0
() Selected holes .
Full Traces = 531450
[] Hole Labels 0 I
. o BT S e e
Location and Orientation . o ole a -
E asting Ref T16E7R —
6531350 - = ~ "
Morthing Ref ER31180 - -
Length 260 £53130) 44—ttt
Thickness 20 T
) 8531250 # Tt
Azimuth 50
L - - - - . e - o1
Section Azimuth 8531200 - hE—ct ¢
@ Ew [+ — t ot aa o |
DNS i 6531150 R i S R
: . Tt
() &ngled | Defaul Define
6531100
Multiple Sections o = =2 = = = o o =
MNumber of sections 85310502 & 2 5 = a2 & &
Perpendicular Spacing 1 z = = - = = i 1
716568 B531520
Spacing 30
ok ] [ Cancel ] [ Help
10. Click OK.

11. For the Northing Ref, enter 6351180.
12. For Map Scale, enter 1500.
13. Click OK.

The Section_6531180N_Map 1 data frame is added to the Table Of Contents; it
contains the Holes and RefGrids layers which are parts of the Geosoft Map
Layer output.
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Figure 3.28 Section Map
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@) Section Map.mxd - ArcMap - ArcView [elr= =]
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
Oeda B & - HERRaMQR @ [ EER
Geosoft Data~ | [[ | [ [ 28 = Help~ _ ° Geosoft Setup - Seek Data ™ Help~ -
Target Surface A Help~ _ © TargetProject= Data~ Selection= Voxels~ @ & ®2d 2t ® i iy M Help~
Table Of Contents R % 5 10 115 120 125 120 135 140 - @
Eless =l g
= Layers 5
[ £ Section 6531180N_Map1 B
£ B Geosoft Map Layers —<le
@

The Layers data frame is not needed and can be removed.

To remove the default data frame:

In the ArcMap Table Of Contents, right-click the Layers data frame and select

Remove.

Tab

Output

Page Layout

Section Location

Collars

Topography

Plan View

There are several parameters available to help you customise the display of your
section map. The following table describes each tab in the Section Parameters
dialog.

Table 3.2 Section Parameters dialog tabs

Description

Use this tab to specify the output of the plan map as
either Geosoft Map Layers or shapefile format.

Use this tab to specify the page layout of the section plot
(s), including the map components, legend, and fitles.

Use this tab to specify the location of the section plof(s).
A section plotis a slice of the ground, which is normally
vertical but may also swing away from the vertical.

Use this tab to select specific symbols for plotting hole
collars.

Use this tab to plot topography on the section plot(s).

Use this tab to plot a plan view on the section plot(s).
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Tab Description

Load/Save Use this tab to load and/or save map and data plotting
parameters to a file.

Slices Use this tab to plot a slice from a voxel, 3D DXF or 3D
Shapefile on the section map.

Hole Traces Use this tab to define the hole traces of the section plot
(s)-

Data Use this tab to specify the data and plot type for your
map.

Profiles Use this tab to plot profiles of gridded data on the

section plot(s).

Reference Grid Use this tab to specify the parameters for a reference
grid displayed on the section plot(s).

By default, the collar locations and depth ticks are plotted. Next, you will reopen the
Section Parameters dialog and plot the collar symbols with different colours based
on who logged the data.

To change the display of the collar symbols:

1. Open the Section Parameters dialog and click the Output tab.
2. ForFrame/Layer Name Tag, enter Map 2.

3. Click the Collars tab.

Figure 3.29 Section Parameters Collars tab

Section Parameters @

Profiles I Reference Grid I Topography I Flan View | Load/Save | Slices
Qutput I Page Layout I Section Location | Collars | Hole Traces | Data

Plot Collar Symbols
Size [mm)
@ Fixed Symbol O 07
Zone Channel Use the fixed symbal
Zone edge colour
() Coloured )
Symbols Zone File
Browse... Define...
Plot codes in legend
Clazs Channel
_ String (@) Plot labels in legend
(O Classfied 5 bl Class File
Symbols Browse... Define...

[ ok [ cancel |[ Heb

For Size (mm), enter 2.0.

Select the String Classified Symbols option.

From the Class Channel list, select GEO and click Define.

The Select collar symbol classification file name dialog opens.
7. Forthe File name, enter SymbolCodes.

This will automatically create a new .csv file with this name.
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8. Click Save.
The Edit Symbol Codes dialog opens.
Figure 3.30 Edit Symbol Codes dialog

Edit Symbol Codes (=23

Symbol Codes 1:16
Populate from
channel

Code Description

Previouz

LLLAERCERYRRAY

More...

o

k. ] [ Cancel ]

Help ]

9. Click Populate from channel.
The Select data source dialog opens.
10. From the Channel/Database list, select GEO and click OK.

A message window opens indicating there are new items to import into the
symbol code file.

11. Click Yes.

12. For each Code, click in the Description box to enter the following text and click
in the Symbol box to select the following fill colours:

Code Description Symbol
NG Natalie Green green
SD Sara Deschamps orange
™ Tara Macey blue
13. Click OK.
14. Click OK.

A new data frame, Section_6531180N_Map 2, is added to the Table Of
Contents. The collars are now plotted using coloured symbols based on who
logged the data.
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Figure 3.31 Section Map with String Classified Collar Symbols (zoomed)
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The Section_6531180N_Map 1 data frame is no longer needed and can be
removed.

To remove the data frame:

In the ArcMap Table Of Contents, right-click the Section_6531180N_Map 1
data frame and select Remove.

Next, you will plot topography on the section map.

To plot topography on the section map:

1. Open the Section Parameters dialog and click the Output tab.
2. ForFrame/Layer Name Tag, enter Map 3.

3. Click the Topography tab.

Figure 3.32 Section Parameters Topography tab

Section Parameters @

Qutput I Page Layout I Section Location I Collars I Hole Traces Data
Profiles | Reference Grid | Topography | Plan View | Load/Save | Slices
[ Plot topography on section

Grid or model file Line Style

Legend Optons

[ ok [ cancel |[ Heb |

4. Select the Plot topography on section option and click Browse.
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The Select File Type dialog opens.
Figure 3.33 SelectFile Type dialog

Select File Type

(@) Gridded topography (GRD, DEM)
() Datamine Wireframe (DM)

() Surpac Vision DTM

(7) Gemcom Wireframe (BT2)

[ Ok J [ Cancel ] [ Help ]

Select Gridded topography (GRD, DEM) and click OK.

From the Topography folder, select Topo.grd and click Open.
Click in the Line Style box.

The Line Attributes dialog opens.

Figure 3.34 Line Attributes dialog

Line Attributes (=23

Pattern Family Colour

Standard Patterns =~ = _

Thickness (mm) Pitch (mm})
0.5 5

Pattern

Example  solid line

[ OK ] [Canoel ] [Reﬁesh] [ Help ]

Click the Colour box, select brown and click OK.

Click OK.

A new data frame, Section_6531180N_Map 3, is added to the Table Of
Contents; the topography profile is displayed and listed as a Geosoft Map

Layer.
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Figure 3.35 Section Map with Topography
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The Section_6531180N_Map 2 data frame is no longer needed and can be
removed.

To remove the data frame:

In the ArcMap Table Of Contents, right-click the Section_6531180N_Map 2
data frame and select Remove.

Now you will change the hole trace parameters to remove the label lines and depth
ticks.

To change the hole traces parameters:
1. Open the Section Parameters dialog and click the Output tab.

2. ForFrame/Layer Name Tag, enter Map 4.
3. Click the Hole Traces tab.
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Figure 3.36 Section Parameters Hole Traces tab

Section Parameters @

Profiles I Reference Grid I Topography I Flan View Load/Save | Slices
Output | Page Layout | Section Location | Colars | Hole Traces | Data

Hole ID at top or entrance
[ Hole 1D &t bottam or exit

Hole Trace Plot Depth Ticks

Width o) 01| ©) Left side @ Right side
Out of slice Tick interval {m) 50
Hole Labels Tick: size {mm) 1

Plot depth labels

4.

[ Depth at bottom or exit Size fnm) 1.5 -
Fort
Crossing Annotations
[ Deviations from certer [T Entry locations +/- |
[] Depths at crossings Entry marks: x, v Size nm) 1.5
[ ok [ cancel |[ Heb |

In the Hole Labels section, click Advanced.

Figure 3.37 Hole Labels Advanced Options dialog

Hole Labels Advanced Options

Label Text
Fant: v

Size [mm]: 15

Hole 1D Labels
Qffzet [mm]:

Position: (@) .

K.eep perpendicular to hole trace
Plot label lines
Overplat pratection

[ Ok ][ Cancel ” Help ]

© © N o O

For Label Text Size (mm), enter 2.0.

Clear the Plot label lines option.

Click OK.

Clear the Plot Depth Ticks option.

Click OK.

A new data frame, Section_6531180N_Map 4, is

The Hole Labels Advanced Options dialog opens.

added to the Table Of

Contents; the depth ticks and label lines are no longer plotted.
10. Remove the Section_6531180N_Map 3 data frame.

Next, you will plot four different types of data on your section map. First you will
plot rock patterns, then a bar plot, a grid and finally post values.

To plot rock patterns on the section map:
Open the Section Parametersdialog and click theOutput tab.

1.

2. ForFrame/Layer Name Tag, enter Map 5.
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3. Click the Data tab.

Figure 3.38 Section Parameters Data tab

Section Parameters @
Profiles I Reference Grid I Topography I Flan View I Load/Save I Slices
Qutput I Page Layout I Section Location I Collars I Hole Traces | Data
Data selection
Plot Data Plat Type
[ v] Define
[ v] Define
[ v] Define
[ v] Define
[ v] Define
[ v] Define
[ v] Define
[ v] Define

[ Clear All ]
[ ok [ cancel |[ Heb |

4. From the first Data list, select Rock (Geology).
5. From the Plot Type list, select Rock patterns.

Recall that you earlier used the Project Preferences to set the default rock code file
to be "Lithology Rock Code.csv". If you click on the Define button next to the Data
field, you will see that this file has been loaded automatically.

To plot a bar plot of Au assay values:
From the second Data list, select Au (Assay).

From the Plot Type list, select Bar plot and click Define.

1.
2.

The Bar Plot Parameters dialog opens.

Figure 3.39 Bar Plot Parameters dialog

Bar Plot Parameters
Flat Parameters
() Left side
@ Right side

Line style

Offzet [mm) 0

Thickness [mm) 0.1

Fil
@ Ma fil

—

() Pattern fill

() Rock patterns

() Zone File
Az WPt
Browse...
Az [Aszay]
Defing...

Scaling
() Fived scale [datatcm)
@ Auto-zcale to size [cm)
@ Selected holes
() Selected holes in section
Minimum [baze] value
M axirmum [clip] value

Averaging inkerval
[ Log scale

Flot Scale Bars
[ &t start of haole
At end of haole

Text size [mm) 15

Depth ticks
[T Plat depth ticks
Left side
(@) Right side
Length [ramm] 1
Thickness [mm] 0.1

[ Ok J [ Cancel

)|

Help
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3. Inthe Plot Parameters section, select Left side and for Thickness (mm), enter

0.05.

4. Inthe Fill section, select Zone File.

The Au_WP.itr zone fill will be created automatically.

5. Click Define.

The Define Colour Zone dialog opens.

Figure 3.40 Define Colour Zone dialog

Define Colour Zones
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Zone 8

Zone 7 0.48
Zone6 0.17
Zone 5 0.08
Zone 4 0.04
Zone 3 0.02
Zone2 001
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6. Select the Cum. % option.

This displays the data as cumulative percentages.

7. Enterthe following values for each zone:

Zone

7

6

Value

99

97

95

90

83

75

50

8. ForZone 1, click the black colour box and change the colour to grey.

9. Click OK.

10. In the Plot Scale Bars section of the Bar Plot Parameters dialog, clear the At
the end of hole option.

11. Click OK.

To plot gridded data:
1. From the third Data list, select Au (Assay).
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2. From the Plot Type list, select Grid: Min. curve.

To plot post values:
From the fourth Data list, select Au (composite).

These are the Au values from the composite database you created earlier.

1.

2. From the Plot Type list, select Post values and click Define.

o g &~ w

The Post Numeric Values dialog opens.

Figure 3.41 Post Numeric Values dialog

Post Murmneric Values IEI
Text dizplay Depth ticks
() Left side [ Plot depth ticks
@ Right side Left zside
Too-close labels (=) Fiht side
Lot {1
B [ Thickness [mm] |01
Minimum Text colour
I awirnLirn @ Fixed colour
(7 Use colour zone file
Text height [mm) 1.5
Fixed colour -
Ferh Dffset [mm) 0 Colour zone file narne
- A Pt Browese... Define...
[ QK ] [ Cancel ] [ Help ]

In the Text display section, select Left side.

For Decimals, enter 3.

For Text height, enter 1.

Click OK.
All four data plots are now setup in the Section Parameters dialog.

Figure 3.42 Section Parameters dialog with four data types to be plotted

Section Parameters @
Profiles | Reference Grid | Topography | Plan View | Load/Save I Slices
Qutput I Page Layout I Section Location I Collars I Hole Traces | Data
Data selection
Plot Data Plot Type
[[Rock [Geology] + |[Rock pattems ~|(__Define
1] au [assay) + |[Bar ot ~|[Define
V[ Au [Assay] ~ || Giid: Min. curve ~ ][ Define
[Au [composite] v][F'ost\raIues v][ Define ]
[ v] Define
[ v] Define
[ v] Define
[ v] Define

[ Clear All ]
[ ok J[ cancel |[ Heb |

7. Toview the four data plots on the section map, click OK.

A new data frame, Section_6531180N_Map 5, is added to the Table Of

Contents; the four data plots are added as separate layers that can be turned off

and on.

8. Remove the Section_6531180N_Map 4 data frame.
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Figure 3.43 Section Map with data plotted (zoomed)
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Next, you will add a legend and a plan view to your map.

To add a legend:

1. Open the Section Parameters dialog and click the Output tab.
2. ForFrame/Layer Name Tag, enter Map 6.

3. Click the Page Layout tab.

Figure 3.44 Section Parameters Page Layout tab

Section Parameters @
Profiles Reference Grid I Topography I Flan View I Load/Save | Slices
Qutput Page Layout | Section Location I Collars I Hole Traces Data

Components Legend
Flot holes [ Plot Legend

) . List holes
[T Plot grid data profiles Compass diagram
[T Plot plan view Scale bar

Borders
Map Layout... Infar Logo...
Plot Titles
[ ok |[ camcel |[ Hep |

4. Inthe Legend section, select Plot legend and click the Logo button.

The Position Logo dialog opens.
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Figure 3.45 Position Logo dialog

==l

Position Logo

[ Plat lngo

File name

Browse...

Location mmiddle l=ft

Height [crm) 25

Offset fom) % |0 v |0

[ QK ] [Eancel] [ Help ]

®© N o O»

Select Plot logo and click Browse.

Change the Files of type to JPEG Image (*.jpg).

From the Logos and Legends folder, select geosoft-logo.jpg and click Open.

For the logo Location, select top centre and click OK.

Next, you will set up to display the plan view on your section map to plot the hole

traces and display an image.

To change the plan view parameters:

1. Click the Plan View tab.

Figure 3.46 Section Parameters Plan View tab

Section Parameters @
Output | Page Layout | Section Location Collars Hole Traces | Data
Profiles I Reference Grid I Topography | Plan View | Load/Save | Slices

[ Plot plan view

Trace Style Depth Ticks

@) Collars

©) Hole Traces Plot Depth Ticks
Plot grid or image in plan view
Grid orimage file
File name
Colour zones
File name
colourtbl

[ ok [ cancel |[ Heb |

Select Plot plan view.

N o o~ w DN

Click OK.

For Trace Style, select Hole Traces.

For the Grid or image file name, click Browse.

Select the Plot grid or image in plan view option.

From the Geophysics folder, select mag_MC.grd and click Open.

Three new data frames are added to the Table Of Contents; one for the section
plot data, one for the legend and one for the plan map.

8. Remove the Section_6531180N_Map 5 data frame.
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Figure 3.47 Section Map
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Shapefile Output

You will now create a section map in shapefile format.

To create a section map in shapefile format:

1.
2.

S © © N o o &~ w

Turn off the display of the three existing Map 6 data frames.

Open the Section Parameters dialog.

All the parameters you used to create the Geosoft Map Layer are remembered.
Click the Output tab.

For Frame/Layer Name Tag, enter Shapefiles.

Clear the Geosoft Map Layer option and select the Shape File Output option.

For the Shape File Output Filename Tag, enter Shapefile.
Click the Page Layout tab and clear the Plot Legend option.
Click the Reference Grid tab and clear the Plot grid option.

Click the Plan View tab and clear the Plot plan view option.

. Click OK.

Eight shapefiles are created and displayed on your map; two polygon layers
represent rock codes and the Au bar plot, two line layers represent the hole
traces and the topography, three point layers represent the collar locations,
drillhole bottoms and the Au post values, and finally, a raster layer representing
the gridded Au data.

Take some time now to use the ArcMap tools to symbolise these shapefiles and
insert map elements. Resize the data frame as necessary.
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o Now would be a good time to save your map document.

In this lesson you:

* Selected drillholes for the section map

* Created a Geosoft Map Layer section map

* Changed the display of the collar symbols and hole traces
* Plotted topography

* Plotted rock patterns, a bar plot, a grid and post values

* Added alegend and plan view

* Created a section map in shapefile format
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Lesson 3.4 Creating a Stacked Section Map

In this lesson you will:
Create a stacked section map
Plot structural ticks

Trace the sections on a plan map

Creating a Stacked Section Map

Using the drillhole stacked section option, you can plot multiple sections on a single
map.

In this lesson, you will generate multiple sections on a single map using the
parameters defined for the previous single section you made earlier.

Since ArcMap is designed to function as a single-map environment, you will create
and save a new .mxd file with portrait orientation in which you will create the
stacked section map. A portrait page layout is preferred for stacked section maps.

To change the page orientation:

1. From the ArcMap File menu, select Page and Print Setup.
The Page and Print Setup dialog opens.

2. For Orientation, select Portrait.
Click OK.

To create a stacked section map:

1. Onthe Target Drillhole toolbar, click the Generate Target Stacked Section
Plot button.

2. Select default/previous parameters and click OK.
The Section Parameters dialog opens.
Click the Load/Save tab.

In the Load/Save Map Parameters section, click the Load map parameters
from a file button.

5. From the Geosoft Training Data folder, select TFA_Section.ins and click
Open.

Click the Section Location tab.
For Number of sections, enter 2.

In the Section Azimuth section, click Define beside E-W.

© © N o

Define the section location based on the figure below.
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Figure 3.48 Selecting holes for stacked section map
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10. Click OK.

11. For Easting Ref, enter 716662.
12. For Northing Ref, enter 6531284.
13. For Thickness, enter 15.

14. For Spacing, enter 45.

15. For Map scale, enter 1500.

16. Click the Page Layout tab.

17. In the Plot Legend section, click the Logo button and deselect the Plot logo
checkbox in the Position Logo dialog.

18. Click OK.
19. In the Plot Titles section, change the Title to Stacked Section Map.
20. Click OK.
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Figure 3.49 Stacked section map
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Stacked Section Map

Structure Data

Structural data is point data collected at specific depths down a drillhole. This data
often represents planar structures (bedding, cleavage, schistosity, faults, joints and
veins) or linear structures (planar structure intersections, mineral stretching, and
other forms of lineation). In general, each structure type consists of an alpha and
beta angle of measurement to determine the geological orientation of structures
down the drillhole. In the struture data you will shortly import, the "alpha" represents
the dip of the structure relative to the core reference line and the "beta" represents
the dip direction of the structure relative to the core reference line.

Structural Ticks

At each location in the hole, the structural tick is plotted to indicate the orientation of
a structure that crosses the axis of the hole. For section plots, the intersection of
the structure with the section plane is determined and a line is drawn, centred on
the hole, to show the intersection.

Using the dip and dip direction channels of the structure table, you will add
structural ticks to the section which will be coloured based on the structure type as
defined in the structure codes file you examined earlier.

To plot structural ticks:
1. Open the Section Parameters dialog and click the Data tab.
2. Deselect the first four Data rows that are plotted.

3. From the fifth Data row, select Alpha [Structure].
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4. From the Plot Type list, select Structural ticks.
5. Click Define.
The Structural Tick Parameters dialog opens.

Figure 3.50 Structural Tick Parameters dialog

- ™y
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Dip Alpha [Stucture] Left side
Direction [Beta [Structure] '] @) Right side

Dip/Dir Reference
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@ Relative ta hole Thickness [mm) | 0.1
Fief Line
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Plat Parameters

@) Fized colour - Length (mm) 1

() Structure codes Thickness [mm] 0.1

Structure Codes.cav Browse... Edit...

[ ok ][ Cancel ” Help

" J

6. From the Direction list, select Beta [Structure].

v For "Absolute" Dip/Dir Reference, the dip is measured downward from
the horizontal (e.g. 90 degrees is vertical) and the direction is the

azimuth angle, measured clockwise from North.

v For "Relative to hole", dip is measured with respect to the hole axis,
with zero degrees parallel to the hole axis and 90 degrees being
perpendicular to the hole axis. Direction is measured clockwise looking
down the hole axis, from either the top or bottom reference point.

v In cases of vertical holes, Dip and Dip Direction is always interpreted

using the "absolute" reference.

7. Inthe Plot Parameters section, select Structure codes.
8. For Length (mm), enter 5.
9. ForThickness (mm), enter 0.4.

10. From the Structural Data list, select Structure_Type [Structure].

11. Ensure the Structure code name file is Structure Codes.csv.

12. Click OK and OK again.

The result should look similar to the figure below.
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Figure 3.51 Stacked section map with structure ticks plotted (zoomed)
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W You may want to change the transparency of the other layers.

To trace the sections on a plan map:

1.

Open the .mxd file containing your mineralised plan map.

2. Hide all data frames except for those pertaining to the plan map.

3. Onthe Target Drillhole toolbar, click the Trace Target section into current

data frame button.

The Draw a section dialog opens.

Figure 3.52 Draw a section dialog

Draw a section

Section job name:

Output shape file name:

Plot section...:

(-5 el
(]
(]
center line(s) - ]

For Section job name, click the Browse button and select TfA_stacked.ins.

For Output shape file name, enter Stacked_Sections.

For Plot section, select perimeter(s).

The outside boundary of the stacked sections are plotted on the plan map.
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Figure 3.53 Plan Map with stacked section perimeter lines
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Now would be a good time to save your map document.

In this lesson you:

Created a stacked section map
Plotted structural ticks

Traced the sections on a plan map
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Lesson 3.5 Creating a Fence Diagram

In this lesson you will:
Select holes
Create a fence diagram
Plot geology polygons

Add a legend and plan view

Fence Diagrams

A limiting factor in using section maps is the fact they can only be oriented in a
straight line. . Fence diagrams provide you with the means to plot a cross-section
from any combination of drillholes, regardless of how they are located relative to
one another. Fence diagrams are particularly useful in regional exploration, where
you might want to interpret lithology between widely-separated and offset drillholes
in your project area.

Since ArcMap is designed to function as a single-map environment, you will begin
by creating a new map file in which you will create the fence diagram.

To create a new .MXD:

1. Onthe Standard toolbar, click the New Map File button D
The New Document dialog opens.

2. Click OK.

A new, untitled map with the Target Project loaded, the drillholes selected and
the correct page setup is created.

3. Savethe map as Fence Diagram.mxd.

To select holes and create a fence diagram:
1. Onthe Target Drillhole toolbar, click the Generate Target Fence Diagram
Plot button =%/,

The Fence Parameters dialog opens.

www.geosoft.com Target for ArcGISTarget for ArcGIS 11| 129


http://www.geosoft.com/

Module 3: Mapping Drillhole Data

Figure 3.54 Fence Parameters dialog
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Map Scale

Vertical Exaggeration: 1
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2. Click Select from list.
The Select Fence Diagram Holes in Order dialog opens.

Figure 3.55 Select Fence Diagram Holes in Order dialog
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3. Fromthe Not Selected list, select SKC255 and click the L’ button.
This hole is now listed in the Selected list.

4. Repeat step 3 to select the following holes: SKC422, AXRC015, SKC256,
SKC253 and SKC252.

Click OK.
Click the Output tab.
For Frame/Layer Name Tag, enter Map 1 and click OK.

The FenceSection data frame is added to the Table Of Contents; it contains the
Holes and Borders layers which are parts of the Geosoft Map Layer output.

8. Remove the Layers data frame.
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Figure 3.56 Default Fence Diagram
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Next, you will reopen the Fence Parameters dialog box and interpolate the geology
between the drillholes.

To plot geology polygons:
1. Open the Fence Parameters dialog and click the Output tab.

2. ForFrame/Layer Name Tag, enter Map 2.
3. Click the Data tab.

Figure 3.57 Fence Parameters Data tab
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4. From the first Data list, select Rock (Geology).
5. From the Plot Type list, select Geology polygons and click OK.
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A new data frame, FenceSection_Map 2, is added to the Table Of Contents; the
geology polygons are now plotted on the fence diagram.

6. Remove the FenceSection_Map 1 data frame.

Figure 3.58 Fence Diagram with geology polygons

Next, you will add a legend and plan map to the fence map.

To add a legend and plan map:
1. Open the Fence Parameters dialog and click the Output tab.

2. ForFrame/Layer Name Tag, enter Map 3.
3. Click the Page Layout tab.

Figure 3.59 Fence Parameters Page Layout tab
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4. Select Plot legend and click OK.

Two new data frames are added to the Table Of Contents; one for the fence
diagram and one for the legend.
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5. Remove the FenceSection_Map 2 data frame.

Figure 3.60 Fence Diagram with legend
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Q Now would be a good time to save your map document.

In this lesson you:

* Selected holes

* Created afence diagram

* Plotted geology polygons

* Added alegend and plan view
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Lesson 3.6 Creating a Strip Log

In this lesson you will:
Create a strip log
Plot data on the strip log
Add alegend
Create a fracture density plot
Create a stereonet
Create a tadpole plot

Create strip logs for a range of holes

Strip Logs

Strip logs are useful for visualising data from one drillhole, side by side.. The
drillhole trace is plotted vertically on the strip log and the associated data are plotted
at regular or customised intervals. You can plot up to 32 different drillhole datasets
on a strip log.

Since ArcMap is designed to function as a single-map environment, you will begin
by creating a new map file in which you will create the strip log.

To create a new .MXD:

1. Onthe Standard toolbar, click the New Map File button D
The New Document dialog opens.

2. Click OK.

A new, untitled map with the Target Project loaded, the drillholes selected and
the correct page setup is created.

3. Save the map as Strip Log.mxd.

Geosoft Map Layer Output

You will now create a strip log for a single drillhole, in Geosoft Map Layer format
output. Following that, you will adjust various parameters to change the display of
the strip log.

To create a strip log:
1. Onthe Target Drillhole toolbar, click the Generate Target Striplog Plot button

&
strie |

The Strip Log Parameters dialog opens.
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Figure 3.61 Strip Log Parameters dialog
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2. For Frame/Layer Name Tag, enter Map 1.
Clear the Shape File Output option.
Click the Page Layout tab.

Figure 3.62 Strip Log Parameters Page Layout tab
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In the Holes to plot section, select Specified hole(s).
From the hole/mask list, select SKC236.
Click OK.

The Log_SKC236_Map 1 data frame is added to the Table Of Contents; it
contains the Border, RelativeLevel, DepthLines and HoleTrace Geosoft Map
Layers.

8. Remove the Layers data frame.
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Figure 3.63 Strip Log map
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Next, you will plot four different types of data on your strip log. First you will plot
downhole lithology as rock patterns, then Au assay data as a bar plot, post values
and a profile.

To plot rock patterns on the strip log:

1. Open the Strip Log Parameters dialog and click the Output tab.
2. ForFrame/Layer Name Tag, enter Map 2.

3. Click the Data tab.

Figure 3.64 Strip Log Parameters Data tab
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4. From the first Data list, select Rock (Geology).
5. From the Plot Type list, select Rock patterns.
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To plot a bar plot of Au assay values:
1. From the second Data list, select Au (Assay).

2. From the Plot Type list, select Bar plot and click Define.
The Bar Plot Parameters dialog opens.

Figure 3.65 Bar Plot Parameters dialog
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3. Inthe Plot Parameters section, for Thickness (mm), enter 0.05.
4. Inthe Scaling section, enter an Auto-scale to size (cm) value of 10.
5. Inthe Fill section, select Zone File.
The Au_WP.itr zone fill will be used automatically.
6. Inthe Depthticks section, clear the Plot depth ticks option.

7. Click OK.

To plot post values:
1. From the third Data list, select Au (composite).

These are the Au values from the composite database you created earlier.
2. From the Plot Type list, select Post values and click Define.

The Post Numeric Values dialog opens.
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Figure 3.66 Post Numeric Values dialog
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For Decimals, enter 3.

For Text height, enter 2.

Click OK.

e A L

and post values data selections.

In the Text display section, select Left side.

For Text colour, select Use colour zone file.

In the Strip Log Parameters dialog, click the Link button straddling the bar plot

This will link the hole traces so that these two data plots will be plotted down the
same vertical hole. The dialog should appear as follows:

Figure 3.67 Strip Log Parameters Data tab with link
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To plot a profile:

1. From the fourth Data list, select As (Assay).

2. From the Plot Type list, select Profile and click Define.

The Profile Plot Parameters dialog opens.
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Figure 3.68 Profile Plot Parameters dialog

Lesson 3.6 Creating a Strip Log

Profile Plot Parameters
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In the Plot Parameters section, for Thickness (mm), enter 0.05.

Click the black colour box and chance the profile line colour to green.

In the Scaling section, enter an Auto-scale to size (cm) value of 20.

In the Depth ticks section, clear the Plot depth ticks option.

Click OK.

All four data plots are now setup in the Section Parameters dialog.

Figure 3.69 Strip Log Parameters dialog with four data types to be plotted

Strip Log Parameters @
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| Output I Page Layout I Hole Trace | Data

Data selection 1:8
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[ v] Define
[ '] Define
( Clear Al I Reorder |
[ ok |[ cenesl |[ hHep |

To view the four data plots on the strip log, click OK.

A new data frame, Log_ SKC236_Map 2 is added to the Table Of Contents; the

data plots are added to your strip log as Geosoft Map Layers.
Remove the Log_SKC236_Map 1 data frame.
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Figure 3.70 Strip Log map with data plotted
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Next, you will add a legend to the strip log.

To add a legend:

1. Open the Strip Log Parameters dialog and click the Output tab.
2. ForFrame/Layer Name Tag, enter Map 3.
3. Click the Legend tab.
Figure 3.71 Strip Log Parameters Legend tab
Strip Log Parameters
Qutput Page ut | Hole Trace I Data
Load/Save Legend | Strip Positioning
[ Plot Legend
Location Information
Top (@ Right [T Vertical scale
“width cm) (10
Plot data info Plot logo
Post text File: name
Post values TR
Bar plot
Profile
Text bands Location middle left
et 25
Line plots Offzet [cm) ¢ |0 v |0
[ ok [ Cancel |[ Heb
4. Select Plot Legend.

In the Information section, select Vertical Scale.

In the Plot data info section, select Post text, Post values, Bar plot and

Profile.

140 | Target for ArcGISTarget for ArcGIS Il

www.geosoft.com


http://www.geosoft.com/

www.geosoft.com

Lesson 3.6 Creating a Strip Log

Leave the remaining options selected as well.
Select Plot logo and click Browse.

8. Change the Files of type to JPEG Image (*.jpg), select geosoft-logo.jpg from
the Logos and Legends folder and click Open.

9. Forthe logo Location, select bottom centre and click OK.

Two new data frames are added to the Table Of Contents; one for the strip log
and one for the legend.

10. Remove the Log_SKC236_Map 2 data frame.

Figure 3.72 Strip Log map with legend information
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Ay As with plan maps and section maps, strip logs can also be created in
shapefile format.

Yy Now would be a good time to save your map document.

Fracture Density Plots

The fracture density plot is a form of "rose" plot, essentially a radial histogram with
the height (radius) of the bins showing the relative frequency of the points as a
function of dip-direction. The number of points in each interval is summed, and the
radius of the bin with the highest number of items is scaled to the entered radius.
Note that it is the radius of the petal which is proportional to the number of items,
not the area.

You will now create a Fracture Density plot from a single drillhole within the Target_
Structure.gdb database.
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To create a new .MXD:

1. Onthe Standard toolbar, click the New Map File button D,

The New Document dialog box opens.

2. Click OK.

A new, untitled map with the Target Project loaded, the drillholes selected and

the correct page setup is created.

3. Save the map as Rose Plot.mxd.

To create a fracture density plot:

1. Onthe Target Drillhole toolbar, click the Generate Target Striplog Plot button

&
Strie | _

The Strip Log Parameters dialog box opens.

Click the Data tab.

2

3. Deselect the second, third, and fourth data rows.
4. From the fifth Data list, select Alpha [Structure].
5

For Plot Type, select Fracture density and click Define.

The Fracture Density Plot Parameters dialog box opens.

Figure 3.73 Fracture Density Plot Parameters dialog box
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[ QK ] [ Cancel ] [ Help

"
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In the Plot Parameters section, enter a Radius (mm) of 15.

6

7. Change the black box next to Radius and Sector Angle to red.
8. Clearthe Plot depth ticks option and click OK.
9

Remove the Layers data frame.
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Stereonets

Stereonets are used in structural geology to depict the angular relationships
between geologic structures; they are a way of representing 3-dimensional
directions on a 2-dimensional surface. The colour of the dots shows the structure
type being measured; the dip direction is shown in its orientation from North or the
top of the stereonet. Steeply dipping planes have poles that are closer to the edge
of the stereonet; shallow dipping planes have poles that are closer to the centre of
the stereonet.

Two stereographic projections are commonly used; equal-area projection (Schmidt
net) and equal-angle projection (Wulff net). The net is a projection from the centre
point of a sphere onto the surface of the sphere thus allowing you to visualise the
dip and dip direction of measured features.

You will now create a Stereonet for one of the drillholes on your project.

To create a new .MXD:

1. Onthe Standard toolbar, click the New Map File button D
The New Document dialog box opens.

2. Click OK.

A new, untitled map with the Target Project loaded, the drillholes selected and
the correct page setup is created.

3. Save the map as Stereonet.mxd.

To create a stereonet:
1. Onthe Target Drillhole toolbar, click the Generate Target Striplog Plot button

&
strie |

The Strip Log Parameters dialog box opens.
2. From the sixth Data list, select Alpha [Structure].
3. From the Plot Type list, select Stereonet and click Define.

The Stereonet Plot Parameters - Strip Log dialog box opens.
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Figure 3.74 Stereonet Plot Parameters - Strip Log dialog box
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4. Inthe Plot Parameters section, enter a Radius (mm) of 15.
5. Change the colour of the black box to grey.
6. Clearthe Plot depth ticks option.
7. Inthe Symbols section, select Structure codes.
8. From the Structural Data list, select Structure_Type [Structure].
9. Inthe Intervals section, select Defined and enter the following values:
From To
0 60
60 90
90 110

10. Remove the Layers data frame.

Tadpole Plot

A tadpole plot is a graph of dipmeter results. The dip of the measured structure is
plotted as a dot on a depth/dip graph and the dot tail indicates the dip direction (e.qg.,
the tail points vertically upwards from the dot for a northerly dip direction).

You will now create a Tadpole plot from a drillhole in your project.

To create a tadpole plot:
1. From the seventh Data list, select Alpha [Structure].
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2. Forthe Plot Type, select Tadpole plot and click Define.
The Tadpole Plot Parameters dialog opens.

Figure 3.75 Tadpole Plot Parameters dialog
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In the Plot Parameters section, enter a Panel Width (cm) of 5.

In the Colour section, select Structure codes.

3
4
5. From the Structural Data list, select Structure_Type [Structure].
6. Clearthe Plot depth ticks option and click OK.
7. Inthe Strip Log Parameters dialog, click OK.

The tadpole plot is displayed on the strip log map.

Figure 3.76 Tadpole Plot
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As with the stereonet, the colour of each tadpole symbol represents a structure
type. Its location on the graph along the X axis describes the dip of the structural
feature that each tadpole symbol represents. The tails show the dip direction. If a
tail is pointing straight up, the dip direction would be due North.

iy You can also create strip logs for a range of holes, where you select Range
of Holes and specify a range in the Holes to plot section.

In this lesson you:
Created a strip log
Plotted data on the strip log
Added a legend
Created a fracture density plot
Created a stereonet
Created a tadpole plot

Created strip logs for a range of holes
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Lesson 3.7 Creating a 3D Map

In this lesson you will:
Create a 3D map
Use the Geosoft 3D Viewer
Plot rock patterns and a bar plot
Plot gridded data
Export toa 3D PDF

3D Drillhole Maps

Geosoft's 3D Viewer enables you to display drillhole, surface and other data types
in an interactive, three-dimensional environment. Drillholes are displayed in their
"true" three-dimensional location and can have up to two different data types plotted
along their trace.

In this lesson, you will create a simple 3D View and explore the navigation tools
within.

Since ArcMap is designed to function as a single-map environment, you will begin
by creating a new map file in which you will create the 3D map.

To create a new .MXD:
1. Onthe Standard toolbar, click the New Map File button D,
The New Document dialog opens.

2. Click OK.

A new, untitled map with the Target Project loaded, the drillholes selected and
the correct page setup is created.

3. Savethe map as 3D Map.mxd.

To create a 3D map:
1. On the Target Drillhole toolbar, click the Generate 3D Drillhole Plot button @

The 3D Map Parameters dialog opens.
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Figure 3.77 3D Map Parameters dialog
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2. Open the Page Layout tab, select the Plot Legend option and click the Logo

button.

The Position Logo dialog opens.

Figure 3.78 Position Logo dialog
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Select Plot logo and click Browse.
Change the Files of type to JPEG Image (*.jpg), select geosoft-logo.jpg from

the Logos and Legends folder and click Open.

Enter the following titles:

Company: Geosoft

Property: Mt Palmer

Map

For the logo Location, select top centre and click OK.

Subtitle: Target for ArcGIS Training

3.
4.
5.
6.
Title: 3D
7. Click OK.

The Geosoft 3D Viewer opens.
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Figure 3.79 Geosoft 3DViewer
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The following interactive tools are provided to navigate the display of your datain
3D:

Table 3.3 3D Manager Tools

Icon Tool Description

_@, Add Click this button to add any number of planes to the 3D
Plane view.

% Section Click this button in order to create a section view, where
View you must first position the Reference Plane where you

want to create the new drillhole, then draw the proposed
drillhole on the plane.

Table 3.4 3D Navigation Tools

Icon Tool Description

o Shadow To toggle the visibility of the shadow cursor
Cursor On On/Off

& Pan To move the entire displayed view

Q Zoom In/Out To zoom in and out of the displayed view

c‘,‘%} Rotate To rotate the displayed view 360 degrees in all

directions

= : Centre to To centre the current 3D view in the 3D Viewer
Window display window

Q Automatic To automatically adjust the 3D view as objects
Zoom On/Off are selected/deselected in the tree control
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Q
o
=]

@ QA 8 @ 8§ @ 2 2 ©

Tool

Zoom to Full
Extents

Automatic

Redraw On

Redraw

North View

South View

East View

West View

Top View

Bottom View

User Defined
View

Description

To centre the 3D view based on the currently
selected objects in the tree control

To refresh/redraw the 3D view automatically
after changes are made

To refresh/redraw the 3D view in the 3D Viewer
window

To set the observation point for the current view
to directly north (looking south)

To set the observation point for the current view
to directly south (looking north)

To set the observation point of the current view
to directly east (looking west)

To set the observation point of the current view
to directly west (looking east)

To set the observation point of the current view
to directly above (looking down)

To set the observation point of the current view
to directly below (looking up)

To specify the inclination and azimuth of the
view

i Perspective To select to display as either a perspective
View/ view or an orthographic view.
Orthographic
View
= Create To create a snapshot of your current view.
Snapshot
v Right-click in the 3D Viewer for quick access to some of these navigation

tools. You can also zoom in and out using the track wheel on your mouse.

Take some time now to experiment with the 3D navigation tools.

To plot data in the Geosoft 3D Viewer:
1. From the Add to 3D menu in the Geosoft 3D Viewer, select Drillholes.

The Draw holes to an existing 3D view dialog opens.
2. Click the Data tab.
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Figure 3.80 Draw holes to an existing 3D view Data tab
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From the Plot Type list, select Rock patterns.

The Bar Plot Parameters dialog opens.

Figure 3.81 Bar Plot Parameters

From the Plot Type list, select Bar plot and click Define.

From the Data list in the Left side section, select Rock [Geology].

From the Data list in the Right side section, select Au [Assay].
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7. For Thickness, enter 0.05.

8. Inthe Fill section, select Zone File.

9. ForAuto-scale to size (m), enter 10.

10. Inthe Plot Scale Bars section, clear the At the end of hole option and click

OK.

The Bar Plot Parameter dialog closes.
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11. Click OK.

The rock patterns and bar plots are displayed in the Geosoft 3D Viewer.

Figure 3.82 Geosoft 3D Viewer with data plotted
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In 3D, only two sets of data can be plotted down hole along the trace (Left
side and Right side). When the data appears in the Geosoft 3D Viewer, the
point-of-view will always remain the same, no matter how the image is
rotated, panned or zoomed.

Next you will plot gridded data by interpolating the drillhole values at a specified
relative level or elevation. You will create three grids at 50 metre intervals.

To plot gridded data:
From the Add to 3D menu in the Geosoft 3D Viewer, select Drillholes.

1.

The Draw holes to an existing 3D view dialog opens.

Click the Data tab.

From the Data list in the Gridded Data section, select Au [Assay].
From the Plot Type list, select Grid: Min. curve and click Define.

The Minimum Curvature Gridding dialog opens.
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Figure 3.83 Minimum Curvature Gridding dialog
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5. For Averaging interval, enter 10.

The grid’s values are derived from the values in the holes where the holes
intersect the grid plane. Because these values may vary quite rapidly with
location down the hole, an averaging interval is used to sample the hole in the
area of the intersection, and smooth out this variation.

6. Inthe Multiple Grids section, for the Number of grids enter 3.

7. ForIncrement, enter -50.

8. Click OK.
The Minimum Curvature Gridding dialog closes.
9. Click OK.

The three grids are created and displayed in your Geosoft 3D Viewer.

Figure 3.84 Geosoft 3D Viewer with three grids
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Exporting a 3D View to a 3D PDF

By exporting your current 3D View to a standard Adobe PDF file, you can share
your 3D subsurface models with colleagues who do not have Geosoft software
installed. The 3D interactive tools, such as zoom, rotation, layer controls, and
transparency are included in the exported PDF file.

To export to a 3D PDF:
1. From the Export menu in the Geosoft 3D Viewer, select 3D PDF.

The Export 3D View to PDF dialog opens.

Figure 3.85 Export 3D View to PDF dialog
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2. Click OK.

The 3D PDF opens in your default PDF viewer.
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Figure 3.86 3D PDF
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You can use these interactive tools on the 3D Toolbar to change the zoom, rotation,
layer controls, transparency, lighting and many other options for your PDF 3D
View:

Figure 3.87 3D Toolbar

Fe e o VE w8 O
'} Now would be a good time to save your project.

To view the static 3D map:
Close the Geosoft 3D Viewer.

The Geosoft 3D Viewer closes and a static view of the data manipulated in the
Geosoft 3D Viewer is displayed on the map.
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Figure 3.88 3D Map

%/ GEOSOFT.

lore’

Geosoft
Mt Palmer
3D Map
Target for ArcGIS Training

v Now would be a good time to save your map document.

In this lesson you:

* Created a 3D map

* Used the Geosoft 3D Viewer

* Plotted rock patterns and a bar plot
* Plotted gridded data

* Exported toa 3D PDF
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Lesson 4.1 Creating Voxels

In this lesson you will:
Create a voxel
View voxel statistics
Clip a voxel to a topography layer
Window a voxel

Apply a colour zone file to a voxel

3D Gridding

The 3D Gridding option uses either basic statistical kriging or inverse distance
weighted interpolation algorithms to create a 3D voxel grid from 3D data contained
in a Geosoft Database (GDB file). To create a voxel grid you will need to have a
data set that contains X, Y, and Z fields that locate the data within a coordinate
system in which Z coordinates are interpreted as positive up.

To create a 3D voxel grid model using Kriging:
1. From the Voxel menu in the 3D Viewer, select 3D Gridding then Kriging.

The 3D Kriging dialog opens.

Figure 4.1 3D Kriging dialog

(3D Kriging [E=)
Channel to grid: v]
Output voxel name: E]
Cell size:
o) (Goon ]
g A
2. Click More.

The 3D Kriging dialog expands to show additional options.
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Figure 4.2 Expanded 3D Kriging dialog

ra ™y
3D Kriging [
Channel to grid: [ v]
Output voxel name: E]
Cell size:
o) o)
Advanced | Var
Cell size for Z:
Blanking distance: 4 Woxel cells
Log option: linear w7
Log minimum: 1
Maximum radius: 16 Voxel cells
Minimum points: 16
Maximum points: 32
Strike: 1]
Dip: Q0
Flunge: 1]
Strike weight: 1
Dip plane weight: 1

- 2

3. From the Channel to grid list, select Au [Assay].

The Output voxel file will be named Target Assay Au.geosoft_voxel by
default.

For Cell size, enter 5.

For Blank distance, enter 10.

For Log option, select log, save as linear.
For Log minimum, enter 0.01

Click the Variogram tab.

© ® N o o &

For Range, enter 55 and for Sill, enter 0.44.

v You can optionally view the variogram to visually inspect the result of the
advanced parameters on the model.

10. Click OK.

The voxel is displayed in the Geosoft 3D Viewer and listed in the 3D Manager
tree list.
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Figure 4.3 Voxelin 3D Viewer
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To view voxel statistics:
1. Inthe 3D Manager tree list, select the VOX_target_assay_au 3D Object.
2. Onthe Attributes tab displayed below, click Visible Cell Statistics.

The Voxel Statistics for Visible Cells dialog opens and displays the Maximum,
Minimum, Mean, Standard Deviation, and Volume.

Figure 4.4 Voxel Statistics for Visible Cells dialog

Voxel Statistics for Visible Cells_‘ [ 2 [t

Vool name:
Valid data:
Dummies:

Volume:

Minimum:
Maxdmum:

Mean value:

Standard deviation:

-

Target_Assay_Au.geosoft_voxel I

162687

44207

20335875 m?

0.009999939775

3.714679241

0.04774942179

0.09267759146

ALY The statistics depend on the gridding parameters you entered (i.e.
blanking distance, cell size, log option/minimum, advanced Kriging
parameters).

To clip a voxel to the topography:
1. From the Voxel menu in the 3D Viewer, select Voxel Topography Clip.

The Generate A Clipped Voxel dialog opens.
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Figure 4.5 Generate A Clipped Voxel dialog

Generate A Clipped Voxel [~ 5| (23]
Input Voxel: - E]
Output Voxel: E]
Top Grid: E]
Bottom Grid: E]

Cancel

For the Input Voxel, select Target_Assay_Au.geosoft_voxel.
For the Output Voxel, enter Au_Topo_Clip.

For the Top Grid, click the Browse button.

From the Topography folder, select Topo.grd and click Save.
Click OK.

A new 3D Object called VOX_au_topo_clip is created.

7. Toview the new clipped voxel, turn off the display of the unclipped voxel VOX_
target_assay_au.
Your clipped voxel is now visible. Voxel cells that intersect with the topography
surface are not clipped and are visible; voxel cells above the surface have been
removed.

2 e

Figure 4.6 3D Viewer with voxel clipped to topography

460.2561

25¢ 300

" g1 Bas4z

To window a voxel to a boundary:
1. From the Voxel menu, select Window a Voxel.

The Window a Voxel dialog opens.
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Figure 4.7 Window a Voxel dialog
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For the Input voxel file, select Au_Topo_Clip.geosoft_voxel.

The Output voxel file field will be automatically populated with Au_Topo_
Clip_win.geosoft_voxel.

Ensure the Horizontal Windowing and To a shapefile options are selected.

From the Drilling Data folder, select DH_Selection.shp and click Open.

Click OK.

The output voxel VOX_au_topo clip_winis clipped to the extents of the .shp
file and is added to the 3D Viewer. Turn off the display of the Topo layer and the
VOX_au_topo_clip 3D Object to see the clipped object.

3
4. For Shape file (*.shp), click the Browse button.
5
6

Figure 4.8 3D Viewer with windowed voxel

460.2561

250 300

;
91.04543

6530719
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In this lesson you:

* Created and displayed a voxel

* Viewed voxel statistics

* Clipped a voxel to a topography layer
* Windowed a voxel

* Applied a colour zone file to a voxel
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Lesson 4.2 Creating Isosurfaces

In this lesson you will:
Determine an isosurface value
Create and display an isosurface
Append an isosurface to the geosurface file
Create multiple isosurfaces from a voxel

Export isosurfaces to a DXF file

Isosurfaces

Anisosurface is a 3-dimensional surface that passes through points of equal value.
Isosurfaces can be thought of as 3D contours. Isosurfaces are writtento a
geosurface file that is able to save many isosurfaces extracted from the same
voxel. This allows you to copy a single file with all its isosurfaces to another
location, or to easily share your results with colleagues to collaborate on projects.

Using Geosoft tools, there are three different ways to create isosurfaces from a
voxel:

Visually clip the minimum data values from a voxel and automatically extract an
isosurface at the specified clip value.

Create a single isosurface at a specified value.

Automatically create multiple isosurfaces using a linear, log or user-specified
distribution.

To determine the isosurface value:
1. Inthe 3D Objects tree in the 3D Manager, select VOX_au_topo_clip_win.
2. Click the Clipping tab.

3. Inthe Data section, use your cursor to move the bottom slider to the right to
increase the value to 0.25.

This interactively modifies the low value of the Data clip region. Only the voxel
cells valued at 0.25 ppm or greater will be visible.

Figure 4.9 Voxel Data Clipping

Atributes | Clipping

Data
0.25 3.59

[« | i
]

»

o [

P
m

Spatial
X 715418 716868 ¥]
o

Ko 1 | »
[E] ]

[F] Modify orientation

Y. 6530722 5531432 ¥]
B

o« 11} b
[aY] LA

W' Youcan also type in specific values.
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To create and display the isosurface:
1. Click on the Define isosurface using data clipping values icon within the
clipping pane (9 )-

The Create Isosurface from Voxel dialog opens and is automatically populated
with the Input voxel name, the Output geosurface name, the Surface Properties
value (this is the minimum data clip value you specified) and the Colour.

Figure 4.10 Create Isosurface from Voxel dialog

Create Isosurface from Voxel T >

Input vexel name: [M_Tom_up_\m.gme&_wwel
Output geosurface name: [M_Topo_ﬂn_m.gewnft_w!aoe

Vahse: |0.25 | Colour:

[ Create closed suface

0.25

[oc ] concel

Change the Colour to pink.

Specify 0.25 for Value.

Check the Create closed surface check box.
Click OK.

The geosurface (SURF_Au_Topo_Clip_win) and the isosurface (Isosurface
>0.25) are added to the 3D Viewer.

6. Turn off the display of the VOX_au_topo_clip_win layer to see the isosurface
more clearly.

ok 0N
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Figure 4.11 Isosurface ata value of 0.015
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To change the attributes of the isosurface:
1. Select the Isosurface_0.25 3D Object and click the Attributes tab.

2. Using the slide bar, change the Transparency to 75%.
3. Select the Edges option.

To append another isosurface to the geosurface file:
1. From the Add to 3D menu, select Isosurface then Create Isosurface.

The Create Isosurface from Voxel dialog reopens.
2. Click the Create closed surface checkbox so it is no longer checked.
3. Change the Surface value to 1, and change the Colour to yellow.
4. Ensure the Append to geosurface option is selected.

Isosurface_1is appended to SURF_au_topo_clip_win and you now see the two
isosurfaces, one inside the other, in the 3D Viewer.
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Figure 4.12 Isosurfacesin 3D
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1. Click the Create closed surface checkbox so it is no longer checked.

You will now automatically extract 5 isosurfaces using a log distribution from the
au_topo_clip_win.geosoft_voxel.

To create multiple isosurfaces:

1. From the Add to 3D menu, select Isosurface and click Create Multiple
Isosurface.

The Create Multiple Isosurfaces from Voxel dialog opens.

Figure 4.13 Create Multiple Isosurfaces from Voxel dialog

Create Multiple Iscsurfaces ﬁom_ @M

# Input voxel name: - B

“ Qutput geosurface name:

Surface Properties
[] Close isosurfaces between valus ranges

MNumber of isosurfaces (1-12):
Distribution:

lsosurface Value Colour

Woe! Statistics
Minimum:
Maximum:

Mean Value:
Standard deviation:

Colour table: Load Save

2. Forlnput voxel, select Au_Topo_Clip_win.geosoft_voxel.
3. Change the Output geosurface name to Au_Log Multiple.geosoft_surface.
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Select the Close isosurfaces between value ranges option.
For Distribution, click Use a log distribution.

The Log Transform dialog opens.

Use the default values and click OK.

In the Create Multiple Isosurfaces from Voxel dialog, click OK.

SURF_au_log_multiple and its five multiple isosurfaces are added to the 3D
Viewer. All of the isosurfaces are automatically displayed with 50%
transparency except for the highest value which is opaque.

Figure 4.14 Multiple Isosurfacesin 3D
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8. Turn off the display of the SURF_au_topo_clip_win layer.

1. Select the Close isosurfaces between value ranges option.

You will now export the first two isosurfaces you created to an AutoCAD DXF file.

To export isosurfaces to a AutoCAD 3D DXF file:

1.

Turn off the display of the SURF_au_log_multiple layer and turn on the display
of the SURF_au_topo_clip_win layer.

From the Export menu in the 3D Viewer, select AutoCAD DXF File.

The Select Map Groups to Export dialog opens. Only 3D vector layers that are
visible in the 3D Viewer are listed.
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Figure 4.15 Select Map Groups to Export dialog
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3. Fromthe Not Selected list on the left, select SURF_au_topo_clip_win.

4. Click the right arrow button L .

The geosurface and its isosurfaces are added to the Selected list.
5. Click OK.

The Export to 3D DXF File dialog opens.
6. Forthe DXF file, enter Au_Orebodies.dxf and click OK.

These map groups are saved to a single DXF file and added to your project
folder.

In this lesson you:
Determined an isosurface value
Created and displayed an isosurface
Appended an isosurface to the geosurface file
Created multiple isosurfaces from a voxel

Exported isosurfaces to a DXF file
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Lesson 4.3 Creating a Lithology Voxel and Contact
Surface from Geology

In this lesson you will:
Create a lithology voxel
View lithology voxel statistics

Create a contact surface from geology

Creating a Lithology Voxel

A lithology voxel is a voxel based on codes. First, contact surfaces between each
lithology unit are created; then the spaces between the surfaces are filled in with
the voxel blocks.

In this lesson, you will create a lithology voxel based on the codes that are in the
Rock channel of the Geology database and reference the lithology rock codes.csv
file to colour the voxel cells.

To create a lithology voxel:
1. From the Voxel menu in the 3D Viewer, select Create Lithology Voxel.

The Create Lithology Voxel dialog opens.

Figure 4.16 Create Lithology Voxel dialog

Create Lithology Voxel @1
Geology channel: [ v]
Output voxel name: - E]
Rock code file: Lithology Rock Code. csv E]
==
2. Click More.

The Create Lithology Voxel dialog expands to show additional options.
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Figure 4.17 Expanded Create Lithology Voxel dialog
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3. Forthe Geology channel, select Rock [Geology].

The Output voxel name will be Rock.geosoft voxel by default.
4. Check the Retail surface grids box.
5. ForCell size, enter 2 and click OK.

The lithology voxel is displayed in the 3D Viewer.

-

ALY Note: It may take a while before the results are displayed in the 3D Viewer.

Figure 4.18 Lithology Voxel
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Next, you will open the Lithology Unit Selection tool. You can use this tool to view
basic statistical information about the data in the lithology voxel and to turn the

display of lithology units on and off.
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To view lithology voxel statistics:
1. Inthe 3D Objects tree list, select the VOX_rock lithology voxel.
2. Onthe Clipping tab below, click Lithology Unit Selection.

The Lithology Unit Selection dialog opens. The Volume (m3) column displays
the total volume of all items (cubes) with the given lithology within the current
XYZ clipping region of the voxel.

Figure 4.19 Lithology Unit Selection dialog
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Lot The Volume calculation is based on your chosen cell size and
interpretation distance. It is not detailed enough to be used for resource
calculations or modelling.

3. Click in the Selected column to turn the display of lithology units on and off in
the 3D Viewer.

4. Click OK.

Creating a Contact Surface

A contact surface is a sub-surface topography of the top or bottom of any lithology
unit. A contact surface is useful for identifying folding features and can be added to
a section map as sub-surface topography. You do not need to make a lithology
voxel before creating a contact surface as it looks solely at the downhole lithology
data.

In this lesson, you will create a contact surface to represent the top of the
mineralised zone identified earlier as the Sif lithology unit.

To create a contact surface from geology:

1. From the Voxel menu in the 3D Viewer, select Create Contact Surface from
Geology.

The Create Contact Surface from Geology dialog opens.
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Figure 4.20 Create Contact Surface from Geology dialog
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For the Geology channel, select Rock [Geology].
For the Geology unit, select Sif.

The grid file Rock_Sif top_first.grd (grd) will be generated based on using the
default Surface settings of top of the first layer.

4. Forthe Colour table, click the Colour ramp.
The Select Colour Ramp dialog opens.
For Category, select monochromatic.
Select the blue.tbl colour table and click OK.
Click More.

The Create Contact Surface from Geology dialog expands to show additional
options.

Figure 4.21 Create Contact Surface from Geology More dialog
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. J

For Cell size, enter 2 and click OK.
For Compositing gap, enter 2.

10. For Non-contact radius, enter 0.
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11. For Blanking distance, enter 500.

12. Click OK.
The contact surface is added to the 3D Viewer. You may want to turn off the
display of other layers to see the contact surface more clearly.

Figure 4.22 Contact surface from geology
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To create a contact surface from geology:
1. Select the appropriate colour table and click OK.

In this lesson you:
Created a lithology voxel
Viewed lithology voxel statistics
Created a contact surface from geology
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Lesson 4.4 Extracting Slices from a Voxel

In this lesson you will:

Interactively extract a slice from a voxel

Extracting Slices from a Voxel

In addition to slicing voxels from within the Section tool, you can interactively
extract voxel slices in any orientation from your plan map. A new Geosoft Grid
(.grd) file representing the voxel slice will be generated and automatically displayed
in the 3D viewer.

To interactively extract a slice from a voxel:

1. From the Add to 3D menu in the 3D Viewer, select Grids, then Extract
Sections(s) from Voxel.

The Extract Section(s) from Voxel dialog opens.

Figure 4.23 Extract Section(s) from Voxel dialog

[ Extract Section(s) from Voxel M‘
Vol file: | - E]
Output grid file: - E]
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[ oK ] [ Cancel ]
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For the Voxel file, select Au_Topo_Clip.geosoft_voxel.
For the Output grid file, enter Voxel_Slice.

For the Section selection, select Interactive - from drill project.

o > 0D

For the Grid cell size, enter 5 and click OK.
The Define Section View window opens.

6. Click one of the Define buttons and draw a line to define the slice.

W You can also enter specific Location and Orientation information.

7. Click OK.

Your voxel slice is added to the 3D Viewer.
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Figure 4.24 3D Viewer with voxel slice
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In this lesson you:

Interactively extracted a slice from a voxel
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Module 5 has Four Lessons:

Lesson 5.1
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Digitizing Interpretations on Section Maps ................. 182
Editing Feature Classes
Wireframing Interpretations
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Lesson 5.1 Creating an fGDB and Adding Feature
Classes

In this lesson you will:
Create an interpretations geodatabase
Add a polygon feature to the geodatabase

Add a polyline feature to the geodatabase

Explicit Modelling

Geological Interpretation and Wireframing
Explicit modelling in enables you to build 3D models from 2D interpretations drawn
on section or plan maps. There are four main parts to the modelling workflow:

Create a series of horizontal or vertical section maps containing the data to
support your interpretation.

Digitize two-dimensional (2D) interpretations on section or plan maps.

Open the 2D interpretations in the 3D Viewer and wireframe (connect) them
together to form 3D volumes and/or surfaces.

Use the analysis tools to extract information from the volumes and surfaces.

Interpretations Geodatabases

Target Interpretations Geodatabases are a special version of an Esri File
Geodatabase that store digitized interpretations drawn on section maps. Both
polygon and polyline features can be stored in the same file geodatabase.
Interpretations geodatabases store the following information:

XYZ locations
Coordinate system
Attributes including feature names and feature templates

v The coordinate system for the Interpretations Geodatabase will
automatically be set based on the current Target drillhole database.

You can use the options available on the Target Wireframing toolbar to create an
interpretations geodatabase, digitize interpretations, and manage the features and
interpretations.
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Figure 5.1 Target Wireframing toolbar options

. Edit Vertices
Open Interpretations  Egiting 1M F—
Geodatsbace iting Menu  Snapping Menu

Wireframing Project - ﬂ [ﬂ Editor ~ Snapping * X | Help~

Mew Interpratations | Start Digitizing \ Delete Selected
Geadatabaze Manage Interpretations Edit Toal Element
Geodatabase

W The Target Wireframing toolbar can be docked or it can remain in a floating
state.

To open the Wireframing map document:
1. From the ArcMap File menu, select Open.

2. From the Geosoft Training Data folder, select Wireframing.mxd and click
Open.

The Wireframing map document opens in ArcMap.

To create an interpretations geodatabase:

1. From the Wireframing Project menu on the Target Wireframing toolbar, select
New Geodatabase or click the New Interpretations Geodatabase button.

The New Target Interpretations Geodatabase dialog opens.
Figure 5.2 New Target Interpretations Geodatabase dialog

Mew Target Interpretations Geodatabase @

Output gecdatabase name: E]

Target project coordinate system: GDAS4 f MGA zone 50

Feature classes:

o) [ Coree ]

2. For Output geodatabase name, enter Palmer_interp.

The Coordinate system is automatically set to GDA94 / MGA zone 50 based on
the projection of the drillhole project.

To add a Line feature class to a geodatabase:

1. Tothe right of the Feature classes box, click the Add new feature class
button.

The Add Feature Class dialog opens.
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Figure 5.3 Add Feature Class dialog
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Name:
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Template Properties
Default tool: Q Palygon

Drawing symbol: Symbology...

Feature class description:
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For Name, enter Top_lron.

From the Type of feature stored list, select Line Features.
4. Inthe Template Properties area, click Symbology.

The Symbol Selector opens.

Figure 5.4 Symbol Selector
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5. For Colour, select orange and click OK.

6. For Feature class description, enter Top of iron formation and click Add.

Top_Ironis added to the list of Feature classes stored in the Interpretations

Geodatabase.

To add a polygon feature class to a geodatabase:

1. Totheright of the Feature classes box, click the Add new feature class

button.

The Add Feature Class dialog opens.
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2. ForName, enter Alluvium.
The Type of feature stored is Polygon Features by default.

3. Click the Symbology button, change the Fill Colour and Outline Colour to blue
and click OK.

4. ForFeature class description, enter Depositional layer and click Add.

Alluvium is added to the list of Feature classes stored in the Interpretations
Geodatabase.

5. Click OK.

v You can manage your feature classes by clicking the Manage
Interpretations Geodatabase button on the Target Wireframing Toolbar.

'l To open an existing geodatabase to continue digitizing, click the Open
Interpretations Geodatabase button on the Target Wireframing toolbar. The
interpretations in the geodatabase will be automatically displayed on the
dataframes on which they were drawn.

In this lesson you:
Created an interpretations geodatabase
Added a polygon feature to the geodatabase
Added a polyline feature to the geodatabase
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Lesson 5.2 Digitizing Interpretations on Section
Maps

In this lesson you will:
Digitize polyline interpretations on section maps

Digitize polygon interpretations on section maps

Snapping

Snapping can make digitizing more efficient and accurate. If snapping is on when
digitizing an interpretation on a section map, a red circle will appear around the tip of
the cursor when it comes within 10x10 pixels of the specified Snap To item. The
following table describes the three snapping options and their snapping circle
colours:

Table 5.1 Snapping Options

Snap To Option Description Snapping Circle

Colour
True Drillhole The cursor will snap to the true X, Y, Pink
Locations Z location along the drillhole trace
from the interval or pointin the
specified drillhole database.
Projected Map The cursor will snap to the X, Y, Z Red
Groups location of the specified map group
projected onto the centre plane of
the section.
Geostring The cursor will snap to the X, Y, Z Orange when
Features location of the specified geostring snapping to a
feature. Polygon and polyline vertex; Red
features can snap to other polygon when snapping
and polyline features including to to an edge
polygons and polylines of the same
feature.

To digitize geological polyline features on a section map:
1. Make the Section_6531260N dataframe Active and switch to the Data View.

2. From the Editor menu on the Target Wireframing toolbar, select Start Editing.

3. From the Snapping menu, select Snap to DH Database and from the Select
DH Database menu choose Litho_composite.

4. Click Start Digitizing and select the Top_Iron feature class in the Create
Features sidebar.

5. Hover the digitization cursor over different rock codes along the section trace.

If you allow the snap cursor to rest for a moment, you will see the following
information reported in a tooltip:
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* The Hole ID and specified Snap To database.

* The distance away from the centre plane of the section.

* Thetrue X, Y, Z location.
6. Digitize a polyline along the top of the iron formation.

This is the purple rock pattern along the drillhole trace and the Rock code is Sif.

7. Toend the polyline, right-click and select Finish Sketch.
8. Click the Editor menu in the Target Wireframing toolbar and click Save Edits.
If you switch dataframes without saving your edits you will be prompted to do so.

Figure 5.5 Litho_composite database and S6531260N section

Y\ N\
° N

istance off plane’\¢6 2m o
ue XYZ location: (%16701, 6531554,

9. Repeat this process digitizing a polyline for the top of the iron formation on the
following section map dataframes:

* Section_6531285N
* Section_6531310N
* Section_6531331N

Section_6531380N
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Figure 5.6 Top_iron interpretations on section maps

W You can double-click to end a polyline or polygon.

W Digitizing more points will create smoother interpretations which will
also create smoother wireframe surfaces.

To digitize geological polygon features on a section map:
1. Activate the Section_6531260N dataframe to open it in the Data View.
2. From the Create Features list, select Alluvium.

3. Digitize a polygon for the alluvium layer (the blue rock pattern marked with rock
code Ca just below the collars), snapping to the top and the bottom of this layer.

4. Toclose the polygon, right-click and select Finish Sketch.

Figure 5.7 Alluvium and Top_lIron polygon interpretation on S6531260N.map
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5. Repeat this process digitizing an alluvium polygon on the following section
maps:
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W

Section_6531285N.map
* Section_6531310N.map
* Section_6531331N.map
* Section_6531380N.map

Figure 5.8 Alluvium polygon and Top_Iron polyline interpretations on section maps
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In this lesson you:
* Digitized polyline interpretations on section maps

* Digitized polygon interpretations on section maps

www.geosoft.com
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Lesson 5.3 Editing Feature Classes

In this lesson you will:
Change the colour of a feature class
Add a feature class into the geodatabase
Digitize a polyline interpretation
Delete an interpretation from a section map
Delete a feature class from an interpretations geodatabase
View a summary of the interpretations on section maps

View the interpretations in the 3D Viewer

Editing Feature Classes

The Manage Interpretations Geodatabase tools in the Wireframing toolbar allow you
to edit your geodatabase and all its associated feature classes and interpretations.
Using these tools, you can add and delete features, or change the properties of an
interpretation after it has been digitized.

To change the colour of a feature class:
1. On the Wireframing toolbar, click Manage Interpretations Geodatabase.

The Manage Feature Classes dialog opens.

Select Top_iron and click the Edit selected feature class button.

@

Click the Symbology button.

The Symbol Selector dialog opens.

From the Color dropdown menu, select Red from the Color palette.
Click OK on the Symbol Selector dialog.

In the Edit Feature Class dialog, click Save.

N o o A

In the Manage Geostring dialog, click OK.
The colour of the Top_iron feature automatically updates on the section maps.

Next, you will add a new feature to the geostring.

To add another feature class to the geodatabase:
1. Onthe Wireframing toolbar, click Manage Interpretations Geodatabase.

2. Click the Add new feature class button.

The Add Feature Class dialog opens.

For Name, type temp.

Click the Symbology button and change the Colour to pink.
For Type of feature stored, select Line Features.

Click Add.

Click OK.

N o o Mo
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Next, you will digitize a polyline interpretation on S6531285N.map.

To digitize a polyline on a section map:

1. Inthe Project Explorer, double-click S6531285N.map to make it the current
section map or right-click and select Activate.

2. Onthe Target Wireframing toolbar, click on the Editor dropdown menu and
select Start Editing.

3. Click on the Snapping menu and ensure Snap to DH Database is selected and
under the Select DH Database submenu, ensure Geology is selected.

4. Onthe Create Features tools tab on the right, ensure temp is selected.

Digitize a polyline line along the top of the first bright green rock pattern (this is
the rock code "M").

To end the polyline, right-click and select Finish Sketch.

On the Target Wireframing toolbar, click on the Editor dropdown menu and
select Save Edits and then Stop Editing.

Next, you will delete the polyline that you digitized on the section map.

To delete an interpretation:

1. Onthe Target Wireframing toolbar, click on the Editor dropdown menu and
select Start Editing.

2. Onthe Geostrings toolbar, click the Edit Tool.
Click to select the blue polyline interpretation.
Once selected it will be bounded by a cyan border.
4. Onthe Geostrings toolbar, click the Delete Selected Interpretation(s) button (

%),

5. On the Target Wireframing toolbar, click on the Editor dropdown menu and
select Stop Editing.

b You can select multiple interpretations by holding the Control key on
your keyboard.

Next, you will delete the temp feature from the geodatabase.

To delete a feature class from an Interpretations Geodatabase:

1. Onthe Target Wireframing toolbar, click on the Wireframing Project dropdown
menu and select Manage Geodatabase.

2. From the Feature Classes list, select temp.
3. Click the Delete selected feature class button, then Yes.
4. Click OK.

by It is not necessary to delete interpretations from a feature before deleting
the feature. This was only done so you would learn how to perform both
tasks.

To edit the vertices of an interpretation:
1. Inthe Editor menu select Start Editing.
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2. Click the Edit Tool in the Wireframing toolbar and select any of your
interpretations.

w

In the Wireframing toolbar, select the Edit Vertices tool.

B

Place your mouse cursor over a vertex on your selected interpretation and click
and drag to move it. You can also remove or add a vertex by right-clicking and
choosing the appropriate tool.

5. Right-click and select Edit Vertices to tumn off the editor.
6. Inthe Editor menu, select Save Edits and then Stop Editing.

To view the geostring in the 3D Viewer:
1. Open the Layout View for the Wireframing MXD.

2. From the Target Drillhole toolbar, click Activate 3D Viewer.

The Geosoft 3D Viewer opens.

3. Fromthe Add to 3D menu, select Interpretations Geodatabase.

4. For Geodatabase, browse and select Palmer_interp.gdb and click OK.

Your section interpretations are displayed in the 3D Viewer. In the tree list, the
geodatabase is listed as the top node under 3D Objects. Within the item, the
sections that have interpretations for the feature class are listed.

Figure 5.9 Geostringin 3D Viewer tree list

&£ 3D Objects

E| =l STR_Palmer_interp
E| 1 Alluvium Alluvium polygon feature

L. S6531260N Section

W4 56531285N Section

M3 S6531310N Section Section maps with alluvium feature

C-] S$6531331N Section interpretations

M0 S6531335N Section

E|~ Top_lron

----- [w] % SE531260N Section
----- ] 4 56531285N Section Section maps with top_iron feature

Geostring file

Top_lron polyline feature

----- [w] 4 S6531310N Section interpretations
----- [W] # S6531331N Section

v You can tum the visualization off for some of the other map groups to
help you see the geostring file more clearly.

v Viewing the geostring alongside other data may help indicate which
interpretations require editing. Changes to interpretations are done on
the section map and the geostring will automatically update in the
3D Viewer.

In this lesson you:
Changed the colour of a feature class
Added a feature class into the geodatabase
Digitized a polyline interpretation

Deleted an interpretation from a section map
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* Deleted a feature class from an interpretations geodatabase
* Viewed a summary of the interpretations on section maps

* Viewed the geostring in the 3D Viewer
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Lesson 5.4 Wireframing Interpretations

In this lesson you will:
Start a wireframing session
Join polygons to form a closed surface wireframe
Add ends to a closed surface
Save a surface to a geosurface file
View the total surface area and total volume for a surface

End a wireframing session

Wireframing

Wireframing is the process of joining 2D interpretations to form 3D surfaces. In for
ArcGIS, this process is streamlined, efficient, and intuitive. After starting a
wireframing session, you click interpretations in the 3D Viewer to form the
wireframe. All the required tools are found in the Wireframing Tools panel that
displays when a wireframing session is in progress.

To start a wireframing session:
1. From the Wireframe menu, select Start Wireframing.

The Start Wireframing dialog opens.

Figure 5.10 Start Wireframing dialog

Start Wireframing @
Geostring to wireframe: E]
Feature to wireframe: [ v]

[ QK ] [ Cancel ]

For Geodatabase to wireframe, select Palmer_interp.gdb.
For Feature to wireframe, select Top_iron.
Click OK.

The Wireframing Tools are displayed on the right side of the 3D Viewer; note
that you are in Wireframing Mode. The top_iron interpretation polygons are
bounded in yellow.
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Figure 5.11 3D Viewer with Wireframing Tools displayed
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To create an open surface by wireframing polylines:
1. Click a polyline in the 3D model.
The selected polyline will be bounded by a cyan border.
2. Click an adjacent polyline to wireframe to the first polyline you selected.

You now have the beginning of a wireframe surface.

3. Continue selecting the remaining polylines to add them to the surface.

PARS Wireframe bodies and surfaces are automatically assigned the same
colour of the feature class. You can optionally change the colour of the
wireframe created from an active feature.

To create a closed surface by wireframing polygons:

1. Onthe Wireframing Tools panel, change the Active feature to Alluvium.

2. Inthe 3D Viewer, click to select the closest polygon to you in the 3D view.
The selected polygon is bounded by a cyan border.

3. Click the adjacent polygon.

You now have the beginning of a wireframe body. Both ends are bounded in
cyan meaning you could continue adding to the wireframe from either side.

FALY If you have interpretations that belong to the same active feature that need
to be treated as separate wireframes, click the Add New Wireframe Body
button. For instance, the same rock type may occur in two separate areas
(separated by a fault) or may bifurcate.
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v While wireframing, you can use the Undo/Redo buttons on the Wireframing
Tools panel or use the Ctri+Z and Ctri+Y shortcut keys, respectively.

To create ends on the wireframe body:

1. Onthe Wireframing Tools panel in the 3D Viewer, click Create Wireframe
Ends.

The options on the Wireframing Tools panel update and the two open ends in
the wireframing body are bounded in yellow.
For Ends Options, select Conical.
Click an open end to close it.
4. Click the remaining open end to close the body.
Fans Ends must be added before saving the wireframes to a geosurface

file. If you attempt to save before adding ends, you will be asked if you
would like to auto-close the wireframe with flat ends.

Geosurfaces

Geosurfaces are 3D vector files that store the results of wireframing or isosurface
creation. The files can be saved and shared with others, and also used in voxel
math expressions and VOXI constraint building.

Geosurfaces store the following information:
XYZ locations
Coordinate system
Attributes including feature names and colours

The coordinate system for the geosurface is automatically set based on the
geostring used to create the wireframe. Isosurfaces, created from a voxel, are also
stored in geosurface files.

To save the wireframes to a geosurface file:
1. On the Wireframing Tools panel, click the Save Wireframes as
Geosurface File button (8).

2. ForFile name, enter palmer and click Save.
The surface Alluvium is added to the 3D Objects tree.
v You also have the option of saving the Wireframe as a MultiPatch Feature
class in the Interpretations Geodatabase.
3. Under Wireframing Tools, change the Active Feature to Top_iron.
4. Click Save Wireframe as a Geosurface File.
5. Select the palmer.geosoft_surface file and click Save.

The surface Top_Iron is added to the same geosurface and is added to the
3D Objects tree.
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Figure 5.12 palmer and Top_iron geosurface in 3D Viewer tree list
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Next, you will view the Total Surface Area and the Total Volume for the .

To view the Total Surface Area for the Top_iron surface:
1. Inthe 3D Objects tree, select the Top_iron surface.

2. Click Properties in the Attributes tab.
The Geosurface Properties dialog opens.

Information about this surface, including Total Surface Area is given. The
transparency, rendering, and colour can be changed to alter how the surface
displays.

To view the Total Surface Area and Total Volume for the surface:
1. Inthe 3D Objects tree, select the .

2. Click Properties in the Attributes tab.
The Geosurface Properties dialog opens.

Information about this surface, including Total Surface Area ("Area") and Total
Volume ("Volume")are displayed.

3. Click Close.

To stop wireframing:
From the Wireframe menu in the 3D Viewer, click Stop Wireframing.

The Wireframing Tools are removed from the 3D Viewer.

In this lesson you:
Started a wireframing session
Joined polylines to form an open surface wireframe
Joined polygons to form a closed surface wireframe
Added ends to a closed surface
Saved a surface to a geosurface file
Viewed the total surface area and total volume for a surface

Ended a wireframing session
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